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YOU SHOULD CAREFULLY READ THE FOLLOWING TERMS AND CONDITIONS OF THIS LICENSE 
AGREEMENT BEFORE OPENING THIS PACKAGE. IF YOU DO NOT AGREE WITH THESE TERMS 
AND CONDITIONS, PLEASE PROMPTLY RETURN THIS PACKAGE FOR A FULL REFUND.

LICENSE AGREEMENT
Varitronics, LLC (hereafter "Varitronics") hereby grants you a non-exclusive, nontransferable license to use 
this VariQuest® Software (hereafter "Software") and the accompanying documentation according to the 
following terms:

1. LICENSE GRANT: You may 1) install the Software on all computers located at the invoiced site for this 
Software; 2) use and transmit the Software on a network within this invoiced site; 3) install the Software on 
one server or multiple servers within this invoiced site; 4) install the Software on personal computers of 
staff employed at this invoiced site for the sole purpose of designing output from Varitronics printing 
systems for educational purposes at this invoiced site; and 4) make copies of the Software in machine 
readable form for backup purposes only. 

2.  LICENSE RESTRICTIONS: You may not: 1) modify, adapt, translate, reverse engineer, decompile, 
disassemble, create derivative works based on, or copy (except for the backup copy) the Software or the 
accompanying documentation; 2) rent, transfer or grant any rights in the Software or accompanying 
documentation without the prior, express written consent of Varitronics; or 3) remove any proprietary 
notices, labels, or marks on the Software and accompanying documentation.

3. NATURE OF THIS AGREEMENT: This license is not a sale. License fees paid by you, if any, are in 
consideration of the licenses granted under this Agreement. Title and copyrights to the Software, 
accompanying documentation, and any copy made by you, remain the property of Varitronics or its 
suppliers. Unauthorized copying of the Software or the accompanying documentation, or failure to comply 
with the above restrictions, shall automatically terminate this license, without further notice, and terminate 
your rights to use the Software, and Varitronics shall, in addition to its other legal remedies, be entitled to 
its reasonable attorney fees.

4. LIMITED WARRANTY: Varitronics warrants that, for a period of ninety (90) days from the date of 
delivery to you as evidenced by a copy of your receipt, the Software, as furnished, under normal use, will 
perform without significant errors. Varitronics' entire liability and your exclusive remedy under this warranty 
(which is subject to you returning the Software to Varitronics) will be, at the option of Varitronics, to attempt 
to correct or help you around errors, to replace the Software with functionally equivalent software or 
diskettes, or to refund the license fee of the Software and terminate this Agreement.

EXCEPT FOR THE ABOVE EXPRESS LIMITED WARRANTY, VARITRONICS MAKES AND YOU 
RECEIVE NO WARRANTIES, EXPRESS, IMPLIED, STATUTORY OR IN ANY COMMUNICATION WITH 
YOU, AND VARITRONICS SPECIFICALLY DISCLAIMS ANY IMPLIED WARRANTY OF 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. VARITRONICS DOES NOT 
WARRANT THAT THE OPERATION OF THE PROGRAM WILL BE UNINTERRUPTED OR ERROR 
FREE.

Some states do not allow the exclusion of implied warranties so the above exclusions may not apply to 
you. This warranty gives you specific legal rights. You may also have other rights which vary from state to 
state.
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Technical Support

5.  LIMITATION OF LIABILITY: IN NO EVENT WILL VARITRONICS BE LIABLE FOR ANY DAMAGES, 
INCLUDING LOSS OF DATA, WHEN LOADING THIS SOFTWARE OR OTHERWISE, OR LOST 
PROFITS, COST OF COVER OR OTHER SPECIAL, INCIDENTAL, CONSEQUENTIAL OR INDIRECT 
DAMAGES ARISING FROM THE USE OF THE PROGRAM OR ACCOMPANYING DOCUMENTATION, 
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY. THIS LIMITATION WILL APPLY EVEN IF 
VARITRONICS HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Some states do not allow the limitation or exclusion of liability for incidental, or consequential damages, so 
the above limitation may not apply to you.

6.  GENERAL: This Agreement shall be governed by, and interpreted under, the laws of the State of 
Minnesota, USA. You acknowledge that U.S. law and regulations may restrict the export/re-export of the 
Software. You agree not to export/re-export the Software or portions thereof in any form without the 
appropriate U.S. and foreign government licenses. This obligation shall survive and continue after this 
Agreement terminates. This Agreement is the entire agreement between the parties and supersedes any 
other communications or advertising with respect to the Software and accompanying documentation. If any 
provision of this Agreement is held invalid, the remainder of this Agreement shall continue in full force and 
effect.

Technical Support
For technical assistance, please contact your authorized VariQuest dealer or the VariQuest Technical 
Support team:
• Email: techsupport@variquest.com
• Phone: 1-800-328-0585
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Copyrights

Copyrights
This manual is copyrighted with all rights reserved. No portion of this manual 
may be copied or reproduced by any means without the prior consent of 
Varitronics, LLC.

Windows® 10 Pro, Windows® 8 Pro 64-bit, Enterprise Operating System, 
Windows® 7 Pro 64-bit, are trademarks of Microsoft Corporation.
Adobe Acrobat Reader is a trademark of the Adobe Corporation.
All brand or product names referenced in this manual are trademarks or 
registered trademarks of their respective companies or organizations. 

VariQuest®, VariQuest® Visual Learning Tools, VariQuest® Poster Maker 
3600, VariQuest® Design Center Software, VariQuest®  Design Center, 
VariQuest®  Awards Maker 400, VariQuest®  Cutout Maker 1800, ProImageTM 
PosterPrinter 3000, VariQuest® Perfecta® 2400 Poster Design System and 
VariQuest® Perfecta® 3600STP Poster Design System are trademarks of 
Varitronics, LLC.

VariQuest® Design Center Software, 2019 Varitronics, LLC. All Rights 
Reserved.

D'NEALIAN® is a registered trademark of Sanman Associates, Inc. 
ZB Fonts © 1996 Zaner-Bloser, Inc., Educational Publishers.
Certain templates under license from Learning ZoneXpress. © 2012 Learning 
ZoneXpress.
This software and documentation are based in part on software and 
documentation under license from Hewlett-Packard Company. © 2017 
Hewlett-Packard Development Company, L.P.

Disclaimer
While every precaution has been taken in preparation of this document, 
Varitronics assumes no liability to any party for any loss or damage caused by 
errors or omissions or by statements resulting from negligence, accident, or 
any other cause. Varitronics further assumes no liability arising out of the 
application or use of any product or system described, herein; nor any liability 
for incidental or consequential damages arising from the use of this document. 
Varitronics disclaims all warranties of merchantability or fitness for a particular 
purpose.

Varitronics reserves the right to make changes without further notice to any 
product or system herein to improve reliability, function, or design. 
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Overview of the Design Center Software

Overview of the Design Center Software

VariQuest® Design Center Software is one component of the VariQuest® 
Visual Learning Tools product line, which supports school staff members and 
volunteers in creating materials that help improve student and staff 
performance.

The VariQuest® Design Center Software lets you easily design, store, cut, and 
print a wide variety of educational and motivational items. Its integrated design 
elements provide a remarkably fast and easy way to generate the following 
types of projects:

• Full color posters and banners from the VariQuest® Perfecta® 2400 Full-
Color Poster Design System.

Full color scanning, copying and printing from the VariQuest® 

Perfecta® 3600STP Poster Design System or the VariQuest® Perfecta®  

2400STP Poster Design System.

• Posters and banners from the VariQuest® Poster Maker 3600STP and 
ProImage PosterPrinters.

• Cutouts of letters, numbers, symbols, shapes, and collections from the 
VariQuest®  Cutout Maker 1800.

• Awards, flashcards and stickers from the VariQuest® Motiva™ 400 Color 
Label Printer or the VariQuest® Awards Maker 400.

• Integrated Learning Activities that use output from all products and 
implement visual and kinesthetic learning strategies found in VariQuest® 
Learning Modules.
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Launching the Software

Launching and Setting Up the Software

VariQuest® Design Center Software is designed for fast and easy use in a 
variety of situations and user preferences. The software can be used on either 
a dedicated Design Center touch computer or a PC and functions the same on 
either unit, except for these key differences:

• When used on the Design Center touch computer: Touch the keys or 
graphics on the monitor. Enter text by touching the keys on the “Virtual 
Keyboard” screen. 

You can also use an attached mouse and keyboard (sold separately) to point 
and click the buttons and choices.

• When used on a PC with the VariQuest® Design Center Software installed: 
Click the buttons and select menu choices and options with your mouse. 

You can also enter text using the “Virtual Keyboard” by either pointing-and-
clicking on the screen graphic or by using the computer’s keyboard (see "Using 
the Virtual Keyboard," page 1-21 for more details).

Launching the Software
How you launch the Design Center Software depends on whether you have 
the dedicated Design Center touch computer, or you are using a PC.

TIP

If the Design Center Software is not installed, refer to the VariQuest® Design 
Center Software PC Installation Guide, packaged with your software CD.

On the Design Center

1. Turn on the VariQuest®  Design Center.

On a PC

1. Select Start > Programs and locate the VariQuest® Design Center 
Software. Click the link to start the program.

- or -
2. Double click on the VariQuest® Design Center Software link on the 

computer desktop .
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Completing the Initial Setup
When the VariQuest® Design Center Software is first launched from either the 
Design Center touch computer or a PC, it automatically opens to the initial 
setup sequence. This is a one-time procedure and will not be required again.

TIP
You can change the settings made during the initial setup at any time by going 
to the Workroom Assistant and choosing the Setup function. (See Chapter 2 
"Workroom Assistant" for more information.)

To complete the initial setup tasks:
1. Read the welcome message, then to continue, touch or click OK. 

The VariQuest output devices installed on your Design Center touch 
computer or PC, as well as any standard printers, are listed on Output 
Devices screen. 
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2. In the Output Devices list, touch or click each output device you will use. A 
checkmark appears next to the selected devices.

3. In the Standard Printers list, touch or click the regular sheet-fed printer(s) 
that you want to be able to print to. 

TIP
Only printers that have been previously installed on your PC or Design 
Center touch computer are displayed in the list. You are not required to 
select a standard printer. 

TIP
If your VariQuest output device (e.g., Poster Maker, Perfecta Full-color 
Poster Design System, Cutout Maker, Motiva Color Label Printer or 
Awards Maker) is not listed in the Design Center Devices list, the driver 
for the device has not been installed. 

You can continue with the setup procedure and return to this screen 
after installing the device. See the VariQuest Design Center Software 
PC Installation Guide for device installation instructions.

4. When done selecting devices, touch or click OK.
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5. At the prompt, touch or click OK to enter your school name and mascot 
image.

6. In the Name field on the School Information screen, the message 
<No school name entered> displays. Touch or click Edit Name.
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7. On the Virtual Keyboard, touch or click the keys to enter the name of your 
school. 

- or -
Use the PC keyboard to enter the name of your school.

8. When done, touch or click OK. The name you just entered will display on 
the School Information screen.
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9. To add a school mascot image file, locate the mascot file on your Design 
Center touch computer or PC.

TIP
If your mascot file is not located on your Design Center touch computer 
or PC, insert the CD or USB device that contains the image in the CD-
ROM player or an available USB port. 

10. To the right of the mascot preview box, touch or click Browse.

11. In the Find Graphic screen, navigate to the drive and folder where the 
graphic file is located.

TIP
To open a directory or folder, touch or click its icon. To go up to the next 

higher directory, touch or click: .

TIP
For best results, use high-resolution graphics (such as those used for 
printing in yearbooks or letterheads). Most images created for a 
website don’t work well because of their lower resolution. 
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12. Touch or click the graphic file you want. All graphic files that use any of 
these supported formats will be displayed:

- Bitmap (*.bmp)
- TIFF (*.tif)
- JPEG (*.jpg)
- Portable Network Graphic (*.png)
- Windows Metafile (*.wmf)

For more information on using the Find Graphic screen, see the procedure 
"Search for My Graphics," page 1-32.

13. When your file displays in the center window, touch or click it to display in 
the Graphic Preview box. If needed, touch or click Rotate to rotate the 
image until it is in the correct position.

14. When done, touch or click OK.

15. When done with the initial setup process, touch or click OK on the popup 
message to end the setup and go to the Main Menu.
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Understanding the Main Screen

When you launch the VariQuest® Design Center Software, it opens to the 
Main screen: 

The main screen can display any of the design elements shown in the 
illustration, however, the specific ones you’ll see depend on which VariQuest® 
devices are connected to your Design Center touch computer or PC, and 
whether they’ve been selected from the Workroom Assistant.

The software first launches with three tabs in the tab bar: Workroom 
Assistant, Menu, and Exit. When you open a design element, a tab for that 
design element will also be added to the top row. These tabs make it fast and 
easy to move from one part of the software to another.

TIP
When you are working on a design element, the tab color changes to the 
unique color for that design element. 
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Workroom Assistant Tab
The Workroom Assistant tab provides options for setting up and learning to 
use the Design Center Software. Clicking or touching this tab displays these 
choices:

• User Documentation (see "User Documentation," page 2-3)
• Setup (see "Selecting Output Devices," page 2-5)

• About VariQuest® Design Center Software (see "Get Version Information," 
page 2-18).

Menu Tab
The Menu tab displays when you first launch the VariQuest® Design Center 
Software and consists of buttons that access the specific design elements. 

TIP
You can return to the Menu screen at any time by touching or clicking its tab at 
the top of the screen.

The design elements displayed on the menu screen depend on which 
VariQuest® components are installed (except Learning Modules):

• Learning Modules (see "Learning Modules," page 3-1)
• Perfecta 2400 (see Chapter 4 "Perfecta® 2400 Full-Color Poster 

Design System" for more information.
• Perfecta 2400STP/Perfecta 3600STP (see Chapter 5 "Perfecta® 

2400STP & 3600STP Poster Design System" for more information.
• Poster Maker (see Chapter 6 "Poster Maker 3600, ProImage™ Poster 

Printer, Plus3000 and XL3000" for more information.)
• Cutout Maker (see Chapter 7 "Cutout Maker 1800" for more information.)
• Awards Maker (see Chapter 8 "Awards Maker 400 - Awards and 

Stickers" for more information.)
• Motiva 400 (see Chapter 9 "Motiva™ 400 - Color Awards and Stickers" 

for more information.)

Touch or click any of the device-specific design elements to access its 
features.
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Exit Tab
The Exit tab displays a drop-down menu with four choices: 

• Minimize Software: Reduces the Design Center Software to an icon on your 
taskbar. Touch or click the icon once to restore the software to full-screen size.

• Close VariQuest Software: Lets you exit the software but leave your Design 
Center touch computer or PC running.

• Shut down PC: Lets you exit both the software and the Design Center touch 
computer or PC.

• Cancel: Stops the exit process and leaves the Design Center Software 
running.

TIP
When running the Design Center Software on a PC, depending on the PC 
display settings, the display may fill your entire screen. You can minimize the 
Design Center Software using the Exit tab.

To keep the software open while accessing another application on your 
desktop, you can display the Windows task bar and Start menu by pressing the 
Windows key on your keyboard.

Device Tabs
When you open a device-specific design element, its tab will be added to the 
Tab row on the top. You can move among the design elements, Menu screen, 
and Workroom Assistant by touching or clicking those tabs. 

Navigating with Tabs: When you use a tab to return to a design element, you 
will be returned to the screen you were last working on — not to the starting 
screen. 

To go to the start of the design element, either touch or click the Start Over 
button, or Close the design element and reopen it from the Menu screen.
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Common Features
The VariQuest® Design Center Software contains navigational aids and 
buttons that function the same throughout the software.

Screen Buttons
Each of the five tabs allow you multiple layout and design options for your 
template. Not all buttons appear for every product.

Toolbar
These include buttons that are located on the top of the working area. Most 
screens include these buttons. 

• Guide Me: Touch or click to see a popup window with help on what to do on the 
screen that is currently open.

• Close: Touch or click to close the current design element and return to the 
Menu screen. When closed, the tab for that design element is removed from the 
row of tabs. This lets you clean up your workspace when you’re done.

TIP
When unsure of what steps to take, touch or click Guide Me.
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Navigation Bar
The Navigation Bar is located on the bottom of the working area. Depending 
on the screen currently displayed, one or more of these buttons will appear at 
the bottom of your working area.

• Start Over: Touch or click to discard your work and start over. Your work will 
be deleted and you will be returned to the first screen of that design element 
where you can begin again.

• Back: Touch or click to return to the previous screen. It cancels any work you 
have done on the current screen, but retains any earlier selections and 
modifications.

• Next: Touch or click to go to the next screen of the project you are creating.
• Done: When finished with a task, touch or click to close the current screen and 

return to the screen from which you accessed it.
• Print: Depending on the design element, one of these buttons appears when 

you reach the preview screen for the project you are working on. Touch or click 
to send your project to the appropriate output device or printer.

• Finished: If you saved your job, touch or click this button to return to the "find" 
screen where you can export the file to a USB device (see "Export Files to a 
USB Device," page 1-35 for details). If you did not previously save your job, 
this button works the same as the Start Over button.

TIP
Scroll Arrows can also be used to navigate through lists. Touch or click to scroll 
horizontally or vertically through lists.
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OK & Cancel
Whenever you make a selection or modify a template, you can confirm your 
action or cancel it. The Design Center Software displays the OK and Cancel 
buttons to let you approve what you’ve done and go to the next step, cancel 
and redo it, or skip the step. 

For example, these buttons appear on the bottom of the Virtual Keyboard to let 
you accept or discard the text you’ve entered, and on popup windows that 
show previews of your choices.

• OK: Touch or click to accept your selection or edits and move to the next 
step. This saves your choices and returns you to the point from which you 
came to the screen.

• Cancel: Touch or click when you do not want to continue with your choice 
or edits. This discards your changes and returns you to the point from which 
you came to the screen.
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Design Center Software Color Coding
Distinctive color coding in the Design Center Software lets you easily orient 
yourself to the specific output types (i.e., Poster Maker, Perfecta, Cutout 
Maker, Awards Maker, Learning Modules). 

In addition, thumbnails in the preview window(s) are also color coded so that 
you can quickly determine to which output-type they apply.

Design Element Color Coding
Each of the device-specific design elements and the Workroom Assistant are 
assigned a distinct screen color and tab. Whenever you are working in a 
design element, the tab at the top of the screen and the controls take on the 
color-coding of that design element.

The colors are:

• Posters & Banners  (Red)

• Color Posters & Banners  (Blue)

• Cutouts & Collections  (Orange)

• Awards & Stickers  (Purple)

• Learning Modules  (Light Green)

• Workroom Assistant  (Turquoise)

• 3D Printer  (Dark Green)
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Thumbnail Color and Coding Identifiers

Thumbnail Color

Whenever you search or browse for content in the Design Center Software, 
the thumbnail results appear color-coded:

• Activated content: Displays a thumbnail with a white background with the 
file name displayed in the distinctive color coding of the associated output 
type (e.g., orange for Cutout Maker). 

• Not-Activated content: Displays a thumbnail and file name with a grayed-
out background. 

TIP
All content for the Poster Maker, Perfecta and Awards Makers are 
activated by default. To activate additional shapes or Learning 
Modules, see "Obtaining Additional Content," page 1-37.

Thumbnail Labeling

The label name of a thumbnail includes the Content ID and its activation 
status (activated or not activated). Color content only displays if color printers 
or awards makers are installed.

When you click a thumbnail, a preview will popup with additional information 
about the item:

• ID #
• Name
• Associated Learning Module (if applicable)

TIP
If you are viewing the thumbnail of a cutout, the expiration date for Premium 
Content Access also displays.
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Setting Up Content Preferences

Content preferences are setup and changed from the Browse Categories 
screen in each of the output-type design elements. Preferences that you 
select here will determine how much of the content will display when you 
search or browse for content.

TIP
Use the right and left arrows to see more templates in your search results. 
Select a template to see a larger view. Once viewed, click ‘OK’ to continue and 
edit or ‘Cancel’ to search further.

There are two types of preferences that you can select from this screen: 

• Grade Level: Lets you choose to display content appropriate for specific 
learning levels: Intermediate (3-6), Postsecondary (12+), Primary (PK-2) 
and Secondary (7-12).

• Show All. Lets you choose to display "all" content, or just "activated" 
content. By default, the system displays only activated content. 
- Activated content displays a thumbnail with the color coding of the 

associated output type (e.g., purple for Award Maker). The label name 
includes the Content ID and whether it is activated or not activated.

- Not Activated content (has not been purchased) is identified as "Not 
Activated" and cannot be used in your projects. To activate content, see 
"Obtaining Additional Content," page 1-37.
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Select Grade-Level Content
To set grade-level preferences:
1. From any of the output types (e.g., Poster Maker, Awards Maker), touch or 

click Browse Categories. The current Content Preferences are displayed 
above the thumbnail preview window.

2. Touch or click Change.
3. In the Preferences screen, select or deselect the Grade Level Content 

that you want to apply.

TIP
Only the content for the selected grade level(s) will display when searching by 
Keyword or Browsing for content. If your search does not return an expected 
result, check that your Content Preferences include the appropriate grade 
level(s).

Show Available Content
To set available content preferences:
1. From any of the output types (e.g., Perfecta, Poster Maker, Awards Maker, 

Motiva), touch or click Browse Categories. The current Content 
Preferences are displayed above the thumbnail preview window.

2. Touch or click Change.
3. In the Preferences screen, select or deselect the Available Content you 

want to display.

TIP
By default, the system displays only activated content for the Cutout Maker. 
Change the setting to Show All Content to preview other additional content 
available for purchase.
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Using the Virtual Keyboard

The Virtual Keyboard is a graphical representation of a keyboard and text-
entry box that appears whenever you need to enter or change text. The 
keyboard appears when you:

• Choose the Search by Keyword option from anywhere in the software.
• Create or edit name lists in the Workroom Assistant or one of the design 

elements.
• Enter or change text on a design project in any of the design elements.
• Add or change your school name in the Workroom Assistant.
• Save a design or template under a new name.

You can use the Virtual Keyboard just like a regular keyboard to “type” text 
into the text-entry box. Options for entering text include:

• Design Center touch computer: Touch keys on the screen, just as you 
type them on a keyboard.

- or -
• Attached Mouse: Point to and click the keys in the Virtual Keyboard.

- or -
• Attached Keyboard (or PC): Type on the attached keyboard.
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Function Keys
Just as on a typical keyboard, use the following keys on the Virtual Keyboard 
to add or edit your text:

• Shift: To type an upper-case letter, touch or click the Shift key and then the 
character key. 

TIP
When you press the Shift key, the characters on the screen change from 
lower-case to upper-case. You do not need to “hold down” the Shift key; as 
soon as you press another key, the characters return to lower case.

• Caps Lock: To switch to all-caps, touch or click the Caps Lock key. The keys 
on the screen appear in all upper case and will produce all-caps until you touch 
or click the Caps Lock key again to return to lower-case.

• Symbols: To type the keyboard symbols above the number keys, touch or click 
the Shift or Caps Lock key and then the symbol key(s).

• Move Cursor: Touch or click  and  (left and right arrow) keys. If the text 
consists of more than one line, move between lines by touching or clicking 
and(up and down arrow keys).

• Delete: To erase the character to the right of the text cursor, touch or click the 
Delete key.

• Backspace: To erase the character to the left of the text cursor, touch or click 
the Backspace key.

• Enter: The Enter key functions differently, depending on why you are using the 
keyboard:

- Keyword Search: To start the search based on whatever text is in the 
text box, touch or click Enter (the Next button also starts the search).

- Enter text for projects or name lists: To insert a line break in the text 
box, touch or click Enter.

• Spanish Letters: Touch or click once to display accented Spanish letters. 
Touch or click again to return to the standard keyboard.
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Adding Spanish Letters
Adding Spanish letters is done using the Spanish Letters function key.

To add Spanish letters:
1. On the Virtual Keyboard, type the character(s) you want.

2. To add a Spanish character, touch or click Spanish Letters . The 
special characters will display on the Virtual Keyboard.

3. Touch or click the character(s) you want to add.
4. Touch or click Spanish Letters again to return to the standard keyboard 

layout and continue with your project.
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Replacing Text
When entering new text, the Virtual Keyboard opens with a blank text box. 
When changing existing text, the keyboard opens with the current text 
highlighted, as shown in the illustration. 

To replace text: 
1. To replace all highlighted text: Touch or click Backspace; or just start 

entering new text; the highlighted text will disappear. 
2. To edit only part of the text: Touch or click the left/right arrow keys to 

move the cursor where you want the change; or touch or click the screen 
where you want the change, then begin your edits.

Spell Checker
The Virtual Keyboard provides a spell-check function which highlights words 
that are not part of the dictionary shipped with the software. The spell-checker 
alerts you to words in the text box that might be misspelled so you can 
immediately correct them.

Misspelled words are highlighted after you add a space or a punctuation mark. 
The spell-checker does not suggest words, nor can you add words to, or 
remove them from, the dictionary. 



VariQuest® Design Center Software User Guide 1-25 Getting Started

Locating Files in the Software
Search for Files

Locating Files in the Software

A great benefit of the VariQuest® Design Center Software is its stock of 
templates, designs, shapes, graphics and learning modules already built into 
the system. These files offer a huge variety of options so you should never 
have to design a project from scratch. You can also customize a template or 
design, save it under your own unique name and select from your own graphic 
files for projects.

To easily locate the right template, design or graphic, the software contains a 
powerful search function to help you find just the right items for your projects. 
You can use this fast search tool at various points in the Design Center 
Software. In addition, you can import and export files from a USB device.

Search for Files

TIP
When searching from Learning Modules, you will need to select the module 
you want before choosing a search method.

When doing a search, the Find screen opens with search options that you can 
use to find a template, shape, collection, graphic or design element, or one of 
your own saved projects. 

To search by: 

• Keyword: Locate a template or file using either:
- Design Center Software ID: The ID is listed with each template, shape, 

and collection in its’ respective VariQuest® Content Guide
- Content Keyword: Enter a keyword such as “sports” or “numbers.”

• Browse Categories: Search through all templates, shapes, collections, 
graphics and design elements. The files are grouped into categories and 
subcategories, such as “animals” or “weather.” 

TIP
Search results show only the content for the output type and grade level(s) you 
have selected. If your search does not return an expected result, check that 
your Content Preferences include the appropriate grade level(s).

• My Files (or My Saved Jobs): Search your own templates. When you 
customize a template, you can save it under a different name for future 
use. Later, you can find your saved templates through the My Files (or 
My Saved Jobs) option. 

• My PDFs: Search your own pdf files for quick and easy PDF printing. 
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Search by Keyword

Every VariQuest® template, shape and collection is assigned a unique ID, 
name, and several descriptive words, all of which are checked in a keyword 
search.

To search by keyword:
1. In the Search by Keyword screen, enter the ID or keywords by which you 

want to search on the Virtual Keyboard.

TIP
Use only letters or numbers for searching; do not use symbols. For 
a search by ID, you can use only one ID. For other types of keyword 
searches, you can enter more than one keyword, with each word 
separated by a space.

2. Touch or click Enter on the Virtual Keyboard or Next at the bottom of the 
screen to begin the search for the file.

Keyword Search Example

ID Search Example
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3. The Search Results screen displays one or more thumbnail pictures of the 
designs or graphics matching your keyword (just one thumbnail, if you 
searched by ID). Touch or click the thumbnail to select the one you want.

TIP
If the screen displays the words No Results Found, or if your template doesn’t 
appear, touch or click Back to return to the Virtual Keyboard. Check that you 
entered the ID correctly. If the ID is correct, but the template doesn’t appear, 
touch or click the Start Over button and try locating it using Browse Categories 
or, check that your Content Preferences include the appropriate grade levels.
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4. The thumbnail you select will appear magnified in a pop-up window, with its 
ID and descriptive name. 
• To accept it, touch or click OK. 
• To see more thumbnails, touch or click Cancel to return to the full display 

and continue browsing.
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Search by Browsing Categories
Browse Categories is a good way to find the right template or graphic for your 
project when you have a general idea of the type you want, but don’t know the 
ID, or if you want to pick from a variety of choices. This option lets you look at 
items in any or all categories.

Note: If you are using the Perfecta color printers or Motiva awards and 
stickers printer, you can change the color of the vector graphics. See 
"Change Graphic Color," page 4-25 (Perfecta 2400) or "Change Graphic 
Color," page 5-25 (Perfecta 3600STP) for more details.

TIP
If the screen displays No Results Found, or if your template doesn’t appear, 
check that your Content Preferences include the appropriate grade level(s). 
Also check whether the Content Shown is "Activated" only or "All Content."

To browse by category:
1. On the Find screen, touch or click Browse Categories. The Browse 

Categories screen appears showing a list of categories and subcategories 
on the left, and thumbnails of each design or graphic on the right.
• Categories: Touch or click the category name in the Categories list, then 

choose a subcategory. The first page of thumbnails displays on the right.
• Scroll Arrows:

- More Items in a Category: Touch or click the left and right scroll 
arrows below the display of thumbnails to see more items.

- More Categories: Touch or click the up and down scroll arrows on the 
Categories list to see more categories.

• Thumbnails: To see a larger preview, touch or click the thumbnail.

TIP
You can usually identify banners by their long, narrow profiles.
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Search for My Saved Files or Jobs
Whenever you modify a design you are prompted to save it. The modified 
design is saved in a separate location, either My Files (Awards Maker, 
Perfecta and Poster Maker) or My Saved Jobs (Cutout Maker). 

You can also use a USB device to import and export saved files (see "Import 
Files from USB Device," page 1-34 and "Export Files to a USB Device," page 
1-35).

TIP
When you know you will re-use or output additional copies of your customized 
design, it is a good idea to save it under a new name. It will be saved to a 
separate location where it can be quickly accessed using the My Files (or 
My Saved Jobs) option.

To find a saved design 
1. From the Main screen, touch or click:

• My Files (from Poster Maker, Perfecta, Motiva or Awards Maker)
• My Saved Jobs (from Cutout Maker)

TIP
For saved designs, Motiva, Awards Maker, Poster Maker and Perfecta 
template files appear as thumbnail previews. The name you used when you 
saved it appears under the thumbnail. For saved Cutout Maker shapes, the job 
names appear as a list. 
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2. Select the design you want from the thumbnails or list, then touch or click 
Edit or Open.

TIP
If you do not want to use any of the thumbnails shown, touch or click Start 
Over or Back.

3. Touch or click OK to accept the design (Motiva, Awards Maker, Poster 
Maker and Perfecta only). You will be taken to the next screen of the 
design element you are using where you can continue with your project.
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Search for My Graphics
The software comes with a large number of graphics. However, your 
organization may have its own additional graphics — such as the school 
mascot — that can also be used in creating design projects. From the 
Graphics Tab, then New Graphic button, you can choose the “find” option Find 
My Own Graphic.

To find or change a graphic
1. On the edit screen, touch or click the graphic you want to replace.
2. Touch or click Graphics Tab, then New Graphics. 

3. Touch or click Find My Own Graphic.
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4. On the Find Graphic screen, navigate to the location of your graphic.

TIP
On the Find Graphic screen, you can browse through all files on your system 
to find the graphic you want. 

5. When you find the graphic you want to use, touch or click OK to accept it.

6. After selecting your saved graphic or design, you will be taken to the next 
screen of the design element you are using where you can continue with 
your project.
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Importing and Exporting Saved Files

Import Files from USB Device
You can save Motiva, Awards Maker, Poster Maker and Perfecta files to a 
USB device so they can be transported between your local PC and the Design 
Center Software. Saved Cutout files cannot be exported.

To import a file from a USB device:
1. Insert your USB device in the Design Center touch computer or your PC.
2. From the Menu page, select the output type where your file is saved.
3. Select My Files.
4. Touch or click Import.

5. Navigate to the location on your USB drive where the file is saved.
6. Select the file then touch or click OK. A message will display indicating that 

the file was successfully imported.

TIP
If a file with the same name already exists on your Design Center touch 
computer, the file will not be imported.
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Export Files to a USB Device
Depending on the output type you are working with, you may be prompted to 
save your file to a USB device so they can be transported between your local 
PC and the Design Center Software. 

TIP
Your file must already be saved to your Design Center touch computer or PC 
before it can be exported to a USB device.

To export a file to a USB Device
1. Insert your USB device in the Design Center touch computer or your PC.
2. From the Menu page, select the output type where your file is saved.
3. Select My Files.
4. Touch or click the file you want to export, then touch or click Export.

5. Navigate to the location of your USB drive, then touch or click OK. A 
message will display indicating that the file was successfully saved.

TIP
Make sure you use a unique name for the file you are trying to export. If a file 
with the same name already exists on the USB device, the file will not be 
exported.
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Deleting Saved Files and Jobs

After using the VariQuest® Design Center Software for some time, you can 
end up with numerous customized template files that you have saved. 

You can easily “clean house” by deleting saved files you no longer want by 
selecting My Files in the output type you are working with.

To delete saved files or jobs: 
1. From the Menu page, select the output type with the file you want to delete.

2. Touch or click:
• My Files (for Motiva, Awards Maker, Poster Maker and Perfecta)
• My Saved Jobs (for Cutout Maker) 

3. From the preview list, select the item you want to delete, then touch or click 
Delete.

4. When prompted, touch or click Yes to delete the file, or No to continue 
without deleting. 

TIP
The preview window is automatically updated as soon as the file is deleted.
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Obtaining Additional Content

Content that is packaged with the VariQuest® Design Center Software 
includes all Poster Maker, Perfecta, Motiva and Awards Maker content that is 
not included with any of the design elements. It also includes 50 shapes, a 
license for the JanetVQ and LloydVQ font (for Letters, Numbers & Symbols), 
and 2 collections, all of which you can immediately use to make cutouts. 

TIP
Additional content information is available at www.variquest.com. 

Additional fonts, shapes, collections and learning modules are available from 
your local authorized VariQuest® dealer or the Varitronics® Customer Care 
Department. Your options for purchasing additional content are:

• PACD-1 Year: A Premium Content Access CD-1 year can be used to 
activate all of the shapes, collections and fonts. With this option, all shapes 
are activated for a limited 12-month period. After the subscription expires, 
you will only be able to access shapes that you have previously purchased 
(plus the free shapes included with the software). You can renew the 
shapes by contacting Customer Care for another PACD-1year or PACD-
NX. 

• PACD-NX: All of the shapes, collections and fonts are activated indefinitely. 
There is no expiration date with the PACD-NX option.

• Learning Modules: "Learning Modules" contain exclusive Cutout Maker 
content and coordinating learning activities using output from several 
VariQuest® products.

TIP
When you activate your Learning Module, an electronic copy (.pdf) is 
automatically installed in the list of User Documentation. 
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Activate a Content CD 
You can activate your content with or without the internet connected to your 
Design Center or PC. Follow the instructions for the activation process you 
need.

Activate Content without Internet Connection on Design Center

Note: Newer content CDs will automatically register your content. This 
procedure assumes the content will be automatically registered. If your 
Content CD does not automatically register your content, go to "Activate CD 
Content by phone," page 1-43.

To activate a content CD automatically:
1. Insert the "Premium Content Access" CD into the CD-ROM drive of your 

Design Center touch computer or the PC on which the Design Center 
Software is installed.

2. On the Welcome screen, touch or click Next to continue.

3. On the License screen, touch or click Accept, then Next to continue.
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4. Enter the user information. The content is automatically registered.

TIP
This screen will auto-populate if you have registered any previous 
content for this system.

5. Touch or click Finish to complete the registration.

TIP
For Premium content, the message will indicate the expiration date. If 
you purchased a lifetime subscription, the message will indicate that 
the content access does not expire.



1-40 Getting Started VariQuest® Design Center Software User Guide

Obtaining Additional Content
Activate a Content CD

Activate Content with Internet Connection on Design Center
You can activate your content even if your Design Center system does not 
have an internet connection.

To install and activate a content CD without an internet connection:
1. Insert the "Premium Content Access" CD into the Design Center.
2. On the Welcome screen, touch or click Next to continue.

3. On the License screen, touch or click Accept, then Next to continue.
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4. Go to any computer, tablet, or smart phone with an internet connection, 
then go to activate.variquest.com. 

Note: You can also access the activation screen from the VariQuest web 
site (www.variquest.com). Select Customer Resources and scroll to 
Content Activation.

5. Enter your Registration Code and select the CD Type from the drop-
down menu.

6. Touch or click Continue.
7. Enter the user information then touch or click Next. A registration code is 

provided.

TIP
This screen will auto-populate if you have registered any previous 
content for this system.
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8. Go to your Design Center and enter the registration code in the spaces 
provided.

9. Touch or click Next. You will receive a confirmation message if your 
content has been successfully activated.

10. Click Finish to complete the registration process.

TIP
For Premium content, the message will indicate the expiration date. If you 
purchased a lifetime subscription, the message will indicate that the content 
access does not expire.
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Activate CD Content by phone
1. Insert the "Premium Content Access" CD into the Design Center.
2. On the Welcome screen, touch or click Next to continue.

3. On the License screen, touch or click Accept, then Next to continue.
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4. On the Registration screen, when prompted, call the Registration Center at 
1-800-328-0585.

TIP
The first time you call the Registration Center, be prepared to provide the 
contact information for your school or organization (e.g., school name and 
address, name and contact information for the individual responsible for 
managing the VariQuest products). Whenever you install (or reinstall) a 
content CD, you will be asked for the alpha-numeric registration key that 
appears on this screen.

5. When directed, enter the activation code in the spaces provided. 
6. Touch or click Next. You will receive a confirmation message if your 

content has been successfully activated.
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7. Touch or click Finish when you will receive a message verifying the 
content is unlocked.

TIP
For Premium content, the message will indicate the expiration date. If you 
purchased a lifetime subscription, the message will indicate that the content 
access does not expire.

Providing Feedback
YOUR FEEDBACK IS IMPORTANT TO US! We encourage your input on all 
aspects of the VariQuest® Visual Learning Tools. Let us know about 
additional shapes and fonts you would like to add to your system. For 
feedback and input, please call our Customer Care Department at 
1-800-328-0585 or visit www.variquest.com.
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• "Setup," page 2-5
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Overview of the Workroom Assistant

The Workroom Assistant is like the behind-the-scenes helper who provides 
support and organizes the tools and supplies. Functions and settings that 
apply to all device-specific design elements, as well as information about using 
and adding to the features of the VariQuest® Design Center Software are all 
included in the Workroom Assistant component.

You can display the Workroom Assistant menu from anywhere within the 
Design Center Software by touching or clicking the Workroom Assistant tab 
at the top of the screen.

From the Workroom Assistant menu, you can:

• View User Documentation:

- Access all documentation about the VariQuest®, including the output 
devices and software.

- View Learning Module Activity Guides for modules that you have 
purchased.

• Setup your System:
- Select printers and other output devices to use with the software.
- Enter your school name and assign a mascot graphic file that will 

appear automatically in projects that use those items.
- Create and edit name lists for use with projects.

• Get version information about the Design Center Software.
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User Documentation

The Design Center Software comes with a printable version of this user guide 
as well as all user guides for the VariQuest® family of products. Other 
available product information, such as the Learning Activity Guides for 
purchased modules, can also be viewed using this feature.

To view and/or print user guides and other information:
1. With the Design Center Software open, touch or click the Workroom 

Assistant tab. 

2. Touch or click User Documentation.
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3. In the Categories list, touch or click the name of the component for which 
you want information.

4. In the Document List, touch or click the document you want to view for the 
selected component, then click OK. Documents open in a separate 
window as an Adobe Acrobat (.PDF) file. Media files open in the media 
viewing software on your Design Center touch computer or PC. 

5. To print the document, use the print function in Acrobat Reader and a 
printer set up on your system. 

TIP
If you do not have Acrobat Reader installed on your PC, the document won’t 
open. You can install Acrobat Reader for free by running the installation 
program on the VariQuest® Design Center Software CD and choosing Adobe 
Acrobat Reader under Accessories.

6. When done viewing the document, close its window. You will be returned to 
the User Documentation screen, where you can select another document 
to view.

7. When done, touch or click OK to return to the Workroom Assistant menu.

TIP
If you have purchased any Learning Modules, the "Learning Module Activity 
Guide" for that module will also be installed as a .pdf file in this list.
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Setup
Selecting Output Devices

The VariQuest® output devices that use your Design Center Software are 
typically installed during the initial installation process. If you add a 
VariQuest® device at a later date, or if you or want to select a different sheet-
fed printer connected to your Design Center touch computer or PC, you will 
add them from the Workroom Assistant.

To view and select available output devices:
1. With the Design Center Software open, touch or click the Workroom 

Assistant tab.
2. On the Workroom Assistant screen, touch or click Setup.

3. On the Setup screen, touch or click Output Devices. 
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4. In the left panel, scroll through the Design Center Devices list and touch or 
click all of the output device(s) you want to use.

TIP
You can also select a regular sheet-fed printer from the Standard 
Printers list. Only one printer can be selected at a time.

5. If your VariQuest® device (e.g., Poster Maker, Perfecta®, Cutout Maker, 
Motiva™, Awards Maker or PosterPrinter) does not appear on the Design 
Center Devices list, the driver for the device has not been installed. Install 
the driver, and then return to the Output Devices screen to select it. (For 
details on installing drivers, see the VariQuest® Design Center Software 
PC Installation Guide.)

6. When done, touch or click OK. 
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Entering School Information
The VariQuest® Design Center Software stores your school name and a 
graphic of your school mascot and inserts this information in applicable Poster 
Maker, Perfecta, Awards Maker and Learning Modules templates. 

You can enter or change the school information, or change the mascot graphic 
at any time from the Workroom Assistant.

To enter or change your school name and/or mascot graphic:
1. From the Workroom Assistant tab, touch or click Setup.

2. From the Setup screen, touch or click School Information. 
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3. Depending on what you want to do, touch or click:
• Edit Name... to change the name shown in the Name field. Then continue 

to the next step.
• Browse... to change the graphic shown in the Mascot File box. Then 

continue to Step 6.
• Remove Mascot to delete the mascot file entirely. The graphic will be 

removed as your school mascot file in the Design Center Software; it will 
not be deleted from your system.

4. Using the Virtual Keyboard, enter or edit your school name (see "Using the 
Virtual Keyboard," page 1-21 for details.)

5. When done, touch or click OK to close the Virtual Keyboard and redisplay 
the School Information screen, which will show the new name.
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TIP
Before selecting a new mascot file, make sure the graphic file you want 
to use is on your Design Center touch computer or PC hard drive, on a 
CD you’ve inserted into the CD-ROM drive or on a USB device 
attached to a USB port. 

6. On the School Information screen, touch or click Browse.
7. On the Find Graphic screen, touch or click the drive and folder(s) 

containing the graphic you want to use. If the file is in a subdirectory, you 
can click the folder at each level until the folder with the graphic file opens.
Supported graphic file formats are:

- Bitmap (*.bmp)
- TIFF (*.tif)
- JPEG (*.jpg)
- Portable Network Graphic (*.png)
- Windows Metafile (*.wmf)

TIP
For best results, use high-resolution graphics (such as those used for printing 
in yearbooks or letterheads). Most images created for a website don’t work 
well because of their lower resolution. For best results when using black-and-
white images, use black-and-white or grayscale graphics, although grayscale 
graphics with many gradations can produce less-desirable results.

8. When the folder with the graphic opens, touch or click the file icon. The 
graphic will display in the Graphic Preview box on the right. 

9. If the graphic is not correctly oriented, touch or click Rotate to rotate it.
10. When done, touch or click OK to return to the School Information screen, 

where the new mascot graphic will be displayed.
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Using Name Lists
One of the great time-savers in the VariQuest® Design Center Software is the 
ability to enter, store, and quickly add lists, such as student names. You can 
merge these lists with a template or shape to produce copies with a different 
name on each copy.

TIP
Name lists can only be used on Certificates and templates designed for such 
lists. These templates can be found across the VariQuest tools.

Using the Name Lists function in the Workroom Assistant is the primary way to 
add, edit, and delete name lists in your system. However, you can also add 
and edit name lists from the Edit screen within the output-type design element 
as you create a project.

Create Name Lists 

To create a new name list:
1. From the Workroom Assistant, touch or click Setup.
2. Touch or click Name Lists.
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3. When the Name Lists screen appears, touch or click New List. The Virtual 
Keyboard will open, where you can begin to enter the names on the list 
you want to create.

4. To add names to your list, touch or click the keys on the Virtual Keyboard 
(see "Using the Virtual Keyboard," page 1-21 for more information). After 
each name, touch or click Enter. 

5. When done, touch or click OK.
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TIP
When you return to the Name Lists screen from the Virtual Keyboard, your 
new list will be added to the Saved Lists file, but will be shown under the name 
<UNSAVED LIST>. All names you entered will appear in the Preview list.

6. To save the list, touch or click Save List. The Virtual Keyboard will open 
again with the term <UNSAVED LIST> highlighted in the text entry box. 

7. To name your list, touch or click the keys on the screen. The characters 
you enter will replace the highlighted term.

8. When done, touch or click OK. This saves the list in your system and you 
will be returned to the Name Lists screen, where your saved list will appear 
under the name you gave it on the Saved Lists window.
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View, Edit or Delete Name Lists

To view, edit, and delete name lists:
1. From the Workroom Assistant, touch or click Setup.
2. Touch or click Name Lists.

TIP
On the Name Lists screen, the Saved Lists box shows the names of all or your 
saved lists. The Preview box shows the items for whichever list is highlighted. 
You can use any of these buttons to edit lists and/or the names in them:

To add a new name list, when the Virtual Keyboard appears, 
enter the new items, then touch or click OK. The new 
(untitled) list is displayed in the Saved Lists column.
To save a name list under a different name, highlight the list, 
then touch or click this button. When the Virtual Keyboard 
appears, enter the new name and touch or click OK.
To import your own name list, touch or click this button, then 
touch or click Find File and navigate to the location of your 
Excel name list (see "Import Name Lists from Excel 
Spreadsheet," page 2-15).
To delete an entire name list from an Excel file, highlight the 
name list, then touch or click this button.
To add or edit names on a list, highlight the list, then touch or 
click this button. When the Virtual Keyboard appears, add, 
change, or delete whatever names you want, then touch or 
click OK to return to this screen.
To delete a name from the selected list, highlight the name, 
touch or then touch or click this button.
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TIP
Be sure to highlight the correct list and/or name that you intend to edit. The 
highlighted item appears with a darker background. You can highlight a list or 
name by touching or clicking it.

3. When done, touch or click OK to return to the Setup menu.



VariQuest® Design Center Software User Guide 2-15 Workroom Assistant

Setup
Using Name Lists

Import Name Lists from Excel Spreadsheet 
You can import name lists from the Workroom Assistant as well as from the 
Edit screen within the output-type design elements.

To import name lists from Excel:
1. From the Workroom Assistant, touch or click Setup.
2. Touch or click Name Lists.

3. When the Name Lists screen appears, touch or click Import List.
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4. In the Import List screen, touch or click Find File.

TIP
You can import name lists from your PC hard drive or from a USB device 
connected to the Design Center touch computer or PC.

5. Navigate to the location of your Excel file, then touch or click OK. The first 
sheet of the file will display the contents of Column A.

TIP
If you have a column header in the Excel file, the header will also be imported 
and included in the name list unless you delete that item.

Column
Heading
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TIP
Only the information in Column A of the selected sheet in the Excel file is 
imported. Blank cells are ignored.

6. To choose another sheet in the imported file, touch or click the sheet 
name. The preview window is immediately updated.

7. When done, touch or click OK. The imported list will display in the Saved 
Lists column as "<UNSAVED LIST>."

8. In the Preview column:
• To edit your list (e.g., add a name or correct a spelling), touch or click Edit 

List, then in the Virtual Keyboard, edit the list, then touch or click OK.
• To delete items from your list (e.g., remove the column heading), highlight 

the item, then touch or click Remove Item.
9. Touch or click OK, and when prompted, touch or click Yes to save your list, 

or No to continue without saving.
10. If you selected Yes, enter the name of your list in the Virtual Keyboard, 

then click OK. Your list is saved and you will be returned to the Setup 
menu.

Note: If you need first and last names to be included on your list, the 
columns will need to be merged to create one column. This has to be done 
in Excel before being imported.
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Get Version Information

Software Version & Latest Content Volume
The Workroom Assistant contains information about the version number and 
licensing for your copy of the VariQuest® Design Center Software.

To get version & licensing information about your software:
1. From the Workroom Assistant, touch or click 

About VariQuest Design Center. A pop-up window displays with version, 
copyright information and a scrollable box containing the licensing 
information. 
a. The highlighted box will show content updates that are currently 

installed.
2. When done, touch or click OK to close the window. 
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Chapter Overview
• "Overview of Learning Modules," page 3-2
• "Working with Learning Modules," page 3-3
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Overview of Learning Modules

Learning Modules let you coordinate the VariQuest® Suite with lessons and 
activities that incorporate visual and hands-on learning strategies to reinforce 
basic skills and provide fun and motivational activities that will supplement 
your school curriculum.

Each of the Learning Modules contain exclusive Cutout Maker content. To 
purchase a Learning Module, see "Obtaining Additional Content," page 1-37. In 
addition, when you order a learning module, you also receive a printed copy of the 
associated "Module Activity Guide."

TIP
Learning modules are related to a particular subject. 

Learning Module content is automatically filtered to show only the available 
content for the selected output type (i.e., Awards Makers, Cutout Maker, 
Perfecta or Poster Maker). 

If desired, you can also edit the template(s) using the editing tools applicable 
to the selected output type. If you change a template, you will be given the 
opportunity to save your changes so you can to use it again at a later date. 
Saved Posters & Banners and Awards & Stickers files can be exported to a 
USB device so they can be transported between your local PC and the Design 
Center Software. 
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Working with Learning Modules

To select a learning module:
1. From the Main screen, select Learning Modules. 

2. In the Select Module screen, select one of the learning modules.

TIP
You must purchase the Learning Module to activate the exclusive content in 
the selected module.
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3. In the Find Output screen, touch or click the output type that you will use 
for this module. 

4. To locate a template, select Search by Keyword, or 
Browse Categories (see "Locating Files in the Software," page 1-25 for 
more information about searching for files).

TIP
The search results will show only the content for the output type and grade 
level(s) you have selected. To change your grade level preferences, see 
"Setting Up Content Preferences," page 1-19.
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5. Select a template from the preview window, then in the popup window, 
touch or click OK. The template opens for editing in the selected output 
type.

TIP
Scroll through the categories and subcategories to see all of the available 
templates.

6. Continue editing and printing your template using the tools for the selected 
output type. See the following chapters for details: 

- "Perfecta® 2400 Full-Color Poster Design System," page 4-1
- "Perfecta® 2400STP & 3600STP Poster Design System," page 5-1
- "Poster Maker 3600, ProImage™ Poster Printer, Plus3000 and 

XL3000," page 6-1
- "Cutout Maker 1800," page 7-1
- "Awards Maker 400 - Awards and Stickers," page 8-1
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7. If prompted to save your changes, select Yes if you want to save this file or 
select No to continue without saving. 

TIP
Depending on the output type you selected, you may be prompted to save your 
file. Saved Awards & Stickers and Posters & Banners files can be exported 
to a USB device so they can be transported between your local PC and the 
Design Center Software. Saved Cutout files cannot be exported.

8. In the Enter Name screen, touch or click the virtual keyboard to enter a 
name that you want for this job (see "Using the Virtual Keyboard," page 1-
21).

9. Touch or click OK.
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Chapter 4 Perfecta® 2400 Full-Color 
Poster Design System

Contents
• "Overview," page 4-2
• "File Management," page 4-4
• "Finding a Template," page 4-7
• "Customizing a Poster or Banner Template," page 4-8

• "Text Editing," page 4-8
• "Change Text Content on a Template," page 4-8
• "Change Fonts on a Template," page 4-10
• "Add New Text Item," page 4-12
• "Change Text Color," page 4-13
• "Remove a Text Item from a Template," page 4-14
• "Tab Descriptions," page 4-15

• "Graphics," page 4-18
• "Change Graphics on a Template," page 4-18
• "Remove a Graphic from a Template," page 4-20
• "Insert a Graphic," page 4-21
• "Rotate a Graphic," page 4-22
• "Flip a Graphic Horizontally," page 4-24
• "Change Graphic Color," page 4-25

• "Printing a Poster or Banner," page 4-29
• "Saving a Template before Printing," page 4-29
• "Printing," page 4-32
• "Scan to Print," page 4-34
• "Scan to Template," page 4-38
• "Print a PDF File," page 4-41
• "Print from a non-Design Center Software File," page 4-42
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Overview

The VariQuest® Perfecta® 2400 Full-Color Poster Design System gives you 
the tools to quickly create and print an unlimited variety of posters and banners 
in a range of sizes and colors, ready for immediate display. Often, a template 
provides exactly what you require. However, templates are also easy to 
customize to your individual needs.

TIP
Not every text or graphic object in a template can be changed. If you try 
changing a non-editable item, a message to that effect will appear on your 
screen. If you think it is essential to change the graphic or text item, try 
browsing for a different template design that would be better for your project.

Color Coding 
Distinctive color coding in the Design Center Software lets you easily orient 
yourself to the specific output types. Thumbnails in the preview window(s) are 
also color coded. Whenever you are working on the Perfecta, the tab at the top 
of the screen and the controls are color-coded with Blue .

TIP
By default, all content for the Perfecta are activated. To activate additional 
shapes or Learning Modules, see "Obtaining Additional Content," page 1-37 in 
the Software User’s Guide.

Thumbnail Labeling
The label name of a thumbnail includes the Content ID and its activation 
status (activated or not activated). When you click a thumbnail, a preview will 
popup with additional information about the item:

• ID #
• Name
• Associated Learning Module (if applicable)
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Using the Virtual Keyboard
The Virtual Keyboard is a graphical representation of a keyboard and text-
entry box that appears whenever you need to enter or change text. 

You can use the Virtual Keyboard just like a regular keyboard to “type” text 
into the text-entry box using your Design Center touch computer, an attached 
mouse to point and click keys on the virtual keyboard or from an attached 
keyboard or PC. 

TIP
Touch or click Spanish Letters once to display accented Spanish letters. Touch 
or click again to return to the standard keyboard.

Note: For more specific details on using the Virtual Keyboard or entering 
Spanish text, see "Using the Virtual Keyboard," page 1-21 in the Software 
User’s Guide.
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File Management

When doing a search, the Find screen opens with search options that you can 
use to find a template, shape, collection, graphic or design element, or one of 
your own saved projects. 

TIP
Search results show only the content for the output type and grade level(s) you 
have selected. If your search does not return an expected result, check that 
your Content Preferences include the appropriate grade level(s).

Search for Files
To search by: 

• Keyword: Locate a template or file using either:
- Design Center Software ID: The ID is listed with each template, shape, 

and collection in the respective VariQuest® Content Guide
- Content Keyword: Enter a keyword such as “sports” or “numbers.”

• Browse Categories: Search through all templates, shapes, collections, 
graphics and design elements. The files are grouped into categories and 
subcategories, such as “animals” or “weather.” 

• My Files: Search your own templates. When you customize a template, 
you can save it under a different name for future use. Later, you can find 
your saved templates through the My Files option. 

• My PDFs: Allows for quick and easy PDF printing. The file is automatically 
scaled according to the output size selected, making the printing process 
even easier! 

TIP
For more specific details on searching for files, see "Locating Files in the 
Software," page 1-25.

Search for My Graphics
You can also search for your own graphics from the Edit screen, by choosing 
Graphics tab, then New Graphics button then click on the option Find My 
Own Graphic.

TIP
For more specific details on searching for files, see "Search for My Graphics," 
page 1-32.
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Importing and Exporting Saved Files
You can import or export Perfecta files to/from a USB device from the My 
Files section on the Menu screen. Once selected, your file will be imported 
into the Design Center or exported to the USB device.

TIP
If a file with the same name already exists on your Design Center touch 
computer, the file will not be imported.

Note: For more specific details on importing or exporting saved files, see 
"Importing and Exporting Saved Files," page 1-34.

Deleting Saved Files and Jobs
You can easily delete saved files you no longer want from the My Files menu 
page, selecting the file you want to delete and then clicking Delete.

Note: For more specific details on deleting files, see "Deleting Saved Files 
and Jobs," page 1-36.
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Basic Process

The general process for creating posters or banners includes these basic 
steps. For more detail, see the remainder of this document.

To create a poster or banner:
1. From the Design Center Software main menu, touch or click the button for 

the Perfecta 2400. 
2. Use the search or browse functions to locate the design template you 

want.
3. With a template as your basis, modify it as desired:

• Change the content of editable text.
• Change the font, size, and style of editable text.
• Choose different graphics, remove graphics on templates with replaceable 

graphics.
• Add new text or graphics objects.
• Move and size editable objects.
• Change the text or graphic color 

4. Print the poster or banner.
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Finding a Template

Whether you want to create a new poster or banner or print more of an 
existing project, your first step is to locate the template you want to use. 

TIP
Banners are usually identified by a file name starting with "BAN..." You can 
usually identify banners by their long, narrow profiles.

To search for a file:
1. Locate the template you want by using on one of the search options:

• Search by keyword or template ID
• Browse categories
• Select previously saved template 

2. On the Edit menu, modify the template as desired.
3. When ready to print the project, touch or click Next to go to the Print 

Preview screen.
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Customizing a Poster or Banner Template

Text Editing

Change Text Content on a Template

To change a text item on a template:
1. With the template displayed on the Edit screen, touch or click the text you 

want to change. Square “bullets” appear around the text to indicate it is 
selected.

2. Touch or click Edit Text. The Virtual Keyboard appears with the current 
text highlighted.

3. Touch or click the keyboard on your screen or PC to modify the text.
4. When done entering text, touch or click OK.
5. To continue modifying the template, go to:

• Each of the 5 tabs to allow you to manipulate elements of the template.
• Add or remove graphics and/or text from the template.
• Change colors of graphics and/or text.
• Set objects to back or bring to the front for layering purposes.

6. To print, touch or click Next to go to the Print Preview screen.
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TIP
Remember to always select the text or graphic box you want to change before 
clicking any of the Text editing options or Graphics editing options.

• When you select an editable text box or graphic, square “bullets” appear around 
it to indicate that it is selected.

• In a template, a blank space outlined by a thin dotted line indicates a text box. 
The dotted line does not print; it just marks the space where text can be 
entered.

• In a template, a thick black box with an X inside marks an area where a 
graphic can be placed. The X and box do not print if you decide not to insert 
a graphic.
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Change Fonts on a Template

TIP
Whenever you make a change, the template preview will update immediately.

To change font, style, size or justification of a text item:
1. With the template displayed on the Edit screen, touch or click the text you 

want to change. The selected text will be bordered by squares.
• Size: Font Size can be keyed in or use the arrows buttons to make the 

text larger or smaller.
2. Touch or click Text Tab. 

3. Make the text changes you want, as follows:

TIP
If your template contains more than one modifiable text item, you can select 
another text item without going back to an earlier screen. Just touch or click the 
next text object you want to modify and follow the steps of this procedure.

• Font: On the Font list, touch or click the font you want. Font names in the 
list appear in the actual typeface of their font. Use the up/down arrows to 
scroll through the list of fonts.

• Style: To change, touch or click B (bold), I (italic), and/or U (underline). The 
style is “on” when the button is depressed (down), and “off” when the button 
is not depressed (up). You can apply any or all styles to the selected text.

• Justification: To change text justification (Left, Right or Centered), 
touch or click one of the justification controls. 



VariQuest® Design Center Software User Guide 4-11 Perfecta 2400

Customizing a Poster or Banner Template
Text Editing

TIP
Text justification only affects multiple lines of text within a single text object. It 
does not align the text object on the template.

4. When done, touch or click OK. 
5. To continue modifying the template, go to:

• Select Design tab to change the align, layer rotate, or delete
- New Feature: Copy & Paste Option: select object, click copy then 

paste and place.
- New Feature: Undo last edit.

• Select Graphics tab to change or add a graphic.
• Select Color tab to change graphic or text color.
• Select Background tab to change background color and effect

6. When ready to print the project, touch or click Next to go to the Print 
Preview screen.
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Add New Text Item

TIP
Make sure that a text item is not selected. If a text item is selected, the new text 
will be placed in that text box. To de-select a text box, click in an empty area 
outside of the editing box.

To add a new text item:
1. With the template displayed on the Edit screen, touch or click 

Text Tab.
2. Touch or click New Text.
3. In the Virtual Keyboard, type the text you want to enter, then touch or 

click OK. 

Note: The new text item may be placed over existing items on the template.

4. To move the new text item, touch or click and drag it to a new area on the 
template.

5. If necessary, size the text item using the arrow buttons or key in size.
6. Click Color tab, then a color on the color palette to change the text color, if 

desired.
7. Repeat this procedure to add another text item.
8. When done, touch or click OK to close the screen and continue with your 

project.
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Change Text Color 

The VariQuest® Perfecta® 2400 Full-Color Poster Design System lets you 
change the text color on a template.

To change the text color:
1. With the template displayed on the Edit screen, touch or click any text 

object, then click Color Tab.

TIP
If you have a specific color needed, you can enter it in Custom Color.

2. In the Change Colors menu, touch or click a new text color from the color 
palette. The text color changes to the selected color.

3. Repeat this procedure to change other text item colors.
4. When done, touch or click OK to continue with your project.
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Remove a Text Item from a Template

Two ways to remove a text item:
1. Touch or click the Design tab or Text tab
2. ouch or click the text item you want to remove.
3. Then touch or click Delete Object / Delete Text button. 
4. To undo the deletion, click Undo.
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Tab Descriptions
Design Tab

Send to Back
Touch or click to send selected object to the 
back of all objects.

Bring to Front
Touch or click to bring selected object to the front of 
all objects.

Center Horz.
Touch or click to center the selected object 
horizontally on the page.

Center Vert.
Touch or click to center the selected object 
vertically on the page.

Rotate
Touch or click to rotate the selected object in 90° 
increments counterclockwise.

Delete Object
Touch or click to delete an existing graphic or 
text object.

Copy / Paste
Touch or click to copy and paste an existing 
graphic or text object

Undo Touch or click to undo the last action.

Text Tab

New Text

Touch or click to add a new text box. When the 
Virtual Keyboard appears, enter the new text, then 
touch or click OK. When a text object is selected, 
this button toggles to Edit Text.

Edit Text

Touch or click to change the text in a text box. 
When the Virtual Keyboard appears, enter the 
new text, then touch or click OK. When no text 
object is selected, this button toggles to New 
Text.

Size 
Up/Down Arrow

Text Width
Text Height

Select a text box or graphic, touch or click 
arrows to increase or decrease the size, or type 
the text size text box. You can manipulate text 
by the boundary box to change width and height.

Fonts & Styles
Select a text object, in the Fonts &Styles screen, 
touch or click to select a different font, size, style or 
justification, then touch or click OK.

Horizontal Text
Vertical Text

Select the text orientation. Text in the selected 
text box will be changed to reflect the selected 
orientation.
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Graphics Tab

New / Changing 
Graphics

Touch an object to work with. To add new objects, 
de-select any currently selected objects, then 
select New Graphics. You can either load your own 
or search our Graphic library to find one.

Flip Graphic

You can select an image and flip it to face the 
opposite direction. This is useful, for example, 
when you have two graphics and want them to face 
towards each other.

Shapes
•Rectangle
•Oval
•Cross
•Star
•Triangle

Touch or click the button to insert the shape 
indicated, then touch or click OK. Size the object 
while it is selected. You can change the color 
from the Color tab. 

Size - +
Select a text box or graphic, touch or click 
- or + to increase or decrease the size.

Color Tab
Standard Color: Touch or click the desired color 
on the color palette to change the selected 
object, 

Custom Color: Allows you to enter a Red, Blue 
or Green (RGB) or Hexadecimal (HEX) value to 
achieve a specific color.

Note: Pantone® (PMS) or CMYK values commonly 
used for print can be converted to an RGB and HEX 
equivalent. Conversion tools are widely available on 
the internet.
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Background Tab
None Touch or click to remove background fill

Solid Fill
Touch or click to fill the background with color 
from either the Standard or Custom pallet. 

Horizontal Gradient

Touch or click to fill the background with a 
horizontal gradient in the selected color.

Note: Gradients display best when used with darker 
colors.

Vertical Gradient

Touch or click to fill the background with a 
vertical gradient in the selected color

Note: Gradients display best when used with darker 
colors.
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Graphics
VariQuest® graphics are provided for a variety of designs. Not all graphics will 
look good on all templates, so you may need to experiment to find the graphics 
that work best for your specific template.

Change Graphics on a Template

To change a graphic:
1. On the Edit screen, touch or click the graphic you want to change.
2. Touch or click Graphics Tab.

3. On the New Graphic screen, touch or click the button identifying how you 
want to search for the new graphic.
• Search by Keyword and Browse Categories search the graphics 

provided within the software. When you locate the graphic you want, touch 
or click the thumbnail. 

• Find My Own Graphic lets you search the graphic files elsewhere on your 
Design Center touch computer or PC. When you find the graphic you want, 
touch or click its icon, then touch or click OK to use it and return to the Edit 
screen.
Graphic files that use any of these supported formats will be displayed:
- Bitmap (*.bmp)
- TIFF (*.tif)
- JPEG (*.jpg)
- Portable Network Graphic (*.png)
- Windows Metafile (*.wmf)
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TIP
For best results, use high-resolution graphics (such as those used for printing 
in yearbooks or letterheads). Most images created for a website don’t work 
well because of their lower resolution. 

4. To continue making changes to graphics, refer to:
• "Remove a Graphic from a Template," page 4-20 to remove a graphic.
• "Insert a Graphic," page 4-21 to insert a graphic.
• "Change Graphic Color," page 4-25.

5. When ready to print the project, touch or click Next to go to the Print 
Preview screen.
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Remove a Graphic from a Template
To remove a graphic:
1. On the Edit screen, touch or click Graphic Tab.
2. Touch or click the graphic (or graphic placeholder) you want to remove.
3. Touch or click Delete Graphic (to undo the deletion, click Undo).

TIP
The graphic is removed from the template, but not deleted from the Design 
Center Software. You can always search or browse the software graphics to 
find and restore the graphic.

4. To add a graphic, follow the steps of the procedure "Change Graphics on a 
Template," page 4-18. 

TIP
If you save the changed template after removing a graphic, you can always add 
a graphic back in — either the original or a different one.

5. When ready to print the project, touch or click Next to go to the Print 
Preview screen.
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Insert a Graphic

TIP
Make sure a graphic object is not selected. If a graphic object is selected, the 
new graphic will be placed in that object box. To deselect a graphic, click in an 
empty area outside the editing box.

To insert a graphic:
1. From the Edit screen, touch or click Graphic Tab.
2. Touch or click Graphics button.
3. Browse to the location of your graphic using one of the search options. 

TIP
The new graphic may be placed over existing items on the template.

4. Move the graphic to the desired location on the template.
5. Repeat this procedure to add another graphic. 
6. To change an existing graphic, touch or click the graphic. The option New 

Graphics changes to Graphics. 
7. Touch or click Graphics tab. 
8. Browse to the location of your graphic using one of the search options. 

9. When done, touch or click OK to close.
10. When ready to print the project, touch or click Next to save your project (if 

desired) and go to the Print Preview screen. 
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Rotate a Graphic 
When you import or select a graphic, you can rotate it in 90° increments. This 
is done through the Design Tab.

Note: The Rotate option will work on graphics and text elements in a 
custom or Design Center software template.

To rotate a graphic:
1. In the Edit screen, touch or click Design Tab.
2. Locate and select your graphic. It displays with boundary boxes.
3. Touch or click the Rotate button to rotate the graphic.

a. Each click will rotate the graphic 90° counterclockwise.
4. When done, touch or click off the graphic.

Note: Flip Graphic on the Graphic tab is used to mirror (reflect) the graphic. 
Please refer to page "Flip a Graphic Horizontally," page 4-24
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Rotation using Bounding Box
You can select an graphic and rotate it using the bounding box surrounding it. 
This can be useful when you want to make a smaller rotation of your graphic. 

To rotate a graphic:
1. In the Edit screen, touch or click the graphic.
2. Select the handle of the graphic (this will be the one square hanging a bit 

outside of the perimeter, you will get a ¾ circle with arrow)
3. Keep finger on screen or mouse arrow on handle and start movement.
4. Once done with movement, release finger / mouse and movement will 

stop.

Note: Rotation must be made in 15° increments. If this is not achieved, a 
colored box will print where the text or graphic should be.
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Flip a Graphic Horizontally
You can select an image and flip it to face the opposite direction. This is useful, 
for example, when you have two graphics and want them to face toward each 
other.

To flip a graphic horizontally:
1. In the Edit screen, touch or click Graphics.
2. Locate and select your graphic.
3. Move and/or size the image as desired.
4. Touch or click a Flip Graphic.
5. Touch or click Flip Graphic. The graphic will be flipped 180° horizontally.

TIP
You can use the New Feature of Copy and Paste on the Design Tab when 
selecting an existing graphic on a template to flip.
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Change Graphic Color

With the VariQuest® Perfecta® 2400 Full-Color Poster Design System, you 
can change the color of a some graphics on a template. You can only choose 
one color for the graphic, but the image will change to a gradual blend 
(gradient) of the selected color. 

Note: Not all available graphics can be edited for color. Only vector-based 
graphics can be changed.

To change the graphic color:
1. With the template displayed on the Edit screen, 
2. Touch or click any graphic object, then click Colors tab.
3. In the Color palette, touch or click a new color. The color of the graphic 

changes to varying shades of the selected color.
4. Repeat this procedure to change other graphic object colors.
5. When done, touch or click off the graphic and continue with your project.

Creating Certificates 
You can print Recognition & Motivation Certificate posters for multiple names 
by using the new Name List feature.

To create a certificate using a name list:
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1. Locate the template you want by using on one of the search options:
• Search by keyword or template ID
• Browse categories

Note: The border seen around certificates does not print. For this look, 
order VariQuest® certificate supplies.
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2. On the Edit menu, modify the certificate template as desired.
3. To print multiple certificates using a name list, touch or click Name Lists.

4. From the Add Name List menu, select or create the name list you want to 
use. See "Using Name Lists," page 2-10 for detailed instructions on 
creating and using name lists.
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5. Touch or click OK to select the name list, then touch or click Next to 
continue.

6. At the prompt, touch or click Yes to save the name list, or No to continue 
without saving.

7. In the Print Preview menu, you can change the number of copies you want 
to print. The number of copies defaults to the number of items in the name 
list you selected. 
• If you select more copies than the names in your list, the next copy will start 

with the first name. 
• If you select fewer copies than the names in your list, not all names will be 

printed 
For example, with a name list of 15 names:

- Selecting 15 copies will print 1 copy of each name.
- Selecting 20 copies will print 2 copies of the first 5 names and 1 copy of 

the last 10 names.
- Selecting 3 copies will print only the first 3 names.

8. To scroll through the list of names in the name list, touch or click the Left 
and Right arrows.

9. Choose the Output Size that you want for your certificate (default size is 
8.5 x 11").

10. When done, touch or click Finished to save your project, or Print to print 
the certificates.
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Printing a Poster or Banner

Note: If the ink level is 10% or less in one of the cartridges, a Low Ink 
warning will display prompting you to change the ink cartridge.

When you are ready to print your poster or banner, you have several options, 
depending on the type of project. If you have customized the template, you will 
be asked if you want to save the template before initiating the printing process.

Saving a Template before Printing
If you have made any changes to the template, you will be prompted to save it 
when you choose Next to move from the Edit screen to the Print Preview 
screen. 

TIP
Consider these guidelines for saving a template:

• If you plan to re-use or output additional copies of a template you have 
customized, you should save it. It can be opened later via the My Files option 
on the Find screen.

• Saved templates can be exported to a USB device so they can be transported 
between your local PC and the Design Center Software. 

• If you did not make any actual changes, or if you don’t plan to reuse this 
customized version in the future, it is not necessary to save your changes.
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To save a customized template for a poster or banner:
1. When finished editing, touch or click Next. A pop-up message will ask 

whether you want to save the file.
• Touch or click Yes to save it under a new name. If you save the file, you can 

later export it to a USB device so you can transport it between your local PC 
and the Design Center Software.

• Touch or click No if you don’t want to save it, but want to proceed to printing.
• Touch or click Cancel to remain on the Edit screen (e.g., to continue further 

customization).

2. If you want to save the template, enter the name you want to use on the 
Virtual Keyboard, then touch or click OK.

3. At the confirmation message that the template was saved, touch or click 
OK to continue.
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4. To complete your project, go to: 
• Printer Connected: "Printing," page 4-32.
• Printer Not Connected: Touch or click Finished to end this session and 

return to the Find Color Posters & Banners screen.

TIP
If you are not connected to a printer, you can save your file and export it to a 
USB device so that you can transport the file between your local PC and the 
Design Center Software connected to the printer. See "Importing and Exporting 
Saved Files," page 1-34.
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Printing
The VariQuest® Perfecta® 2400 Full-Color Poster Design System provides a 
number of powerful features which allows for on-screen preview of the ready-
to-print template. 

Note: The Perfecta 2400 printer does not support bi-directional 
communication. The on-screen preview is printed "as is."

To print a poster or banner:
1. Make sure the Perfecta is turned on and the desired paper size and type is 

loaded. 
2. Select one of the four output sizes: Standard, Medium, 13x19 Sheet and 

8.5 x 11 Sheet. Standard and Medium print to roll-fed paper. The 13x19 
and 8.5x11 sizes print to the sheet-fed tray on the back of the Perfecta.

Note: With the Perfecta 2400, you can print multiple poster sizes for 
templates. The approximate size is displayed in the preview image below. 
Banner templates will only print in the Standard output size.



VariQuest® Design Center Software User Guide 4-33 Perfecta 2400

Printing a Poster or Banner
Printing

3. With your poster or banner project displayed on the Print Preview screen, 
touch or click the up/down arrow keys to change the number of copies you 
want. The number in the Copies box defaults to 1.

4. When ready to output your project, touch or click Print.
A pop-up window lets you know the status of the print job and options for 
canceling it, if any. When the entire print job has been sent to the printer, 
the pop-up window closes, leaving the Print Preview screen displayed.

Note: The Perfecta printer does not support bi-directional printing. If your 
Perfecta is not printing, check the LCD panel on the printer, or check that 
all connections are firmly seated.

5. When finished with the project and the Posters & Banners design element, 
touch or click Close. Other options are:

- Print additional copies.
- Go Back to make changes to the design.
- Start Over or Finished to work on a new poster or banner project. 
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Scan to Print

Note: Not all Perfecta® 2400 configurations have the scan-to-print 
capability. Contact your authorized VariQuest Dealer for details.

The VariQuest® Perfecta® 2400 Full-Color Poster Design System scan-to-
print functionality lets you scan an image and print directly to the printer. You 
can scan any image that fits on the scanning bed and the Perfecta will print the 
image to a size of 24" x 34". You can also save the scanned image as a new 
template.

TIP
When placing the image, be sure to align it correctly on the scanning bed. You 
cannot edit or realign the image once it is scanned. 

Note: Before you can use the Scan to Print feature, you must have a 
VariQuest-supported scanner connected to your VariQuest®  Design 
Center. 

To scan to print:
1. Place your image on the scanning bed of your scanner.
2. From the Design Center Software main menu, touch or click Perfecta. 
3. On the Find Color Posters & Banners menu, click Scan to Print.
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4. On the Scan to Print menu, click Start Scan. The image will be scanned 
and a preview displayed.

TIP
Please be patient during the scanning process...it could take a few 
minutes to complete.

5. Touch or click Next.
6. Touch or click Yes to save your scan as a new template.
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7. In the Enter Name screen, enter a name for your new template.

8. Touch or click OK.
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9. On the Print Preview page, select the number of copies you want using the 
up/down arrows.

10. To print, touch or click any of the available output sizes.

11. Touch or click Print.
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Scan to Template 

Note: Not all Perfecta® 2400 configurations have the scan-to-print 
capability. Contact your authorized VariQuest Dealer for details.

The scan-to-template feature lets you scan an image directly into your working 
template. You can also save the scanned image to the My Graphics folder.

Note: To scan an image, you must have a VariQuest-supported scanner 
connected to your VariQuest®  Design Center. 

To scan to a template:
1. Touch or click Browse Categories and choose a template.
2. Select the graphic box that you want the scan imported into.
3. Touch or click Graphics.

TIP
Make sure the graphic you want to scan is on your scanning bed.

4. Touch or click Scan to Template button.
5. In the Scan to Template screen, touch or click Start Scan.

TIP
Please be patient, the scan can take a few minutes to complete.

6. When scan is complete, touch or click Rotate to rotate graphic, if desired.
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7. Touch or click Next to insert the scanned image into the template and 
open the template in the Edit screen.

8. When done editing, touch or click Next.
9. At the prompt to save your scanned image, touch or click Yes to save the 

image to the My Graphics folder.
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10. Enter a name for your image, then touch or click OK.

11. Touch or click OK at the prompt indicating that your changes have been 
saved to the My Graphics folder (located from the Find My Own Graphic 
button).

12. In the Print Preview screen, choose the printing options you want (see 
"Printing," page 4-32).
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Print a PDF File
The My PDFs section allows for quick and easy PDF printing. The file is 
automatically scaled according to the output size selected, making the printing 
process even easier! If you experience difficulty during the printing process, or 
your output is not printing correctly, try printing using Adobe® Reader or the 
native program the from which the PDF file was created.

Note: There is a 99 page limit on the imported PDF file. Any remaining 
pages in the file will be truncated.

To print a PDF file:
1. On the Find Color Posters and Banners menu, touch or click My PDFs.
2. In the Find File menu, browse to the location of your PDF file, then touch 

or click OK.
3. In the Print Preview menu, select the output size you want to print.

TIP
If you select 13 x 19 Sheet or 8.5 x 11 Sheet, you must load the appropriate-
sized paper in the sheet-fed tray located on the back of the printer. This option 
works only with posters - not banners.

4. In the Print Preview screen, use the arrow buttons to:
• View all pages in the PDF by touching or clicking the left or right arrow 

buttons at the bottom of the screen.
• Increase or decrease the number of copies in the Copies box.

Note: To export this file to a USB drive instead of printing, select Finished, 
then go to My Files to export it.
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5. Touch or click Print.
6. Choose the Page Range you want to print, then touch or click Print.

Print from a non-Design Center Software File
The Perfecta 2400 printer can print to most programs that support standard 
printing preferences. Refer to your Perfecta User's Guide for assistance 
printing from other programs.
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Overview

The VariQuest® Perfecta® STP Series Poster Design Systems are color 
printers with built-in WiFi networks that give you on-the-spot ability to scan, 
print and share documents directly from your smartphone or tablet. Using the 
scan-to-print feature, you can instantly enlarge documents, student work and 
artwork into large visual aids.

With these printers, you can quickly create and print an unlimited variety of 
posters and banners in a range of sizes and colors, ready for immediate 
display. In addition to using all of the current Perfecta 2400 24-inch supplies, 
the Perfecta 3600STP also offers 11" to 36" sheet/rolls and VoC requests for 
even larger posters and banners.

Note: All functionality between the Perfecta 2400STP and the 
Perfecta 3600STP are identical. The only difference is the size of the 
available output.

Often, a template provides exactly what you require. However, templates are 
also easy to customize to your individual needs.

TIP
Not every text or graphic object in a template can be changed. If you try 
changing a non-editable item, a message to that effect will appear on your 
screen. If you think it is essential to change the graphic or text item, try 
browsing for a different template design that would be better for your project.

Color Coding
Distinctive color coding in the Design Center Software lets you easily orient 
yourself to the specific output types. Thumbnails in the preview window(s) are 
also color coded. Whenever you are working on the Perfecta, the tab at the top 
of the screen and the controls are color-coded with Blue .

TIP
By default, all content for the Perfecta are activated. To activate additional 
shapes or Learning Modules, see "Obtaining Additional Content," page 1-37 in 
the Software User’s Guide.
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Thumbnail Labeling
The label name of a thumbnail includes the Content ID and its activation 
status (activated or not activated). When you click a thumbnail, a preview will 
popup with additional information about the item:

• ID #
• Name
• Associated Learning Module (if applicable)
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Using the Virtual Keyboard
The Virtual Keyboard is a graphical representation of a keyboard and text-
entry box that appears whenever you need to enter or change text. 

You can use the Virtual Keyboard just like a regular keyboard to “type” text into 
the text-entry box using your Design Center touch computer, an attached 
mouse to point and click keys on the virtual keyboard or from an attached 
keyboard or PC. 

TIP
Touch or click Spanish Letters once to display accented Spanish letters. Touch 
or click again to return to the standard keyboard.

Note: For more specific details on using the Virtual Keyboard or entering 
Spanish text, see "Using the Virtual Keyboard," page 1-21.
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File Management

When doing a search, the Find screen opens with search options that you can 
use to find a template, shape, collection, graphic or design element, or one of 
your own saved projects. 

TIP
Search results show only the content for the output type and grade level(s) you 
have selected. If your search does not return an expected result, check that 
your Content Preferences include the appropriate grade level(s).

Search for Files
To search by: 

• Keyword: Locate a template or file using either:
- Design Center Software ID: The ID is listed with each template, shape, 

and collection in the VariQuest® Content Guide
- Content Keyword: Enter a keyword such as “sports” or “numbers.”

• Browse Categories: Search through all templates, shapes, collections, 
graphics and design elements. The files are grouped into categories and 
subcategories, such as “animals” or “weather.” 

• My Files: Search your own templates. When you customize a template, 
you can save it under a different name for future use. Later, you can find 
your saved templates through the My Files option. 

• My PDFs: Allows for quick and easy PDF printing. The file is automatically 
scaled according to the output size selected, making the printing process 
even easier! 

TIP
For more specific details on searching for files, see "Locating Files in the 
Software," page 1-25.

Search for My Graphics
You can also search for your own graphics from the Edit screen, by choosing 
Graphics, then the “find” option Find My Own Graphic.

TIP
For more specific details on searching for files, see "Search for My Graphics," 
page 1-32.
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Importing and Exporting Saved Files
You can import or export Perfecta files to/from a USB device from the My 
Files section on the Menu screen. Once selected, your file will be imported 
into the Design Center or exported to the USB device.

TIP
If a file with the same name already exists on your Design Center touch 
computer, the file will not be imported.

Note: For more specific details on importing or exporting saved files, see 
"Importing and Exporting Saved Files," page 1-34.

Deleting Saved Files and Jobs
You can easily delete saved files you no longer want from the My Files menu 
page, selecting the file you want to delete and then clicking Delete.

Note: For more specific details on deleting files, see "Deleting Saved Files 
and Jobs," page 1-36.

Basic Process

The general process for creating posters or banners includes these basic 
steps. For more detail, see the remainder of this document.

To create a poster or banner:
1. From the Design Center Software main menu, touch or click the button for 

the Perfecta STP Series. 
2. Use the search or browse functions to locate the design template you 

want.
3. With a template as your basis, modify it as desired:

• Change the content of editable text.
• Change the font, size, and style of editable text.
• Choose different graphics, remove graphics on templates with replaceable 

graphics.
• Add new text or graphics objects.
• Move and size editable objects.
• Change the text or graphic color 

4. Print the poster or banner.
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Finding a Template

Whether you want to create a new poster or banner or print more of an 
existing project, your first step is to locate the template you want to use. 

TIP
Banners are usually identified by a file name starting with "BAN..." You can 
usually identify banners by their long, narrow profiles.

To search for a file:
1. Locate the template you want by using on one of the search options:

• Search by keyword or template ID
• Browse categories
• Select previously saved template 

2. On the Edit menu, modify the template as desired.
3. When ready to print the project, touch or click Next to go to the Print 

Preview screen.
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Customizing a Poster or Banner Template

Text Editing

Change Text Content on a Template

To change a text item on a template:
1. With the template displayed on the Edit screen, touch or click the text you 

want to change. Square “bullets” appear around the text to indicate it is 
selected.

2. Touch or click Edit Text. The Virtual Keyboard appears with the current 
text highlighted.

3. Touch or click the keyboard on your screen or PC to modify the text.
4. When done entering text, touch or click OK.
5. To continue modifying the template, go to:

• Select any of the editing tabs to perform additional editing. 
- Select Text tab to change the font, size or style of editable text items.
- Select Graphics tab to change or add a graphic.
- Select Design tab to remove a graphic or text box and adjust layers.
- Select Color tab to change text or graphic colors.
- Select Background to change the background color of the template.

6. To print, touch or click Next to go to the Print Preview screen.
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TIP
Remember to always select the text or graphic you want to change before 
clicking Edit Text or Graphics.

• When you select an editable text box or graphic, square “bullets” appear around 
it to indicate that it is selected.

• In a template, a blank space outlined by a thin dotted line indicates a text box. 
The dotted line does not print; it just marks the space where text can be 
entered.

• In a template, a thick black box with an X inside marks an area where a 
graphic can be placed. The X and box do not print if you decide not to insert 
a graphic.
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Change Fonts on a Template

TIP
Whenever you make a change, the template preview will update immediately.

To change font, style, size or justification of a text item:
1. With the template displayed on the Edit screen, touch or click the text you 

want to change. The selected text will be bordered by squares.
2. Touch or click Text Tab then Fonts & Styles. 
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3. Make the text changes you want, as follows:

TIP
If your template contains more than one modifiable text item, you can select 
another text item without going back to an earlier screen. Just touch or click 
the next text object you want to modify and follow the steps of this procedure.

• Font: On the Font list, touch or click the font you want. Font names in the 
list appear in the actual typeface of their font. Use the up/down arrows to 
scroll through the list of fonts.

• Size: Touch or click the Font Size arrow buttons to make the text larger or 
smaller or type in the text size desired.

• Style: To change, touch or click B (bold), I (italic), and/or U (underline). The 
style is “on” when the button is depressed (down), and “off” when the button 
is not depressed (up). You can apply any or all styles to the selected text.

• Justification: To change text justification (Left, Right or Centered), 
touch or click one of the justification controls. 

TIP
Text justification only affects multiple lines of text within a single text object. It 
does not align the text object on the template.

4. When done, touch or click OK. 
5. To continue modifying the template, go to:

• Select Color tab to change the color of graphics and text.
• Select Graphics tab to change or add a graphic.
• Select Design tab to remove a graphic or text box.

6. When ready to print the project, touch or click Next to go to the Print 
Preview screen.



5-12 Perfecta 2400STP/3600STP VariQuest® Design Center Software User Guide

Customizing a Poster or Banner Template
Text Editing

Add New Text Item

TIP
Make sure that a text item is not selected. If a text item is selected, the new text 
will be placed in that text box. To deselect a text box, click in an empty area 
outside of the editing box.

To add a new text item:
1. With the template displayed on the Edit screen, touch or click 

Text tab.
2. Touch or click the New Text button.
3. In the Virtual Keyboard, type the text you want to enter, then touch or 

click OK. 

Note: The new text item may be placed over existing items on the template.

4. To move the new text item, touch or click and drag it to a new area on the 
template.

5. If necessary, size the text item using the sizing buttons.
6. Click Color tab, then a color on the color palette to change the text color, if 

desired.
7. Repeat this procedure to add another text item.
8. When done, touch or click off the text box and continue with your project.
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Change Text Color 

The VariQuest® Perfecta® STP Series Poster Design Systems let you 
change the text color on a template.

To change the text color:
1. With the template displayed on the Edit screen, touch or click any text 

object, then click Colors.

TIP
Have a Hex or RGB color to use? Input it in the custom pallet.

2. In the Change Colors menu, touch or click a new text color from the color 
palette. The text color changes to the selected color.

3. Repeat this procedure to change other text item colors.
4. When done, touch or click off object to continue with your project.
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Remove a Text Item from a Template

To remove a text item:
1. On the Edit screen, touch or click text item to be deleted.
2. Touch or click the Design tab.
3. Touch or click the Delete Object button.
4. Or touch or click Text Tab. 
5. Touch or click the Delete Text button.
6. Click Undo to reverse edit or click off item when done.

Option One

Option Two
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Tab Descriptions

Design Tab

Send to Back
Touch or click to send selected object to the 
back of all objects.

Bring to Front
Touch or click to bring selected object to the front of 
all objects.

Center Horz.
Touch or click to center the selected object 
horizontally on the page.

Center Vert.
Touch or click to center the selected object 
vertically on the page.

Rotate
Touch or click to rotate the selected object in 15° 
increments.

Delete Object
Touch or click to delete an existing graphic or 
text object.

Copy / Paste
Touch or click to copy and paste an existing 
graphic or text object.

Undo Touch or click to undo the last action.

Text Tab

New Text

Touch or click to add a new text box. When the 
Virtual Keyboard appears, enter the new text, then 
touch or click OK. When a text object is selected, 
this button toggles to Edit Text.

Edit Text

Touch or click to change the text in a text box. 
When the Virtual Keyboard appears, enter the 
new text, then touch or click OK. When no text 
object is selected, this button toggles to New 
Text.

Size - +
Text Width
Text Height

Select a text box or graphic, touch or click 
- or + to increase or decrease the size, or the 
text width and height of a text box.

Fonts & Styles
Select a text object, in the Fonts &Styles screen, 
touch or click to select a different font, size, style or 
justification, then touch or click OK.

Horizontal Text
Vertical Text

Select the text orientation. Text in the selected 
text box will be changed to reflect the selected 
orientation.
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Graphics Tab

New Graphics

Touch or click to add a new graphic. In the Change 
Graphic menu, browse to the location of the new 
graphic, then touch or click OK. This button toggles 
to Graphics.

Graphics

Touch or click to change a selected graphic. In the 
Change Graphic menu, browse to the location of 
the new graphic, then touch or click OK. This 
button toggles to New Graphics.

Shapes
•Rectangle
•Oval
•Cross
•Star
•Triangle

Touch or click the button to insert the shape 
indicated, then touch or click OK. Size the object 
while it is selected. You can change the color 
from the Color tab. 

Size - +
Select a text box or graphic, touch or click 
- or + to increase or decrease the size.

Color Tab
Touch or click the desired color on the color 
palette to change the selected object, then touch 
or click OK.
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Background Tab

None
Touch or click to remove background fill, then 
touch or click OK.

Solid Fill

Touch or click to fill the background with color. 
Touch or click the color palette to fill the 
background with the selected color, then touch or 
click OK.

Horizontal Gradient

Touch or click to fill the background with a 
horizontal gradient in the selected color. then 
touch or click OK. 

Note: Gradients display best when used with darker 
colors.

Vertical Gradient

Touch or click to fill the background with a 
vertical gradient in the selected color, then touch 
or click OK. 

Note: Gradients display best when used with darker 
colors.
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Graphics
VariQuest® graphics are provided for a variety of designs. Not all graphics will 
look good on all templates, so you may need to experiment to find the graphics 
that work best for your specific template.

Change Graphics on a Template

To change a graphic:
1. On the Edit screen, touch or click the graphic you want to change.
2. Touch or click Graphics.

3. On the Change Graphic screen, touch or click the button identifying how 
you want to search for the new graphic.
• Search by Keyword and Browse Categories search the graphics 

provided with the software. When you locate the graphic you want, touch or 
click the thumbnail. 

• Find My Own Graphic lets you search the graphic files elsewhere on your 
Design Center touch computer or PC. When you find the graphic you want, 
touch or click its icon, then touch or click OK to use it and return to the Edit 
screen.
Graphic files that use any of these supported formats will be displayed:
- Bitmap (*.bmp)
- TIFF (*.tif)
- JPEG (*.jpg)
- Portable Network Graphic (*.png)
- Windows Metafile (*.wmf)
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TIP
For best results, use high-resolution graphics (such as those used for printing 
in yearbooks or letterheads). Most images created for a website don’t work 
well because of their lower resolution. 

4. To continue making changes to graphics, refer to:
• "Remove a Graphic from a Template," page 5-20 to remove a graphic.
• "Insert a Graphic," page 5-21 to insert a graphic.
• "Change Graphic Color," page 5-25.

5. When ready to print the project, touch or click Next to go to the Print 
Preview screen.
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Remove a Graphic from a Template

To remove a graphic:
1. Touch or click on the graphic (or graphic place holder) you want to remove.
2. Touch or click the Graphic Tab
3. Touch or click Delete Graphic (to undo the deletion, click Undo).

TIP
The graphic is removed from the template, but not deleted from the Design 
Center Software. You can always search or browse the software graphics to 
find and restore the graphic.

4. To add a graphic, follow the steps of the procedure "Change Graphics on a 
Template," page 5-18. 

TIP
If you save the changed template after removing a graphic, you can always add 
a graphic back in — either the original or a different one.

5. Touch or click off the graphic to continue with your project.
6. When ready to print the project, touch or click Next to go to the Print 

Preview screen.

Note: You can also delete the graphic using the Design Tab and touch / 
click the Delete Object button.
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Insert a Graphic

TIP
Make sure a graphic object is not selected. If a graphic object is selected, the 
new graphic will be placed in that object box. To deselect a graphic, click in an 
empty area outside the editing box.

To insert a graphic:
1. From the Edit screen, touch or click Graphic Tab.
2. Touch or click New Graphics.
3. Browse to the location of your graphic using one of the search options. 

TIP
The new graphic may be placed over existing items on the template.

4. Move the graphic to the desired location on the template.
5. Repeat this procedure to add another graphic. 
6. To change an existing graphic, touch or click the graphic. The option New 

Graphics changes to Graphics. 
a. Touch or click Graphics tab. 

7. Browse to the location of your graphic using one of the search options. 

8. When done, touch or click off the graphic and continue with your project.
9. When ready to print the project, touch or click Next to save your project (if 

desired) and go to the Print Preview screen. 
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Rotate a New Graphic 
When you import or select a graphic, you can rotate it in 90° increments. This 
is done through the Design Tab.

Note: The Rotate option will work on graphics and text elements in a 
custom or Design Center software template.

To rotate a graphic:
1. In the Edit screen, touch or click Design Tab.
2. Locate and select your graphic. It displays with boundary boxes.
3. Touch or click the Rotate button to rotate the graphic.

a. Each click will rotate the graphic 90° counterclockwise.
4. When done, touch or click off the graphic.

Note: Flip Graphic on the Graphic tab is used to mirror (reflect) the graphic. 
Please refer to page "Flip a Graphic Horizontally," page 5-24
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Rotation using Bounding Box
You can select an graphic and rotate it using the bounding box surrounding it. 
This can be useful when you want to make a smaller rotation of your graphic. 

To rotate a graphic:
1. In the Edit screen, touch or click the graphic.
2. Select the handle of the graphic (this will be the one square hanging a bit 

outside of the perimeter, you will get a ¾ circle with arrow)
3. Keep finger on screen or mouse arrow on handle and start movement.
4. Once done with movement, release finger / mouse and movement will 

stop.

Note: Rotation must be made in 15° increments. If this is not achieved, a 
colored box will print where the text or graphic should be.
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Flip a Graphic Horizontally
You can select an image and flip it to face the opposite direction. This is useful, 
for example, when you have two graphics and want them to face toward each 
other.

To flip a graphic horizontally:
1. In the Edit screen, touch or click Graphics.
2. Locate and select your graphic.
3. Move and/or size the image as desired.
4. Touch or click a Flip Graphic.
5. Touch or click Flip Graphic. The graphic will be flipped 180° horizontally.

TIP
You can use the New Feature of Copy and Paste on the Design Tab when 
selecting an existing graphic on a template to flip.
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Change Graphic Color

With the VariQuest® Perfecta® STP Series Poster Design Systems, you can 
change the color of some graphics on a template. You can only choose one 
color for the graphic, but the image will change to a gradual blend (gradient) of 
the selected color. 

Note: Not all available graphics can be edited for color. Only vector-based 
graphics can be changed.

To change the graphic color:
1. With the template displayed on the Edit screen, 
2. Touch or click any graphic object, then click Colors tab.
3. In the Color palette, touch or click a new color. The color of the graphic 

changes to varying shades of the selected color.
4. Repeat this procedure to change other graphic object colors.
5. When done, touch or click off the graphic and continue with your project.



5-26 Perfecta 2400STP/3600STP VariQuest® Design Center Software User Guide

Customizing a Poster or Banner Template
Creating Certificates

Creating Certificates 
You can print Recognition & Motivation Certificate posters for multiple names 
by using the new Name List feature.

To create a certificate using a name list:
1. Locate the template you want by using on one of the search options:

• Search by keyword or template ID
• Browse categories

Note: The border seen around certificates does not print. For this look, 
order VariQuest® certificate supplies.
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2. On the Edit menu, modify the certificate template as desired.
3. To print multiple certificates using a name list, touch or click Name Lists.

4. From the Add Name List menu, select or create the name list you want to 
use. See "Using Name Lists," page 2-10 for detailed instructions on 
creating and using name lists.
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5. Touch or click OK to select the name list, then touch or click Next to 
continue.

6. At the prompt, touch or click Yes to save the name list, or No to continue 
without saving.

7. In the Print Preview menu, you can change the number of copies you want 
to print. The number of copies defaults to the number of items in the name 
list you selected. 
• If you select more copies than the names in your list, the next copy will start 

with the first name. 
• If you select fewer copies than the names in your list, not all names will be 

printed 
For example, with a name list of 15 names:

- Selecting 15 copies will print 1 copy of each name.
- Selecting 20 copies will print 2 copies of the first 5 names and 1 copy of 

the last 10 names.
- Selecting 3 copies will print only the first 3 names.

8. To scroll through the list of names in the name list, touch or click the Left 
and Right arrows.

9. Choose the Output Size that you want for your certificate (default size is 
8.5 x 11").

10. When done, touch or click Finished to save your project, or Print to print 
the certificates.
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Printing a Poster or Banner

Note: If the ink level is 10% or less in one of the cartridges, a Low Ink 
warning will display prompting you to change the ink cartridge.

When you are ready to print your poster or banner, you have several options, 
depending on the type of project. If you have customized the template, you will 
be asked if you want to save the template before initiating the printing process.

Saving a Template before Printing
If you have made any changes to the template, you will be prompted to save it 
when you choose Next to move from the Edit screen to the Print Preview 
screen. 

TIP
Consider these guidelines for saving a template:

• If you plan to re-use or output additional copies of a template you have 
customized, you should save it. It can be opened later via the My Files option 
on the Find screen.

• Saved templates can be exported to a USB device so they can be transported 
between your local PC and the Design Center Software. 

• If you did not make any actual changes, or if you don’t plan to reuse this 
customized version in the future, it is not necessary to save your changes.
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To save a customized template for a poster or banner:
1. When finished editing, touch or click Next. A pop-up message will ask 

whether you want to save the file.
• Touch or click Yes to save it under a new name. If you save the file, you can 

later export it to a USB device so you can transport it between your local PC 
and the Design Center Software.

• Touch or click No if you don’t want to save it, but want to proceed to printing.
• Touch or click Cancel to remain on the Edit screen (e.g., to continue further 

customization).

2. If you want to save the template, enter the name you want to use on the 
Virtual Keyboard, then touch or click OK.

3. At the confirmation message that the template was saved, touch or click 
OK to continue.
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4. To complete your project, go to: 
• Printer Connected: "Printing," page 5-32.
• Printer Not Connected: Touch or click Finished to end this session and 

return to the Find Color Posters & Banners screen.

TIP
If you are not connected to a printer, you can save your file and export it to a 
USB device so that you can transport the file between your local PC and the 
Design Center Software connected to the printer. See "Importing and Exporting 
Saved Files," page 1-34.
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Printing
The VariQuest® Perfecta® STP Series Poster Design Systems provide a 
number of powerful features which allows for on-screen preview of the ready-
to-print template. 

Note: The  Perfecta® STP Series printers support bi-directional 
communication. So the on-screen preview is displayed as it will be printed. 

To print a poster or banner:
1. Make sure the Perfecta is turned on and the desired paper size and type is 

loaded. 
2. Select one of the four output sizes: Standard, Medium, 13x19 Sheet and 

8.5 x 11 Sheet. Standard and Medium print to roll-fed paper. The 13x19 
and 8.5x11 sizes print to the sheet-fed tray on the back of the Perfecta.

Notes:
• With the  Perfecta® STP Series, you can print multiple poster sizes for 

templates. The approximate size is displayed in the preview image below. 
Banner templates will only print in the Standard output size.

• The "Output Size" shown in the following graphic will depend on which 
printer you are using.
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3. With your poster or banner project displayed on the Print Preview screen, 
touch or click the up/down arrow keys to change the number of copies you 
want. The number in the Copies box defaults to 1.

4. When ready to output your project, touch or click Print.
A pop-up window lets you know the status of the print job and options for 
canceling it, if any. When the entire print job has been sent to the printer, 
the pop-up window closes, leaving the Print Preview screen displayed.

Note: The Perfecta printer does not support bi-directional printing. If your 
Perfecta is not printing, check the LCD panel on the printer, or check that 
all connections are firmly seated.

5. When finished with the project and the Posters & Banners design element, 
touch or click Close. Other options are:

- Print additional copies.
- Go Back to make changes to the design.
- Start Over or Finished to work on a new poster or banner project. 

Print Quality
There are 3 print quality options available on the Perfecta 3600STP Series 
Printers. Choose the option that best suits the purpose for your print.

• Fast: Prints at 300 dpi and increased speed. Printing at this speed can 
cause banding and lower quality output.

• Normal: Prints at 600 dpi. Good quality for most output projects.
• Best: Prints at 1200 dpi. Prints slower and is only supported on some 

media types.
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Print a PDF File
The My PDFs section allows for quick and easy PDF printing. The file is 
automatically scaled according to the output size selected, making the printing 
process even easier! If you experience difficulty during the printing process, or 
your output is not printing correctly, try printing using Adobe® Reader or the 
native program the from which the PDF file was created.

Note: There is a 99 page limit on the imported PDF file. Any remaining 
pages in the file will be truncated.

To print a PDF file:
1. On the Find Color Posters and Banners menu, touch or click My PDFs.
2. In the Find File menu, browse to the location of your PDF file, then touch or 

click OK.
3. In the Print Preview menu, select the output size you want to print.

TIP
If you select 13 x 19 Sheet or 8.5 x 11 Sheet, you must load the appropriate-
sized paper in the sheet-fed tray located on the back of the printer. This option 
works only with posters - not banners.

4. In the Print Preview screen, use the arrow buttons to:
• View all pages in the PDF by touching or clicking the left or right arrow 

buttons at the bottom of the screen.
• Increase or decrease the number of copies in the Copies box.

Note: To export this file to a USB drive instead of printing, select Finished, 
then go to My Files to export it.
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5. Touch or click Print.
6. Choose the Page Range you want to print, then touch or click Print.

Print from a non-Design Center Software File
The Perfecta Series printers can print to most programs that support standard 
printing preferences. Refer to your Perfecta User's Guide for assistance 
printing from other programs.

Scan to Print 
The VariQuest® Perfecta® STP Series Poster Design Systems scan-to-print 
functionality let you scan an image and print directly to the printer. You can 
scan any image that fits on the scanning bed and scale them up or down (i.e., 
scan a poster and print it to 8.5 x 11").The Perfecta will print the image to a 
size of 47" x 36". 

To use the Scan-to-Print feature, see the Perfecta 2400STP Poster Design 
System or the Perfecta 3600STP Poster Design System User’s Guide in the 
Copy section.
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Printing from a Mobile Device 

You can print, scan or share directly from your smartphone or tablet to your 
printer using a WiFi connection. Additional setup options based on school 
network and WiFi protocols are also available. 

Note: Before printing from your device, the printer must be setup using the 
Wireless Wizard in the Connectivity menu for a wireless connection. See 
the Perfecta 2400STP Poster Design System User Guide or the Perfecta 
3600STP Poster Design System User Guide for details.

• Mobile devices must have an Internet connection and email capability.
• Scan and copy control requires that the mobile device and printer be on the 

same wireless network or have a Wi-Fi Direct connection to the printer. 
• Printing requires an Internet connection to an HP printer.

Print from Mobile Device
1. Make sure your device is set up for mobile printing. 
2. Choose your content: Open the document or photo you want to print, tap 

the menu icon and select Print.
3. Choose your printer: Select the Perfecta 2400STP or the Perfecta 

3600STP printer.
4. Print: Confirm the correct printer and print setting are selected, then touch 

Print and collect your documents.

Print by Email 
To print by email, simply attach a PDF or other print-ready file to an email 
message and send it to your printer’s dedicated address.

There are a few limitations: 

• Files must be in PDF, JPEG, or TIFF formats.
• Maximum file size is 10 MB, but your email server may have a lower limit.
• Files are printed in the original document size (at 100% scale), in normal 

quality, in color, and normally in portrait orientation.
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Print, Scan, and Share from All-in-One (AIO) Remote App
Use the screen on your mobile device to control printer scan and print 
functions. Send scans directly to your mobile device from the Perfecta 
2400STP or the Perfecta 3600STP printer. Print PDF, photos, email 
attachments, and more from virtually anywhere.

Note: Mobile devices must have an Internet connection and email 
capability.

Scan and copy control requires that the mobile device and printer be on the 
same wireless network or have a Wi-Fi Direct connection to the printer.

Printing 
1. Choose your content: Open the document or photo you want to print, tap 

the share icon and select AiO.
2. Open in All-in-One Remote: Go to settings to adjust Quality or Color 

Mode if necessary.
3. Print: Confirm the correct printer and print setting are selected, then tap 

Print and collect your documents.

Scanning and Sharing 
1. Load document to be scanned: Place document on the printer.
2. Open in All-in-One Remote: Trigger scanning from the app. You can 

store the document in your mobile device.
3. Share: Select sharing through email or your preferred repository.
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Overview

This chapter describes poster or banner printing using the VariQuest® Poster 
Maker 3600 or ProImage™ PosterPrinter Series Printers, models Plus 3000 
and XL 3000 only.

The VariQuest® Design Center Software offers an easy way to print your 
posters and banners in a range of sizes and colors, ready for immediate 
display. Often, a template provides exactly what you require. However, 
templates are also easy to customize to your individual needs.

TIP
Not every text or graphic object in a template can be changed. If you try 
changing a non-editable item, a message to that effect will appear on your 
screen. If you think it is essential to change the graphic or text item, try 
browsing for a different template design that would be better for your project.

Color Coding
Distinctive color coding in the Design Center Software lets you easily orient 
yourself to the specific output types. Thumbnails in the preview window(s) are 
also color coded. Whenever you are working on the Poster Maker or 
PosterPrinter, the tab at the top of the screen and the controls are color-coded 
with Red . 

Thumbnail Labeling
The label name of a thumbnail includes the Content ID and its activation 
status (activated or not activated). When you click a thumbnail, a preview will 
popup with additional information about the item:

• ID #
• Name
• Associated Learning Module (if applicable)
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Using the Virtual Keyboard
The Virtual Keyboard is a graphical representation of a keyboard and text-
entry box that appears whenever you need to enter or change text. 

You can use the Virtual Keyboard just like a regular keyboard to “type” text 
into the text-entry box using your Design Center touch computer, an attached 
mouse to point and click keys on the virtual keyboard or from an attached 
keyboard or PC. 

TIP
Touch or click Spanish Letters once to display accented Spanish letters. Touch 
or click again to return to the standard keyboard.

Note: For more specific details on using the Virtual Keyboard or entering 
Spanish text, see "Using the Virtual Keyboard," page 1-21 in the Software 
User’s Guide.
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File Management

When doing a search, the Find screen opens with search options that you can 
use to find a template, shape, collection, graphic or design element, or one of 
your own saved projects. 

TIP
Search results show only the content for the output type and grade level(s) you 
have selected. If your search does not return an expected result, check that 
your Content Preferences include the appropriate grade level(s).

Search for Files
To search by: 

• Keyword: Locate a template or file using either:
- Design Center Software ID: The ID is listed with each template, shape, 

and collection in the VariQuest® Content Guide
- Content Keyword: Enter a keyword such as “sports” or “numbers.”

• Browse Categories: Search through all templates, shapes, collections, 
graphics and design elements. The files are grouped into categories and 
subcategories, such as “animals” or “weather.” 

• My Files: Search your own templates. When you customize a template, 
you can save it under a different name for future use. Later, you can find 
your saved templates through the My Files option. 

TIP
For more specific details on searching for files, see "Locating Files in the 
Software," page 1-25.

Search for My Graphics
You can also search for your own graphics from the Edit screen, by choosing 
Graphics, then the “find” option Find My Own Graphic.

TIP
For more specific details on searching for files, see "Search for My Graphics," 
page 1-32.
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Importing and Exporting Saved Files
You can import or export Poster Maker files to/from a USB device from the 
My Files section on the Menu screen. Once selected, your file will be imported 
into the Design Center or exported to the USB device.

TIP
If a file with the same name already exists on your Design Center touch 
computer, the file will not be imported.

Note: For more specific details on importing or exporting saved files, see 
"Importing and Exporting Saved Files," page 1-34.

Deleting Saved Files and Jobs
You can easily delete saved files you no longer want from the My Files menu 
page, selecting the file you want to delete and then clicking Delete.

Note: For more specific details on deleting files, see "Deleting Saved Files 
and Jobs," page 1-36.
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Basic Process

The general process for creating posters or banners includes these basic 
steps. For more detail, see the remainder of this document.

To create a poster or banner:
1. From the Design Center Software main menu, touch or click the button for 

Poster Maker. 
2. Use the search or browse functions to locate the design template you 

want.
3. With a template as your basis, modify it as desired:

• Change the content of editable text.
• Change the font, size, and style of editable text.
• Choose different graphics, remove graphics on templates with replaceable 

graphics.
• Add new text or graphics objects.
• Move and size editable objects.
• Change the text or graphic color (Perfecta only)

4. Print the poster or banner.
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Finding a Template

Whether you want to create a new poster or banner or print more of an 
existing project, your first step after launching the posters and banners design 
element for your printer is to locate the template you want to use. 

TIP
You can usually identify banners by their long, narrow profiles.

To search for a file:
1. Locate the template you want by using on one of the search options:

• Search by keyword or template ID
• Browse categories
• Select previously saved template 

2. On the Edit menu, modify the template as desired.
3. When ready to print the project, touch or click Next to go to the Print 

Preview screen.
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Customizing a Poster or Banner Template

Text Editing

Change Text Content on a Template

To change a text item on a template:
1. With the template displayed on the Edit screen, touch or click the text you 

want to change. Square “bullets” appear around the text to indicate it is 
selected.

2. Touch or click Edit Text. The Virtual Keyboard appears with the current 
text highlighted.

3. Touch or click the keyboard on your screen or PC to modify the text.
4. When done entering text, touch or click OK.
5. To continue modifying the template, go to:

• Click Design, Text or Graphics to make any other changes.
- Design Tab allows you to change layering levels and rotation
- Text Tab allows you to change the fonts and styles.
- Graphics Tab allows you to replace or remove graphics.

6. To print, touch or click Next to go to the Print Preview screen.
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TIP
Remember to always select the text or graphic you want to change before 
clicking Edit Text or Graphics.

• When you select an editable text box or graphic, square “bullets” appear around 
it to indicate that it is selected.

• In a template, a blank space outlined by a thin dotted line indicates a text box. 
The dotted line does not print; it just marks the space where text can be 
entered.

• In a template, a thick black box with an X inside marks an area where a 
graphic can be placed. The X and box do not print if you decide not to insert 
a graphic.
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Change Fonts on a Template

TIP
Whenever you make a change, the template preview will update immediately.

To change font, style, size or justification of a text item:
1. With the template displayed on the Edit screen, touch or click the text you 

want to change. The selected text will be bordered by squares.
2. Size: Touch or click the Font Size arrow buttons or key in font size to make the 

text larger or smaller.
3. Touch or click Fonts & Styles. 
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4. Make the text changes you want, as follows:

TIP
If your template contains more than one modifiable text item, you can select 
another text item without going back to an earlier screen. Just touch or click 
the next text object you want to modify and follow the steps of this procedure.

• Font: On the Font list, touch or click the font you want. Font names in the 
list appear in the actual typeface of their font. Use the up/down arrows to 
scroll through the list of fonts.

• Style: To change, touch or click B (bold), I (italic), and/or U (underline). The 
style is “on” when the button is depressed (down), and “off” when the button 
is not depressed (up). You can apply any or all styles to the selected text.

• Justification: To change text justification (Left, Right or Centered), 
touch or click one of the justification controls. 

TIP
Text justification only affects multiple lines of text within a single text object. It 
does not align the text object on the template.

5. When done, touch or click OK. 
6. To continue modifying the template, go to:

• Click off text box to perform additional editing. 
• Add New Text Item to add new text items.
• Change Graphics on a Template to replace or remove graphics.

7. When ready to print the project, touch or click Next to go to the Print 
Preview screen.
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Add New Text Item

TIP
Make sure that a text item is not selected. If a text item is selected, the new text 
will be placed in that text box. To deselect a text box, click in an empty area 
outside of the editing box.

To add a new text item:
1. With the template displayed on the Edit screen
2. Touch or click the Text tab, then touch or click New Text.
3. In the Virtual Keyboard, type the text you want to enter, then touch or 

click OK. 

TIP
The new text item may be placed over existing items on the template.

4. To move the new text item, touch or click and drag it to a new area on the 
template.

5. If necessary, size the text item using the sizing buttons or key in size.
6. Repeat this procedure to add another text item.
7. When done, touch or click off text box and continue with your project.
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Remove a Text Item from a Template

To remove a text item:
1. On the Edit screen, touch or click the item you want to remove.
2. Touch or click the Design Tab, then touch or click Delete Object.
3. Or Under Text Tab, Touch or click the text you want to delete.
4. Touch or click Delete Text
5. To undo the deletion, click Undo (under either tab).
6. When done, touch or click off object to continue with your project.
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Tab Descriptions

Design Tab

Send to Back
Touch or click to send selected object to the 
back of all objects.

Bring to Front
Touch or click to bring selected object to the front of 
all objects.

Center Horz.
Touch or click to center the selected object 
horizontally on the page.

Center Vert.
Touch or click to center the selected object 
vertically on the page.

Rotate
Touch or click to rotate the selected object in 90° 
increments.

Delete Object
Touch or click to delete an existing graphic or 
text object.

Copy / Paste
Touch or click on object/ text to copy and paste 
then click or touch both copy and paste.

Undo Touch or click to undo the last action.

Text Tab

New Text

Touch or click to add a new text box. When the 
Virtual Keyboard appears, enter the new text, then 
touch or click OK. When a text object is selected, 
this button toggles to Edit Text.

Edit Text

Touch or click to change the text in a text box. 
When the Virtual Keyboard appears, enter the new 
text, then touch or click OK. When no text object is 
selected, this button toggles to New Text.

Fonts & Styles
Select a text object, in the Fonts &Styles screen, 
touch or click to select a different font, size, style or 
justification, then touch or click OK.

Horizontal Text
Vertical Text

Select the text orientation. Text in the selected 
text box will be changed to reflect the selected 
orientation.

Size - +
Text Width
Text Height

Select a text box or graphic, touch or click the 
arrows to increase or decrease the size, or key 
in the size of the font desired.
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Graphics Tab

New Graphics

Touch or click to add a new graphic. In the Change 
Graphic menu, browse to the location of the new 
graphic, then touch or click OK. This button toggles 
to Graphics.

Graphics

Touch or click to change a selected graphic. In the 
Change Graphic menu, browse to the location of 
the new graphic, then touch or click OK. This 
button toggles to New Graphics.

Shapes
•Rectangle
•Oval
•Cross
•Star
•Triangle

Touch or click the button to insert the shape 
indicated, then touch or click OK. Size the object 
while it is selected. You can change the color 
from the Color tab. 

Size - +
Select a text box or graphic, touch or click 
- or + to increase or decrease the size.
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Graphics
VariQuest® graphics are provided for a variety of designs. Not all graphics will 
look good on all templates, so you may need to experiment to find the graphics 
that work best for your specific template.

Change Graphics on a Template

To change a graphic:
1. On the Edit screen, touch or click the graphic you want to change.
2. Touch or click Graphics.

3. On the Change Graphic screen, touch or click the button identifying how 
you want to search for the new graphic.
• Search by Keyword and Browse Categories search the graphics 

provided with the software. When you locate the graphic you want, touch or 
click the thumbnail. 

• Find My Own Graphic lets you search the graphic files elsewhere on your 
Design Center touch computer or PC. When you find the graphic you want, 
touch or click its icon, then touch or click OK to use it and return to the Edit 
screen.
Graphic files that use any of these supported formats will be displayed:
- Bitmap (*.bmp)
- TIFF (*.tif)
- JPEG (*.jpg)
- Portable Network Graphic (*.png)
- Windows Metafile (*.wmf)
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TIP
For best results, use high-resolution graphics (such as those used for printing 
in yearbooks or letterheads). Most images created for a website don’t work 
well because of their lower resolution. 

4. When ready to print the project, touch or click Next to go to the Print 
Preview screen.
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Remove a Graphic from a Template

To remove a graphic:
1. On the Edit screen, 
2. Touch or click the graphic (or graphic placeholder) you want to remove.
3. On the Design tab, touch or click Delete Object (to undo the deletion, click 

Undo).

TIP
The graphic is removed from the template, but not deleted from the Design 
Center Software. You can always search or browse the software graphics to 
find and restore the graphic.

4. To add a graphic, follow the steps of the procedure "Change Graphics on a 
Template," page 6-16. 

TIP
If you save the changed template after removing a graphic, you can always add 
a graphic back in — either the original or a different one.

5. Touch or click off object to continue with your project.
6. When ready to print the project, touch or click Next to go to the Print 

Preview screen.

Note: You can also delete graphics under the Graphic Tab
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Insert a Graphic

TIP
Make sure that a graphic object is not selected. If a graphic object is selected, 
the new graphic will be placed in that object box. To deselect a graphic, click 
in an empty area outside the editing box.

To insert a graphic:
1. From the Edit screen
2. Touch or click Graphics tab, then Graphics.
3. Browse to the location of your graphic using one of the search options. 

TIP
Move the graphic to the desired location on the template and size as needed.

4. Repeat this procedure to add another graphic. 
5. To change an existing graphic:

a. Touch or click the graphic object, then touch or click Graphics.
6. Browse to the location of your graphic using one of the search options. 

7. When done, touch or click off the object and continue with your project.
8. When ready to print the project, touch or click Next to save your project (if 

desired) and go to the Print Preview screen. 
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Rotate a Graphic
When you import or select a graphic, you can rotate it in 90° increments. This 
is done through the Design Tab.

Note: The Rotate option will work on graphics and text elements in a 
custom or Design Center software template.

To rotate a graphic:
1. In the Edit screen, touch or click Design Tab.
2. Locate and select your graphic. It displays with boundary boxes.
3. Touch or click the Rotate button to rotate the graphic.

a. Each click will rotate the graphic 90° counterclockwise.
4. When done, touch or click off the graphic.
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Flip a Graphic
You can select an image and flip it to face the opposite direction. This is 
useful, for example, when you have two graphics and want them to face 
toward each other.

To flip a graphic horizontally:
1. In the Edit screen, touch or click Graphics.
2. Locate and select your graphic.
3. Move and/or size the image as desired.
4. Touch or click a Flip Graphic.
5. Touch or click Flip Graphic. The graphic will be flipped 180° horizontally.
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Rotation using Bounding Box
You can select an graphic and rotate it using the bounding box surrounding it. 
This can be useful when you want to make a smaller rotation of your graphic. 

To rotate a graphic:
1. In the Edit screen, touch or click the graphic.
2. Select the handle of the graphic (this will be the one square hanging a bit 

outside of the perimeter, you will get a ¾ circle with arrow)
3. Keep finger on screen or mouse arrow on handle and start movement.
4. Once done with movement, release finger / mouse and movement will 

stop.

Note: Rotation must be made in 15° increments. If this is not achieved, a 
colored box will print where the text or graphic should be.
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Printing a Poster or Banner

When you are ready to print your poster or banner, you have several options, 
depending on the type of project. If you have customized the template, you will 
be asked if you want to save the template before initiating the printing process.

Saving a Template before Printing
If you have made any changes to the template, you will be prompted to save it 
when you choose Next to move from the Edit screen to the Print Preview 
screen. 

TIP
Consider these guidelines for saving a template:

• If you plan to re-use or output additional copies of a template you have 
customized, you should save it. It can be opened later via the My Files option 
on the Find screen.

• Saved templates can be exported to a USB device so they can be transported 
between your local PC and the Design Center Software. 

• If you did not make any actual changes, or if you don’t plan to reuse this 
customized version in the future, it is not necessary to save your changes.
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To save a customized template for a poster or banner:
1. When finished editing, touch or click Next. A pop-up message will ask 

whether you want to save the file.
• Touch or click Yes to save it under a new name. If you save the file, you can 

later export it to a USB device so you can transport it between your local PC 
and the Design Center Software.

• Touch or click No if you don’t want to save it, but want to proceed to printing.
• Touch or click Cancel to remain on the Edit screen (e.g., to continue further 

customization).

2. If you want to save the template, enter the name you want to use on the 
Virtual Keyboard, then touch or click OK.

3. At the confirmation message that the template was saved, touch or click 
OK to continue.
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4. To complete your project, go to: 
• Printer Connected: "Printing," page 6-26.
• Printer Not Connected: Touch or click Finished to end this session and 

return to the Find Posters & Banners (Poster Maker) screen.

TIP
If you are not connected to a printer, you can save your file and export it to a 
USB device so that you can transport the file between your local PC and the 
Design Center Software connected to the printer. See "Importing and Exporting 
Saved Files," page 1-34.
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Printing
The VariQuest® Poster Maker 3600 or ProImage™ PosterPrinter 3000 
system provide a number of powerful features which allows for on-screen 
preview of the ready-to-print template. The Poster Maker also includes a bi-
directional communication feature with the Design Center Software, which 
allows for on-screen preview of the ready-to-print template. 

The Design Center Software lets you print an 8.5” by 11” copy on a regular 
sheet-fed printer. This is extremely helpful for creating handouts to accompany 
the poster, or to use with the scan-to-print feature of the Poster Maker or 
PosterPrinter in stand-alone mode (i.e., when it is not connected to the Design 
Center touch computer or a PC). You cannot print 8.5" x 11" copies of 
banners.

To print a poster or banner:
1. Make sure the output device is turned on and the correct paper is loaded. 

• If you are using a Poster Maker: 
The software automatically sizes the template to match the size of the paper 
in the printer. The Output Size appears below the preview on the screen 
and the Paper Width screen does not appear. 

• If you are using a PosterPrinter:
Touch or click the paper size from the options on the screen, be sure to 
select the size of the roll that is installed in the printer.

TIP
For the PosterPrinter: When changing the paper roll, turn off the 
printer, install the paper, then turn it back on again. This allows the 
printer to change the settings to match the new paper size.
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2. With your poster or banner project displayed on the Print Preview screen, 
touch or click the up/down arrow keys to change the number of copies you 
want. The number in the Copies box defaults to 1.

TIP

When printing multiple copies from the VariQuest® Poster Maker 3600, check 
the LCD display to make sure you have enough paper to output all of the 
copies you want.

3. In the Optional box select the following, if desired:
• Poster Maker 3600 and ProImage™ PosterPrinter 3000: Reverse the 

colors of the preview for the printed poster or banner by touching or clicking 
Reverse Color.

TIP

VariQuest® templates are provided for a variety of designs. Not all 
templates will look good printed in reverse. If you choose the Reverse 
Color option, be sure to review the preview before printing to verify that 
reversing the colors will generate the desired output.

TIP
The preview window will update to show the reverse colors as they will be 
printed.
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• If you selected a sheet-fed printer as an output device, you can also print an 
8.5” x 11” copy of a poster or proof from that printer. To do so, touch or click 
Print 8.5 x 11 in.

If you did not select a sheet-fed printer as an output device, the 
Print 8.5 x 11 in. button will not appear on this screen. 

TIP
For more specific details on setting up output devices, see "Selecting 
Output Devices," page 2-5.

4. When ready to output your project, touch or click Print.
A pop-up window lets you know the status of the print job and options for 
canceling it, if any. When the entire print job has been sent to the printer, 
the pop-up window closes, leaving the Print Preview screen displayed.

TIP
For the Poster Maker 3600: 
The Print button is greyed-out if the printer is not communicating with the 
Design Center touch computer or PC. You must wait until communication is re-
established before you can start your print job.

5. When finished with the project and the Posters & Banners design element, 
touch or click Close.
Other options are:

- Print additional copies.
- Go Back to make changes to the design.
- Start Over or Finished to work on a new poster or banner project. 
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Print a PDF File 
The My PDFs section allows for quick and easy PDF printing. The file is 
automatically scaled according to the output size selected, making the printing 
process even easier! If you experience difficulty during the printing process, or 
your output is not printing correctly, try printing using Adobe® Reader or the 
native program the from which the PDF file was created.

TIP
The My PDF function is not available with the ProImage series of 
PosterPrinters. My PDF only works with the Poster Maker 3600 model.

Note: There is a 99 page limit on the imported PDF file. Any remaining 
pages in the file will be truncated.

To print a PDF file:
1. On the Find Posters and Banners menu, touch or click My PDFs.
2. In the Find File menu, browse to the location of your PDF file, then touch 

or click OK.
3. In the Print Preview screen, use the arrow buttons to:

• view all pages in the PDF by touching or clicking the left or right arrow 
buttons at the bottom of the screen.

• increase or decrease the number of copies in the Copies box.

TIP
To export this file to a USB drive instead of printing, select Finished, 
then go to My Files to export it.

4. Touch or click Print.
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Print from a non-Design Center Software File
This section applies to the Poster Maker 3600 only. 

You can print from a non-Design Center Software file, as long as the source 
software is installed on your Design Center touch computer or PC. Formats 
that you can print from are:

- PDF (.pdf) - See "Print a PDF File," page 6-29
- Microsoft Word (.doc)
- Microsoft Excel (.xls)
- Microsoft Power Point (.ppt)

1. From anywhere in the Design Center Software, touch or click Exit.
2. Touch or click Minimize Software.

3. Navigate to the file you want.
4. Touch or click to open your file. It will open in its own application in a 

separate window.
5. To send the file to the Poster Maker, use the Print command in the source 

application (e.g., select File>Print). 
6. On the source application’s Print screen, select your printer from the drop-

down list to print your file:
• Poster Maker 3600: Select the VariQuest Poster Maker 3600. 
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7. Select Properties.

8. On the Properties screen, click Advanced, then:
• PM 3600: under Document Options, set Color Setting to Full Color 

(dither to mono), then click OK.
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9. Set Paper Size:
• On Advanced tab, click Properties, then:

- set Roll paper Size for the paper roll you have installed in the printer.
- set Document Size to 8.5 x 11.

10. Select OK to close all of the setup windows and return to the print screen.

11. On the Print screen, select Print to print the file.

TIP
After printing the external file, it is important to reset the print settings to 
those needed by the Design Center Software. Otherwise, the Design Center 
templates will not print correctly. 
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To reset the print settings for the Design Center Software:
1. Repeat steps 4 through 9 of the previous procedure, but with these 

differences:
• for Roll Paper Size setting, select Set By Program.
• for Document Size, select USER.

2. After closing all windows until only the Print screen displays, select Close 
(instead of Print). 

3. Choose another external file to print.
- or -

4. In the Windows task bar, click the VariQuest icon to maximize the Design 
Center Software and continue working.
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Overview

The VariQuest®  Cutout Maker 1800 and VariQuest® Design Center Software 
provide a fast, easy and fun way to create a variety of cutouts. With the Cutout 
Maker, you can cut letters, numbers, and symbols as either individual 
characters or connected into words for display on bulletin boards, poster 
boards, and other such projects.

Color Coding
• Distinctive color coding in the Design Center Software lets you easily 

orient yourself to the specific output types. Thumbnails in the preview 
window(s) are also color coded. Whenever you are working on the 
Cutout Maker 1800, the tab at the top of the screen and the controls are 

color-coded with Orange .

Thumbnail Labeling
The label name of a thumbnail includes the Content ID and its activation 
status (activated or not activated). When you click a thumbnail, a preview will 
popup with additional information about the item:

• ID #
• Name
• Associated Learning Module (if applicable)
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Using the Virtual Keyboard
The Virtual Keyboard is a graphical representation of a keyboard and text-
entry box that appears whenever you need to enter or change text. 

You can use the Virtual Keyboard just like a regular keyboard to “type” text 
into the text-entry box using your Design Center touch computer, an attached 
mouse to point and click keys on the virtual keyboard or from an attached 
keyboard or PC. 

TIP
Touch or click Spanish Letters once to display accented Spanish letters. Touch 
or click again to return to the standard keyboard.

Note: For more specific details on using the Virtual Keyboard or entering 
Spanish text, see "Using the Virtual Keyboard," page 1-21 in the Software 
User’s Guide.
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File Management

When doing a search, the Find screen opens with search options that you can 
use to find a template, shape, collection, graphic or design element, or one of 
your own saved projects. 

TIP
Search results show only the content for the output type and grade level(s) you 
have selected. If your search does not return an expected result, check that 
your Content Preferences include the appropriate grade level(s).

Search for Files
To search by: 

• Keyword: Locate a template or file using either:
- Design Center Software ID: The ID is listed with each template, shape, 

and collection in the VariQuest® Content Guide
- Content Keyword: Enter a keyword such as “sports” or “numbers.”

• Browse Categories: Search through all templates, shapes, collections, 
graphics and design elements. The files are grouped into categories and 
subcategories, such as “animals” or “weather.” 

• My Files: Search your own templates. When you customize a template, 
you can save it under a different name for future use. Later, you can find 
your saved templates through the My Files option. 

TIP
For more specific details on searching for files, see "Locating Files in the 
Software," page 1-25 in the Software User’s Guide.
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Basic Process

The general process for creating cutouts includes these basic steps. For more 
detail, see the remainder of this document.

To create a cutout or collection:
1. Choose a cutout from the available cutout types:

• Letters, Numbers & Symbols (also known as “fonts”): Cutouts of 
characters found on the keyboard.

• Shapes: Includes shapes, shapes with cutout text inside, or shapes with 
text objects (Signs & Decals only).

• Collections: A set of coordinated shapes related to a single bulletin-board 
theme, craft project, or curriculum concept.

• My Saved Jobs: Your previously saved cutout jobs.
2. Select the type and size of material you will use in the Cutout Maker.
3. Make any modifications to the cutout and set the number of copies. 
4. Send the cut job to the Cutout Maker.

Creating all three cutout types: Letters, Numbers & Symbols, Shapes and 
Collections, involves the same basic steps, yet each type has a few unique 
features.
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Letters, Numbers & Symbols

The Cutouts & Collections design element lets you choose the style, size, 
characters and quantity for your letters, numbers & symbols. The Cutout 
Maker then generates and cuts whatever character(s) appear in the text box 
on the Virtual Keyboard (including Spanish characters). 

To make cutouts of letters, numbers, and/or symbols:
1. Touch or click Letters, Numbers & Symbols. 

2. On the Enter Text screen, touch or click the characters you want to create 
as cutouts. 

TIP
You can enter any character that appears on the keyboard (including Spanish 
letters) up to a maximum of 32 characters. If you use any Spanish letters, you 
must change the font type to LloydVQ. 
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3. When done, touch or click Next. The Modify Your Text screen displays 
with an outline of the characters you entered.

TIP
Initially, the characters will display in Janet VQ font, which is one of two default 
fonts that come with the Design Center Software. If your organization has 
purchased additional fonts, those fonts will be included in the Font list. 

TIP
Currently, LloydVQ is the only font that supports Spanish Letters. If you use 
any Spanish letters, you must change the font type to LloydVQ. 
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4. To select a different font, touch or click the name of the font. The outline in 
the preview box will change to reflect the shape of the new font.

TIP
The default arrangement of characters is "Normal Text," which means each 
character will be cut out separately. To reduce the time involved in setting up a 
display, you can "join" the letters to form a single cutout. When you join 
characters, they are "squeezed" together and overlap slightly. There are two 
options for printing characters.
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5. To join the characters, do one of these options:
• Connect Letters: Touch or click Connect Letters. The preview changes 

to show how the characters are connected.
- or -

• Add Bar (underline): Touch or click Add Bar. The preview changes to 
show the added underline.

TIP
With the Connect Letters option, only letters not separated by a space will be 
joined. With the Add Bar option, letters "and" spaces are joined. Both options 
join the characters horizontally. Characters with vertical spaces, such as the 
dots on the “i” and “j” and the two lines of “=” are not joined; these characters 
will still output in multiple pieces — one for each part.

Preview with Connect Letters selected

Preview with Add Bar selected
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TIP
When printing characters, you can also choose Preserve Letter Order 
to print the letters exactly as entered. For example, if you are cutting on 
vinyl and want to transfer the letters all at once, preserving the letter 
order will let you transfer all of the letters at once using vinyl transfer 
tape. If you do not use Preserve Letter Order, the letters will be 
organized to best conserve the material.

6. To preserve the letter order and print the text exactly as entered, click 
Preserve Letter Order. 

7. When done, touch or click Next and continue to "Common Procedures," 
page 7-25.
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Shapes

The VariQuest®  Cutout Maker 1800 can generate an enormous variety of 
shapes with the Design Center Software. You can cut shapes to match 
virtually any topic and, in some cases, you can also add text to shapes 
(e.g., merge a list of student names so that each copy of a cutout includes a 
unique name).

You can also create just the right size for these shapes using several preset 
standard sizes or choosing a custom size you specify.

Select and Edit Shapes
To make cutouts of shapes:
1. Touch or click Shapes. 
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2. Search for the shape you want:
• Touch or click Search by Keyword to locate the shape using its ID or name 

or to search by topic (e.g., “sports” or “insects”).
- or -

• Touch or click Browse Categories to browse through the shapes in all the 
categories and subcategories.

TIP
For detailed steps on using either search method, see "Locating Files in the 
Software," page 1-25 in the Software User’s Guide.

The results of your search or browse will display as thumbnails, showing all 
shapes that match your criteria. 

TIP
If the screen displays No Results Found, or if your expected result doesn’t 
appear, check that your Content Preferences include the appropriate grade 
level(s). Also check whether the Content Shown is "Activated" only or "All 
Content."
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3. Touch or click the thumbnail of the shape you want to use.
• If you choose a shape that includes a text item within it, see "Shapes with 

Name Lists," page 7-14 for information about using name lists to 
personalize each copy.

• If you choose Signs & Decals, see "Signs & Decals," page 7-19 for 
information about using and creating signs and decals.

4. When a magnified preview of the shape appears, touch or click OK to 
confirm your selection.

TIP
If you try to select a shape that has not been activated, you will be directed to 
contact Customer Service to order and activate the content (for more details, 
see "Obtaining Additional Content," page 1-37 in the Software User’s Guide).

5. Choose the material size and type (see "Select Material Sizes and Types," 
page 7-25).



7-14 Cutout Maker 1800 VariQuest® Design Center Software User Guide

Shapes
Select and Edit Shapes

Shapes with Name Lists
If your shape includes text, continue with this procedure. Otherwise, go to 
"Select Material Sizes and Types," page 7-25.

To include shapes with text items:
1. Be sure to have a shape that includes a name list selected (e.g., NPL002), 

then touch or click OK to accept the shape.
2. In the Include Cut Text screen, touch or click one of the options for 

including a name list, then follow the instructions for that procedure.
• Create/Edit List
• My Saved Lists
• Import list from Excel
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Create/Edit List

TIP
You can use the name list function to create a list of any text — not just names. 
For example, you can create a “name list” consisting of the months of the year 
if you want to create 12 shapes, each with a different month name.

1. In the Enter List Items screen, touch or click the names you want included 
the list, then touch or click OK.

2. In the Include Cut Text in Shape screen, click Next.
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3. When prompted, touch or click Yes to save your list, or No to continue 
without saving:
• Yes: Enter a name for your list, then touch or click OK.
• No: Click OK to continue with the project.

4. When prompted to save your list, touch or click Yes to save the list or No to 
continue without saving.

TIP
If you already have a list with this name, you will be asked if you want to 
overwrite the old list. If you select No, rename your list and click OK again.

5. If desired, select a different font (see "Change Fonts," page 7-21).
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My Saved Lists

Use this procedure if you have already created and saved a name list.

1. Touch or click My Saved Lists.
2. In the Saved Lists field, select the list you want, then touch or click OK.

3. In the Include Cut Text in Shape screen, touch or click Next.

4. To continue with your job, go to "Change Fonts," page 7-21.
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Import List from Excel

Use this procedure to import your name list from an Excel spreadsheet.

1. Touch or click Import List from Excel.
2. In the Import List screen, touch or click Find File.
3. Navigate to the location of your name list, then touch or click OK. The first 

sheet of the file will display the contents of Column A.

TIP
The column header is imported and will be included in the cut job unless that 
item is deleted. Only the information in Column A of the selected sheet is 
imported. Blank cells are ignored.

4. To choose another sheet in the imported file, touch or click the sheet name. 
The preview window is immediately updated.

5. In the Import List screen, touch or click OK.
6. To edit the name list:

• In the Include Cut Text in Shape screen, edit the file by touching or clicking 
Create/Edit List.

• In the Virtual Keyboard, edit the text that you do not want included in your 
list, then touch or click OK.

• In the Include Cut Text in Shape screen, click Next.
7. To continue with your cutout job, go to "Change Fonts," page 7-21.
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Signs & Decals
Signs & Decals allow you to create projects that include both text and 
graphics. When printed on vinyl material, you can use VariQuest transfer tape 
to transfer the cutout vinyl to windows, doors and other objects.

TIP
You cannot delete the text or graphics boxes in Signs & Decals templates. If 
you do not want text or graphics to be cut, leave the object box(es) empty.

To create signs & decals:
1. Touch or click Browse Categories and choose Signs & Decals. The 

available templates will display as thumbnails. 
2. Touch or click the template you want, then touch or click OK to accept it.

TIP
Signs & Decals templates are designed for optimum use and layout. You 
cannot add more text or graphic boxes to Signs & Decal templates. If you need 
additional object boxes, try choosing a different template.
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Text Editing

To edit the text:
1. Select a text box, then touch or click Edit Text. The Virtual Keyboard 

appears.
2. Touch or click the keyboard on your screen or PC to modify the text.

3. When done entering text, touch or click OK.

TIP
Remember to always select the text or graphic you want to change before 
clicking Edit Text or Graphics.

• When you select an editable text box or graphic, square “bullets” appear around 
it to indicate that it is selected.

• A blank space outlined by a thin dotted line indicates a text box. The text box is 
cut out If no text is entered.

• A thick black box with an X inside marks an area where a graphic can be 
placed. The graphic box is cut out if no graphic is inserted.

4. To continue modifying the template, go to:
• "Advanced Editing," page 7-23 to perform additional editing. 
• "Graphics," page 7-22 to insert or replace graphics.
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Change Fonts

TIP
At least two fonts are included with your Design Center Software. You can 
choose any for your text, however, if you are using Spanish Letters, you must 
choose LloydVQ.

To change a font:
1. At the Select Font screen, touch or click the font you want to use for your 

cut text. 

TIP
Whenever you make a change, the template preview will update immediately.

2. Touch or click OK.

TIP
If your template contains more than one modifiable text item, you can select 
another text item without going back to an earlier screen. Just touch or click 
the next text object you want to modify and follow the steps of this procedure.

3. When ready to print the project, touch or click Next to go to the Print 
Preview screen.

TIP
To reduce wasted space, the text bounding box is automatically sized to fit the 
text when the job is sent to the printer. 
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Graphics

VariQuest® graphics are provided for a variety of designs. Not all graphics will 
look good on all templates, so you may need to experiment to find the graphics 
that work best for your specific template.

To change a graphic:
1. On the Edit screen, touch or click the graphic you want to change.
2. Touch or click Graphics.

3. On the Change Graphic screen, touch or click the button identifying how 
you want to search for the new graphic:
• Search by Keyword searches graphics based on keyword(s) you enter.
• Browse Categories searches the graphics based on categories within the 

software. 
4. When you locate the graphic you want, touch or click the thumbnail. 
5. When ready to print the project, touch or click Next to go to the Print 

Preview screen.

TIP
To reduce wasted space, the text bounding box is automatically sized to fit the 
text when the job is sent to the printer.
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Advanced Editing
Advanced editing gives you additional control over the content of the template.

TIP
When sizing text, the object box remains centered on the sign or decal -- only 
the font size changes. This is to ensure that the text is always centered on the 
sign or decal. When sizing graphics, both the graphic and object box changes. 
You may need to reposition the graphic after sizing it.

To do advanced editing:
1. From the Edit screen, touch or click Advanced Edit, then use any of these 

buttons to change the editable objects on the template: 

Touch or click to change the text in a text box. When the Virtual 
Keyboard appears, enter the new text, then touch or click OK. 
Select a text object, in the Select Font screen, touch or click to 
select a different font, then touch or click OK.
Touch or click to change an existing graphic. In the Change 
Graphic screen, browse to the location of the new graphic, then 
touch or click OK. 
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2. To further edit objects, you can do any of the following:
• Move editable objects: Touch and drag the object (cannot be done from 

normal editing mode).
• Change graphic size or proportionally size text objects: Touch or 

click the Size (+) or (-) button to increase or decrease the size.
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Common Procedures
Use these procedures to complete the cutout process for Letters, Numbers & 
Symbols and/or Shapes.

Select Material Sizes and Types
Selecting the right material type is important because the choice determines 
the optimal settings for blade pressure and depth on the Cutout Maker. 

If you select the right material type, but the blade cuts either too deep or not 
enough, you can adjust the blade depth using the Adjust Material Settings 
option (see "Adjusting Blade Depth," page 7-44).

CAUTION!CAUTION!
Material types have been thoroughly tested. Using an unlisted material type or 
choosing the wrong type could damage your equipment.

The Design Center Software makes it easy to select from the three most 
common material sizes:

• 12” x 18” (large construction paper)
• 9” x 12” (small construction paper)
• 8.5” x 11” (bond paper and card stock)

You can also specify a nonstandard paper size using the Custom option. This 
lets you maximize the use of your material, save money, and make use of 
odd-sized scrap material.

The Cutouts& Collections design element also lets you choose from a number 
of material types: 

TIP
When vinyl is selected, a "weeding box" is added to the cutout to allow the 
objects to be more easily removed using transfer tape. See example for 
"Setting Up the Cutout Maker for Output," page 7-34.

Material Type Typical Weight or 
Size

Heavy construction paper — regular or cold-laminated 60-80 lbs
Light construction paper — regular or cold-laminated 40-50 lbs
Card stock 80-100 lbs
Bond (i.e., typical printer or copier paper) 20 lb
VariQuest® Magnetic Sheets 0.018 - 0.024 in.

VariQuest® Vinyl Sheets (includes adhesive but not liner) 0.063 - 0.09 mm
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Standard Material Size and Type

Follow this procedure when using pre-defined standard material sizes and 
types. For custom material, see "Custom Material Size and Type," page 7-27.

To select the size and type of material for a cutout:

TIP
When you first access this screen, both the material size and type will default 
to the most recent selections made on this screen.

1. In the Material Size and Type window, touch or click the box next to the 
Material Size you want for this project. 
• For custom size material, skip the rest of this procedure and go to "Custom 

Material Size and Type," page 7-27.
2. In the Material Type list, touch or click the Material Type you want to use.

TIP
If you choose Magnetic material, you will need to change the cutting blade. Go 
to "Using VariQuest Magnetic Sheets with Cutout Maker," page 7-37. 

If you choose Vinyl material, you may also want to use transfer tape. See 
"Using Transfer Tape with VariQuest Vinyl Sheets," page 7-38.

3. Touch or click Next.
4. Go to "Adjust Cutout Size," page 7-29.
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Custom Material Size and Type

Use this procedure to use custom size material sizes and types. To use one of 
the pre-defined standard material, see "Standard Material Size and Type," 
page 7-26.

1. In the Material Type list, touch or click the Material Type you want to use. 
2. From the Material Type and Size screen, touch or click Custom. 

3. Click Next. The Custom Size screen opens.

TIP
The “scrap paper” graphic on the Custom Size screen defaults to 6” x 6”. The 
smallest paper size is 4.5” x 6”.
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4. Touch or click the plus (+) and/or minus (-) buttons until the scrap paper 
dimensions on the screen match the size of your material.

TIP
If you are using a piece of scrap material that is not rectangular, measure the 
largest rectangular area of the scrap, and use those dimensions for setting the 
custom size.

5. When satisfied with the output size, touch or click Next to continue.
6. Go to "Adjust Cutout Size," page 7-29.
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Adjust Cutout Size
The Select Size screen shows both the relative size and placement of cutouts 
on the material that will result in the least amount of waste. When you change 
the size, the preview will update.

To select a text or shape height:
1. When the Select Size screen displays, select the height you want for your 

text or shape. To change the output size, do one of the following:
• Touch or click one of the predefined sizes. To ensure that Signs & Decals 

are usable, the predefined sizes are different than other cutouts.

TIP
For Text, the number of inches reflects the approximate height of the tallest 
letters, plus descenders. For Shapes the number of inches reflects the length of 
the larger dimension.

• Touch or click Custom to set a size not listed. Then:
- Using the numeric keypad, touch or click the number(s) equal to the 

approximate height of the tallest letter (plus descenders), or largest 
dimension. To delete a number, touch or click Backspace.

- Touch or click OK to accept your entry and close the keypad.

Text
(Normal)

Text
(Signs & Decals)

Shapes
(Normal)

Shapes 
(Signs & Decals)

Small (approx. 2") Small (approx. 6") Small (2”) Small (6”)
Medium (approx. 4") Medium (approx. 8") Medium (4”) Medium (8”)
Large (approx. 6") Large (approx. 10") Large (6”) Large (10”)
Extra Large (approx. 12") Extra Large (approx. 12") Extra Large (12”) Extra Large (12”)
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• Touch or click Largest Possible on Page to produce the largest cutout 
without “tiling” (i.e., cutting a character or object in two or more pieces).

TIP
It is possible to increase the cut size so much that a single object is too big to 
fit on one sheet. In that case, a message will indicate that one or more objects 
will be tiled (split onto multiple sheets). It is also possible to decrease the size 
to the point that it loses some definition. In that case, a message indicates that 
a object is smaller than the minimum cut size. When you see either message, 
you can adjust the cut size accordingly.

2. When satisfied with the output size, touch or click Next to continue.
3. Go to "Select the Number of Copies or Shapes," page 7-31.
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Select the Number of Copies or Shapes
1. On the Number of Copies screen, enter the number of cutouts you want to 

generate by touching or clicking the numbers on the numeric keypad or the 
PC.

TIP
When you change the quantity, the screen updates the preview layout and the 
page count below it. Use the arrows to scroll through all pages.

TIP
The option to fit as many as possible on a page lets you maximize the use of 
your material. Be sure to verify the final quantity. For example: If you choose 
As Many as Possible on Page, which results in 8 shapes on a page, the 
number of copies will automatically change to 8. But if you want 16 copies, you 
need to replace “8” with “16” using the keypad. The Cutout Maker will then cut 
two pages of 8 shapes each.

2. Click Next to continue to the prepare to cut preview screen.
3. Go to "Preview Your Job," page 7-32.
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Preview Your Job
When you have a number of shapes and/or text to cut, you can save both time 
and material by generating them in the same session and sending them to the 
Cutout Maker in one batch.

You can add as many shapes, letters, numbers, and symbols as you want to a 
single cut job. A collection is the only output type that must have its own cut 
job.

To cut multiple shapes and/or font characters in one job:
1. On the Preview screen, before sending your job to the cutter, touch or click 

Add More to Job.

2. On the Output Type screen, touch or click either Letters, Numbers & 
Symbols or Shapes (Collections cannot be added).

3. Follow these procedures to create the additional text or shape: 
• "Letters, Numbers & Symbols," page 7-6
• "Shapes," page 7-11.

TIP
You can adjust the size of only the most recently added cutout. After selecting 
Add More to Job, the size of the cutouts already in the layout cannot be 
changed.

4. When done, touch or click Next.
5. Go to "Save Cut Jobs and Prepare for Cutting," page 7-33.
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Save Cut Jobs and Prepare for Cutting
When you have completed your job, before sending it to the Cutout Maker, 
you will be given the opportunity to save the cut job so that you can use it 
again.

TIP
You cannot edit a cut job after it has been saved. You can only re-cut it.

1. At the prompt to save your job, select Yes to save the cutout job or No to 
continue without saving.
• No: Continue to the next step.
• Yes: In the Virtual Keyboard, enter a name for your cut job, then touch or 

click OK. A message will display indicating that your job has been saved.
2. In the Cutting Job screen, follow the prompts to connect your cutout maker 

and continue cutting the job. 

.
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Setting Up the Cutout Maker for Output
When satisfied with your cutout project, your final step is to send the project to 
the VariQuest®  Cutout Maker 1800 to be cut. The procedure is similar for all 
cutout types.

To output cutouts:
1. After preparing a cut job, touch or click Next from the Preview screen. The 

Cutting Job screen displays with a message to go to the Cutout Maker and 
follow the instructions on the LCD display.

Example of weeding box for vinyl material cutouts:
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2. Load the material for the first page of the job: 
• When prompted by the Cutout Maker:

- Load the material type selected for the project.

TIP
If you choose Magnetic material, you will need to change the cutting 
blade. See "Using VariQuest Magnetic Sheets with Cutout Maker," 
page 7-37. 

- Load the correct material color, if cutting a job that uses multiple colors.
• Always place the sheet so its upper-left-hand corner fits snugly into the top 

left-hand corner of the cutting bed (see illustration).
• If cutting two smaller pages side-by-side, place the first sheet so its upper-

left corner fits snugly into the top-left corner of the cutting bed. Then place 
the second sheet next to the first one, ensuring there is no gap between the 
sheets.

3. With the sheet loaded, press GO on the Cutout Maker.
4. When prompted, smooth the sheet on the cutting bed to ensure any 

wrinkles or curls are flattened out, then press GO again.
5. When the first page is done, remove the material from the cutting bed.
6. If your cut job is more than one page, repeat Steps 2 through 5 for each 

page.
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7. When the cutouts are done, the Done Cutting screen will display. Touch or 
click one of the following options to continue:

- New Job (back to start): Returns to the Output Type screen where 
you can start another job.

- Recut Complete Job: Returns to the Cutting Job screen.
- Recut Page(s): To recut pages, touch or click one or more of the 

pages, then select this button.
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Using VariQuest Magnetic Sheets with Cutout Maker
When using VariQuest® Magnetic Sheets with the VariQuest®  Cutout Maker 
1800, you will need to use a blade designed specifically to cut magnetic 
material. 

For more information or additional assistance, please contact VariQuest® 
Technical Support at 800.328.0585 or visit www.variquest.com. 

TIP
Blades for magnetic material are identified with blue coloring on the blade tip.

If you select VariQuest® Magnetic Sheets from the Material Size and Type 
screen, you will be prompted to change the cutting blade to the magnet blade.

To change the cutting blade:
1. Remove the power from the Cutout Maker.
2. Open the gantry top cover by lifting up its left side.
3. Locate the blade holder.
4. Rotate the blade holder 90° toward the front of the machine.
5. Press the blade release button at the rear of the blade holder to eject the 

existing blade.
6. Using the cork end of the blade-removal tool, remove the blade from the 

blade holder.
7. Insert the magnet blade (with blue coloring on tip) until only a ¼-inch of the 

blade protrudes from the holder.
8. Turn the power on. The blade will retract within the blade holder.
9. Rotate the blade holder assembly 90° backwards to its operating position.
10. Close the gantry top cover.

CAUTION!CAUTION!
Use only VariQuest® Magnetic Sheets. No other magnetic materials have been 
tested or qualified for use with the Cutout Maker. Use of other unqualified 
materials may result in loss of manufacturer’s warranty. 
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Using Transfer Tape with VariQuest Vinyl Sheets
After completing a cutout job using VariQuest® Vinyl Sheets, you can use 
transfer tape to easily transfer your cutout to permanent surfaces such as 
walls, lockers, cars and more. Using transfer tape can help keep vinyl cutouts 
in their original shape without stretching or wrinkling.

TIP
When using vinyl material, a "weeding box" is also cut around the object boxes 
to make removing the cutouts easier.

For more information or additional assistance, please contact VariQuest® 
Technical Support at 800.328.0585 or visit www.variquest.com. 

To use transfer tape:
1. Complete the cutout job.

2. Use the tweezers provided in the VariQuest®  Cutout Maker 1800 
Maintenance Kit to remove any unnecessary areas around cutout shapes 
and letters.

3. Using scissors, cut the transfer tape to a size slightly larger than the cutout 
that needs to be transferred.

TIP
For cutouts wider than 6”, overlap two pieces of transfer tape to cover the entire 
cutout.

4. Press and rub the transfer tape firmly over the cutout to eliminate any 
wrinkles or creases.

5. Gently pull up to ensure the cutout adheres to the transfer tape.
6. Place the cutout, adhesive side down, onto the permanent surface.
7. Rub the transfer tape firmly over the cutout.
8. Remove the transfer tape. The vinyl cutout will be adhered to the 

permanent surface.

CAUTION!CAUTION!
Use only VariQuest® Vinyl Sheets. No other vinyl materials have been tested or 
qualified for use with the Cutout Maker. Use of other unqualified materials may 
result in loss of manufacturer’s warranty. 
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Collections

Another option for making cutouts is to generate a coordinated set of graphics 
such as a theme-based bulletin board or an instructional unit involving the 
assembly of parts.

The VariQuest® Design Center Software offers collections of coordinated 
graphics, making it easy to generate the cutouts and ensure the various 
pieces are grouped together for cutting in the correct size and on the correct 
color of material.

TIP
You cannot modify any parts of collection, however, you can change the 
overall collection size.

Make Cutouts using a Collection
To make cutouts using a collection:
1. Touch or click Cutout Maker. 
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2. Select Collections.

3. Search for the collection you want:
• Touch or click Search by Keyword to locate the shape using its ID or name 

or to search by topic (e.g., “sports” or “USA”).
- or -

• Touch or click Browse Categories to browse through the collections in all 
categories and subcategories.

TIP
For detailed steps on using either search method, see "Locating Files in the 
Software," page 1-25 in the Software User’s Guide.

The results of your search or browse will display as thumbnails, showing all 
collections that match your criteria. 

TIP
If the screen displays No Results Found, or if your expected result doesn’t 
appear, check that your Content Preferences include the appropriate grade 
level(s). Also check whether the Content Shown is "Activated" only or "All 
Content."
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4. Touch or click the collection you want, then touch or click OK in the 
magnified preview. The Material Size & Type screen opens.

5. Select the material size and type (, then touch or click Next.
6. To change the width and height of the overall display, touch or click the 

plus (+) and/or minus (-) buttons. Any changes you make to one 
dimension will change the other dimension proportionally.

TIP
As you size the collection, you may get either of two messages (if you get 
either message, consider adjusting the size):

• One or more shapes are smaller than the minimum cut size. Indicates that 
you should increase the size to ensure all pieces of the collection are cut out.

• One or more shapes are too large for a single sheet and will be tiled. 
Indicates that at least one piece of the collection will be cut into two or more 
parts.

7. When done, touch or click Next.
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8. In the Number of Sets screen, select the # of Sets you want for this 
collection.
When you set the quantity, the preview screen will update, as well as the 
number of pages. Use the left and right arrow buttons to scroll to view the 
other pages.

TIP
The quantity you choose specifies the number of sets of all pieces in the 
collection that will be cut out. A quantity of “1” generates one cutout of each 
shape in that collection, no matter how many shapes make up the collection.
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9. When done, touch or click Next. The Cutting Job screen displays with a 
message to go to the cutout maker and follow the instructions on the LCD 
display.

TIP
Collections pages are split by the color of material needed for the shapes in 
that collection.

10. Follow the steps in the procedure "Setting Up the Cutout Maker for Output," 
page 7-34.

11. When the cutouts are done, the Done Cutting screen will display. Touch or 
click one of the following options to continue:

- New Job (back to start): Returns to the Output Type screen where 
you can start another job.

- Recut Complete Job: Returns to the Cutting Job screen.
- Recut Page(s): To recut pages, touch or click one or more of the 

pages, then select this button.
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Adjusting Blade Depth
Normally, adjustments are not necessary, but if the blade cuts too deeply into 
the cutting mat, or the blade doesn’t cut completely through the material, you 
can adjust the blade using the Adjust Material Settings button. 

You can adjust the cutter blade depth on the Cutout Maker from the Material 
Size and Type screen.

To adjust the blade depth:
1. In the Material Size and Type screen, select the Material Type that 

matches the material you intend to use in the Cutout Maker.
2. Touch or click Adjust Material Settings.
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3. From the list in the Adjust Material Settings screen, touch or click the 
material for which you want to make the blade adjustment.

4. On either side of the Blade Depth field, use the plus (+) and minus (-) 
buttons to make your adjustments if the blade:

- Does not cut completely through the material: Increase the blade 
depth setting by touching or clicking the plus (+) button.

- Cuts too deeply into the cutting mat: Decrease the blade depth 
setting by touching or clicking the minus (-) button.

TIP
You must click Done to save the blade depth settings.

5. When finished, touch or click Done to return to the Material Size and Type 
screen, then touch or click Next to continue with your project.



7-46 Cutout Maker 1800 VariQuest® Design Center Software User Guide

Collections
Adjusting Blade Depth

This page is intentionally left blank.



Chapter 8 Awards Maker 400 - Awards and 
Stickers

Chapter Overview
• "Overview," page 8-2

• "Color Coding," page 8-2
• "Thumbnail Labeling," page 8-2
• "Using the Virtual Keyboard," page 8-3

• "File Management," page 8-4
• "Search for Files," page 8-4
• "Search for My Graphics," page 8-4
• "Importing and Exporting Saved Files," page 8-5
• "Deleting Saved Files and Jobs," page 8-5

• "Basic Process," page 8-6
• "Finding a Template," page 8-7
• "Customizing an Award or Sticker Template," page 8-8

• "Text Editing," page 8-8
• "Change Text Content on a Template," page 8-8
• "Change Fonts on a Template," page 8-10
• "Add New Text Item," page 8-12
• "Remove a Text Item from a Template," page 8-13

• "Graphics," page 8-14
• "Change Graphics on a Template," page 8-14
• "Remove a Graphic from a Template," page 8-16
• "Insert a Graphic," page 8-17
• "Rotate a Graphic," page 8-18
• "Flip a Graphic Horizontally," page 8-19

• "Tab Descriptions," page 8-20
• "Name Lists," page 8-22

• "Add a Name List to a Template," page 8-22
• "My Saved Lists," page 8-25
• "View, Edit or Delete Name Lists from Edit Menu," page 8-27
• "Import Name List from Excel," page 8-29

• "Printing an Award or Sticker," page 8-32
• "Saving a Template before Printing," page 8-32

• "Guidelines for Saving a Template," page 8-32
• "Printing," page 8-34

• "Adjusting Print Density," page 8-38
• "Selecting Mirror Printing," page 8-39



8-2 Awards Maker 400 VariQuest® Design Center Software User Guide

Overview
Thumbnail Labeling

Overview

The Awards & Stickers design element lets you easily create a huge variety of 
awards and stickers. Often templates provide exactly what you need. 
However, you can easily customize templates to suit your own individual 
needs. 

With the addition of the VariQuest®  Awards Maker 400, the VariQuest® 

Design Center Software offers an easy way to print your awards and stickers 
in a range of sizes and colors, ready for immediate use.

TIP
Not every text item or graphic in awards and stickers templates can be 
changed. If you try changing a non-editable item, a message to that effect will 
appear on your screen. If you think it is essential to change the graphic or text 
item, try browsing for a different template design that would be better for your 
project.

Color Coding
• Distinctive color coding in the Design Center Software lets you easily 

orient yourself to the specific output types. Thumbnails in the preview 
window(s) are also color coded. Whenever you are working on the 
Perfecta, the tab at the top of the screen and the controls are color-

coded with Purple .

Thumbnail Labeling
The label name of a thumbnail includes the Content ID and its activation 
status (activated or not activated). When you click a thumbnail, a preview will 
popup with additional information about the item:

• ID #
• Name
• Associated Learning Module (if applicable)
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Using the Virtual Keyboard
The Virtual Keyboard is a graphical representation of a keyboard and text-
entry box that appears whenever you need to enter or change text. 

You can use the Virtual Keyboard just like a regular keyboard to “type” text 
into the text-entry box using your Design Center touch computer, an attached 
mouse to point and click keys on the virtual keyboard or from an attached 
keyboard or PC. 

TIP
Touch or click Spanish Letters once to display accented Spanish letters. Touch 
or click again to return to the standard keyboard.

Note: For more specific details on using the Virtual Keyboard or entering 
Spanish text, see "Using the Virtual Keyboard," page 1-21 in the Software 
User’s Guide.
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File Management

When doing a search, the Find screen opens with search options that you can 
use to find a template, shape, collection, graphic or design element, or one of 
your own saved projects. 

TIP
Search results show only the content for the output type and grade level(s) you 
have selected. If your search does not return an expected result, check that 
your Content Preferences include the appropriate grade level(s).

Search for Files
To search by: 

• Keyword: Locate a template or file using either:
- Design Center Software ID: The ID is listed with each template, shape, 

and collection in the VariQuest® Content Guide
- Content Keyword: Enter a keyword such as “sports” or “numbers.”

• Browse Categories: Search through all templates, shapes, collections, 
graphics and design elements. The files are grouped into categories and 
subcategories, such as “animals” or “weather.” 

• My Files: Search your own templates. When you customize a template, 
you can save it under a different name for future use. Later, you can find 
your saved templates through the My Files option. 

TIP
For more specific details on searching for files, see "Locating Files in the 
Software," page 1-25.

Search for My Graphics
You can also search for your own graphics from the Edit screen, by choosing 
Graphics, then the “find” option Find My Own Graphic.

TIP
For more specific details on searching for files, see "Search for My Graphics," 
page 1-32.
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Importing and Exporting Saved Files
You can import or export Awards Maker files to/from a USB device from the 
My Files section on the Menu screen. Once selected, your file will be imported 
into the Design Center or exported to the USB device.

TIP
If a file with the same name already exists on your Design Center touch 
computer, the file will not be imported.

Note: For more specific details on importing or exporting saved files, see 
"Importing and Exporting Saved Files," page 1-34.

Deleting Saved Files and Jobs
You can easily delete saved files you no longer want from the My Files menu 
page, selecting the file you want to delete and then clicking Delete.

Note: For more specific details on deleting files, see "Deleting Saved Files 
and Jobs," page 1-36.
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Basic Process 
The general process for creating awards and stickers includes these basic 
steps For more detail, see the remainder of this chapter.

To create an award or sticker:
1. From the Design Center Software main menu, touch or click Awards & 

Stickers. 
2. Use the search or browse functions to locate the design template you 

want.
3. With a template as your basis, modify it as desired:

• Change the content of editable text.
• Change the font, size, and style of editable text.
• Choose different graphics, remove graphics on templates with replaceable 

graphics.
• Add new text or graphics objects.
• Move and size editable objects.
• Add a name list to create personalized copies (on templates that use name 

lists).
4. Select the material size and type for output, and print.
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Finding a Template

Whether you want to create a new award or sticker, or print more of an 
existing one, your first step after launching the Awards & Stickers design 
element is to locate the template you want to use.

To search for a file:
1. Locate the template you want by using on one of the search options:

• Search by keyword or template ID
• Browse categories and individual templates 
• Select previously saved template 

2. On the Edit menu, modify the template as desired.
3. When ready to print the project, touch or click Next to go to the Print 

Preview screen.
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Customizing an Award or Sticker Template

Text Editing

Change Text Content on a Template

To change the content of a text item on a template:
1. With the template displayed on the Edit screen, touch or click the text you 

want to change. Once selected, it will be bordered by a square.
2. Touch or click Text, then Edit Text. 
3. On the Virtual Keyboard, modify the text.
4. When done, touch or click OK. The template will display with your text 

changes.

5. To continue modifying the template, go to Fonts & Styles, Design or 
Graphic Tabs to perform additional editing. 

6. To print, touch or click Next to go to the Print Preview screen.
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TIP
Remember to always select the text or graphic before clicking Edit Text or 
Graphics.

• A blank space outlined by a dotted line marks a text box in a template. The 
dotted line does not print; it simply marks the space where text can go.

• A thick black box with an X inside marks an area where a graphic can be placed 
in a template. The X and box do not print if you decide not to insert a graphic.

• When you select a text box or graphic, square “bullets” appear around it to 
indicate that it is selected. 
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Change Fonts on a Template

To change the text font, style, size or justification on a template:
1. On the Edit screen, touch or click the text you want to change

a. Text Size: Touch or click Font Size arrow buttons or key in size to 
make the text larger or smaller.

2. Touch or click Fonts & Styles.

3. Make the changes you want as follows:

TIP
If your template contains more than one modifiable text item, you can select 
another text item without going back to an earlier screen. Just touch or click the 
next text object you want to modify and follow the steps of this procedure.

• Font: On the Font list, touch or click the font you want (the list of font names 
appear in the actual typeface of their font). Use the up/down arrows to scroll 
through the list of fonts.

• Style: Touch or click B (bold), I (italic), and/or U (underline) to create the 
style you want. The style is “on” when the button is depressed (down), and 
“off” when the button is not depressed (up). You can apply any or all styles 
to the selected text.

• Justification: To change text justification (Left, Right or Centered), 
touch or click one of the justification controls. 
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TIP
Text justification only affects multiple lines of text within a single text object. It 
does not align the text object on the template.

4. When done, touch or click OK.
5. To continue modifying the template, go to:

• Design Tab, Graphic Tab or Text Tab
- Touch or Click off highlighted items to add new text Item or new 

graphic objects.
- Click New Text or New Graphic 

• Touch or Click on an object or text to change to replace or remove 
graphics.

6. When ready to print the project, touch or click Next to go to the Print 
Preview screen.
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Add New Text Item

TIP
Make sure that a text item is not selected. If a text item is selected, the new text 
will be placed in that text box. To deselect a text box, click in an empty area 
outside of the editing box.

To add a new text item:
1. With the template displayed on the Edit screen, touch or click Text.
2. Touch or click Text tab, then New Text.
3. In the Virtual Keyboard, type the text you want to enter, then touch or click 

OK. 

TIP
The new text item may be placed over existing items on the template.

4. To move the new text item, touch or click and drag it to a new area on the 
template.

5. If necessary, size the text item using the sizing buttons or key in a size.
6. Repeat this procedure to add another text item.
7. When done, touch or click off object and continue with your project.
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Remove a Text Item from a Template

To remove a text item:
1. On the Edit screen, touch or click the item you want to remove.
2. Touch or click the Design Tab, then touch or click Delete Object.
3. Or Under Text Tab, Touch or click the text you want to delete.
4. Touch or click Delete Text
5. To undo the deletion, click Undo (under either tab).
6. When done, touch or click off object to continue with your project.

7. When done, touch or click OK to continue with your project.
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Graphics
VariQuest® graphics are provided for a variety of designs. Not all graphics will 
look good on all templates, so you may need to experiment to find the graphics 
that work best for your specific template.

Change Graphics on a Template

To change a graphic:
1. On the Edit screen, touch or click the Graphics tab.
2. Touch or click the graphic you want to change.
3. Touch or click Graphics.

4. On the Graphics screen, touch or click the button identifying how you want 
to search for the new graphic:
• Search by Keyword and Browse Categories search the graphics 

provided with the software. When you locate the graphic you want, touch or 
click the thumbnail. 

• Find My Own Graphic lets you search the graphic files elsewhere on your 
Design Center touch computer or PC. When you find the graphic you want, 
select it, then touch or click OK to use it and return to the Edit screen.
Graphic files that use any of these supported formats will be displayed:
- Bitmap (*.bmp)
- TIFF (*.tif)
- JPEG (*.jpg)
- Portable Network Graphic (*.png)
- Windows Metafile (*.wmf)
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TIP
For best results, use high-resolution graphics (such as those used for printing 
in yearbooks or letterheads). Most images created for a website don’t work 
well because of their lower resolution. Black-and-white or grayscale graphics 
produce the best results, although grayscale graphics with many gradations 
can produce less-desirable results.

5. When done, touch or click OK to continue with your project.
6. When ready to print the project, touch or click Next to go to the Print 

Preview screen. 
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Remove a Graphic from a Template
To remove a graphic from a template:
1. On the Edit screen, click Design.
2. Touch or click the graphic you want to remove.
3. Then touch or click Delete Object. 
4. To undo the deletion, click Undo.

TIP
The graphic is removed from the template, but not deleted from the Design 
Center Software. You can always search or browse the software graphics to 
find and restore the graphic.

TIP
If you save the changed template after removing a graphic, you can always add 
a graphic back in — either the original or a different one.
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Insert a Graphic
To insert a graphic:

TIP
Make sure that a graphic is not selected. If a graphic is selected, the new 
graphic will be placed in that graphic box. To deselect a graphic, click in an 
empty area outside of the editing box.

1. From the Edit screen.
2. Touch or click the Graphics tab.
3. Select a graphic, then touch or click Graphics.
4. Browse to the location of your graphic using one of the search options. 

TIP
The new graphic may be placed over existing items on the template.

5. Move the graphic to the desired location on the template.
6. Repeat this procedure to add another graphic. 
7. To delete an existing graphic, touch or click the Design tab, then the 

desired graphic and touch or click Delete Object.

8. When done, touch or click off object and continue with your project.
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Rotate a Graphic
When you import or select a graphic, you can rotate it in 90° increments. This 
is done through the Design Tab.

Note: The Rotate option will work on graphics and text elements in a 
custom or Design Center software template.

To rotate a graphic:
1. In the Edit screen, touch or click Design Tab.
2. Locate and select your graphic. It displays with boundary boxes.
3. Touch or click the Rotate button to rotate the graphic.

a. Each click will rotate the graphic 90° counterclockwise.
4. When done, touch or click off the graphic.
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Flip a Graphic Horizontally
You can select an image and flip it to face the opposite direction. This is 
useful, for example, when you have two graphics and want them to face 
toward each other.

To flip a graphic horizontally:
1. In the Edit screen, touch or click Graphics.
2. Locate and select your graphic.
3. Move and/or size the image as desired.
4. Touch or click a Flip Graphic.
5. Touch or click Flip Graphic. The graphic will be flipped 180° horizontally.
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Tab Descriptions

Design Tab

Send to Back
Touch or click to send selected object to the 
back of all objects.

Bring to Front
Touch or click to bring selected object to the front of 
all objects.

Center Horz.
Touch or click to center the selected object 
horizontally on the page.

Center Vert.
Touch or click to center the selected object 
vertically on the page.

Rotate
Touch or click to rotate the selected object in 15° 
increments.

Delete Object
Touch or click to delete an existing graphic or 
text object.

Copy / Paste
Touch or click on object/ text to copy and paste 
then click or touch both copy and paste.

Undo Touch or click to undo the last action.

Text Tab

New Text

Touch or click to add a new text box. When the 
Virtual Keyboard appears, enter the new text, then 
touch or click OK. When a text object is selected, 
this button toggles to Edit Text.

Edit Text

Touch or click to change the text in a text box. 
When the Virtual Keyboard appears, enter the 
new text, then touch or click OK. When no text 
object is selected, this button toggles to New 
Text.

Size - +
Text Width
Text Height

Select a text box or graphic, touch or click 
- or + to increase or decrease the size, or the 
text width and height of a text box.

Fonts & Styles
Select a text object, in the Fonts &Styles screen, 
touch or click to select a different font, size, style or 
justification, then touch or click OK.

Horizontal Text
Vertical Text

Select the text orientation. Text in the selected 
text box will be changed to reflect the selected 
orientation.
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Graphics Tab

New Graphics

Touch or click to add a new graphic. In the Change 
Graphic menu, browse to the location of the new 
graphic, then touch or click OK. This button toggles 
to Graphics.

Graphics

Touch or click to change a selected graphic. In the 
Change Graphic menu, browse to the location of 
the new graphic, then touch or click OK. This 
button toggles to New Graphics.

Shapes
•Rectangle
•Oval
•Cross
•Star
•Triangle

Touch or click the button to insert the shape 
indicated, then touch or click OK. Size the object 
while it is selected. You can change the color 
from the Color tab. 

Size - +
Select a text box or graphic, touch or click 
- or + to increase or decrease the size.
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Name Lists

Add a Name List to a Template

To add a name list to a template:
1. On the Edit screen, touch or click the text where you want the names from 

your list to appear (e.g., “Student Name”).
2. Touch or click Name List.

TIP
Remember to always select the text before you click Name Text. If the text 
cannot be replaced by a name list, a message with that information will display.
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3. In the Add Name List screen, touch or click Create/Edit List.

4. To add names to your list, touch or click the keys on the Virtual Keyboard. 
After each name, touch or click Enter. 

5. When done, touch or click OK.
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6. The names you entered will display in the Text to Include list. Click OK to 
continue.

7. At the prompt to save your list:
• Touch or click Yes to enter a name for the list, then touch or click OK to 

return to the Edit screen with the first entry in your list displayed in the text 
box.

• Touch or click No to continue without saving. You will be returned to the Edit 
screen with the first entry in your list displayed in the text box.

8. Touch or click Next to continue with your project.
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My Saved Lists
Use this procedure if you have already created and saved a name list.

1. On the Edit screen, touch or click the text where you want the names from 
your list to appear (e.g., “Student Name”).

2. Touch or click Name List.
3. Touch or click My Saved Lists. The Name Lists screen will display all of 

your saved name lists with the items in the list displayed in the Preview 
box.

4. Select the list you want, then touch or click OK. 
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5. On the Add Name List screen, touch or click OK again to accept the list 
and display the first name in the template.

TIP
You can use only one name list per template. If you already used a name list 
for the template and want to use a name list for a different text item, change 
the first text item to standard text by touching or clicking Change Text and 
entering the standard text you want to appear. Then add the name list to the 
new text item.

6. Touch or click Next to continue with your project.
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View, Edit or Delete Name Lists from Edit Menu

To edit a saved list:

TIP
You can only delete a name list from Workroom Assistant.

1. Select the text object you want to edit, then touch or click Name List.

2. Touch or click My Saved Lists.
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3. From the Saved List column, choose the name list you want to use, then 
touch or click OK.

4. To edit your list (e.g., remove the column heading):
a. Touch or click Create/Edit List.
b. In the Virtual Keyboard, make the changes you want to the list.
c. When done, touch or click OK.

5. Touch or click OK, and when prompted touch or click Yes to save your list, 
or No to continue without saving.

6. If you selected Yes, enter the name of your list in the Virtual Keyboard, 
then click OK. Your list is saved and you will be returned to the Edit screen.

7. In the Edit screen, touch or click Next to continue with your project.
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Import Name List from Excel
1. Select the text object you want to edit, then touch or click Name List.
2. Touch or click Import List from Excel.
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3. In the Import List screen, touch or click Find File.

TIP
You can import name lists from your PC hard drive or from a USB device 
connected to the Design Center touch computer or PC.

4. Navigate to the location of your Excel file, then touch or click OK. The first 
sheet of the file will display the contents of Column A.

TIP
If you have a column header in the Excel file, the header will also be imported 
and included in the name list unless you delete that item.

Column
Heading
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TIP
Only the information in Column A of the selected sheet in the Excel file is 
imported. Blank cells are ignored.

5. To choose another sheet in the imported file, touch or click the sheet 
name. The preview window is immediately updated.

6. When done, touch or click OK. The list displays in the Add Name List 
screen.

7. If you want to edit your list (e.g., remove the column heading):
a. Touch or click Create/Edit List.
b. Edit the list in the Virtual Keyboard, then touch or click OK.

8. Touch or click OK, and when prompted touch or click Yes to save your list, 
or No to continue without saving.

9. If you selected Yes, enter the name of your list in the Virtual Keyboard, 
then click OK. Your list is saved and you will be returned to the Edit screen.
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Printing an Award or Sticker

Depending on the type of project, there are several options available for 
printing your award or sticker. If you have customized the template, you will be 
asked if you want to save the template before initiating the print process.

Saving a Template before Printing
If you have made any changes to the template, you will be prompted to save it 
when you choose Next from the Edit screen.

Guidelines for Saving a Template

TIP
Consider these guidelines for saving a template:

• If you plan to re-use or output additional copies of a template you have 
customized, you should save it and open it later via the My Files option on the 
"Find" screen.

• Saved templates can be exported to a USB device so they can be transported 
between your local PC and the Design Center Software.

• If you did not make any actual changes, or if you don’t plan to reuse this 
customized version in the future, it is not necessary to save your changes.
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To save a customized template:
1. When finished with the Edit screen, touch or click Next. A pop-up 

message will ask whether you want to save the file.
• Touch or click Yes to save the template under a new name. If you save the 

file, you can later export it to a USB device so you can transport it between 
your local PC and the Design Center Software.

• Touch or click No if you don’t want to save it, but want to proceed to printing.
• Touch or click Cancel to remain on the Edit screen (e.g., to continue further 

customization).

2. If you want to save your changes, enter the name you want to use on the 
Virtual Keyboard, then touch or click OK.

3. At the confirmation message that the template was saved, touch or click 
OK to continue.

4. Continue to "Printing," page 8-34.
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Printing
To print awards or stickers on an Awards Maker 400:

1. Turn on the VariQuest®  Awards Maker 400 and install the media type and 
width you want.

2. On the Media Type and Width screen, verify the sticker media type and 
size loaded in the printer are checked: 
• Touch or click a media type and media width to select them. 
• Touch or click Next to continue.
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3. With your project displayed on the Print Preview screen (the quantity 
defaults to “1”). To set the number of stickers you want printed, touch or 
click up/down arrow keys in the # of Stickers box.

TIP
When using a name list, the number in the # of Stickers box defaults to the 
number of names on your list. The example shows 15 because it is the number 
shown in # of names on list.

If you reduce the number, the end of the list will be cut off (e.g., if your list 
includes 30 names, but you change the # of Stickers to 25, the last five names 
will not be printed).

If you increase the number, printing will start over at the top of the list (e.g., to 
print two copies of each name using the same 30-name list, you would 
increase the # of Stickers to 60).

• To see a preview of all versions of the template, touch or click 
Show All Previews.
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4. On the All Previews screen, scroll to see the templates for all names. You 
can also magnify the preview by touching or clicking a thumbnail.

5. After viewing all previews, touch or click OK to return to the Print Preview 
screen.
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6. When ready to output your awards or stickers, touch or click Print. 
A pop-up window indicates the print job status. When printing is complete, 
the pop-up window closes, leaving the Print Preview screen displayed.

7. If you are done with the project and the Awards & Stickers design element, 
touch or click Close.
Other options available are:

- Print additional copies.
- Go Back to make a change to the design.
- Start Over or Finished to work on a new awards/stickers project.
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Adjusting Print Density

TIP
The default setting for optimum quality has been pre-set for each sticker media 
type. You will rarely need to adjust it.

1. To adjust the print density, touch or click Adjust Print Density. 
2. In the pop-up window, touch or click the slider and drag it to Lighter or 

Darker, as desired (to return to the previous density level, touch or click 
Reset).

3. When done, touch or click OK, or to discard your adjustments, touch or 
click Cancel.

4. To print a mirror image, Go to "Selecting Mirror Printing," page 8-39. 
Otherwise, touch or click Print.
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Selecting Mirror Printing
Mirror Printing prints the sticker so it can be read through a window (e.g., as 
you would view a parking permit sticker).

TIP
Mirror Printing is only available if you previously selected Specialty - Clear 
Parking Permit Sticker media type.

1. Select and edit your template. 
2. At the prompt, touch or click Yes to save the file, or No to continue without 

saving.
3. In the Material Type and Width screen, select Specialty - Clear Parking 

Permit Sticker media type.
4. Click Next.
5. In the Optional area, select Mirror Printing, if desired. 

6. Click Print to print the sticker, or Finished or Start Over to return to the 
main screen.
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Overview

The Awards & Stickers design element lets you easily create a huge variety of 
awards and stickers. Often templates provide exactly what you need. 
However, you can easily customize templates to suit your own individual 
needs. 

With the addition of the VariQuest®  Motiva™ 400 Color Awards Maker, the 
VariQuest® Design Center Software offers an easy way to print your awards 
and stickers in a range of sizes and colors, ready for immediate use.

TIP
Not every text item or graphic in awards and stickers templates can be 
changed. If you try changing a non-editable item, a message to that effect will 
appear on your screen. If you think it is essential to change the graphic or text 
item, try browsing for a different template design that would be better for your 
project.

Color Coding
• Distinctive color coding in the Design Center Software lets you easily 

orient yourself to the specific output types. Thumbnails in the preview 
window(s) are also color coded. Whenever you are working on the 
Perfecta, the tab at the top of the screen and the controls are color-

coded with Purple .

Thumbnail Labeling
The label name of a thumbnail includes the Content ID and its activation 
status (activated or not activated). When you click a thumbnail, a preview will 
popup with additional information about the item:

• ID #
• Name
• Associated Learning Module (if applicable)
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Using the Virtual Keyboard
The Virtual Keyboard is a graphical representation of a keyboard and text-
entry box that appears whenever you need to enter or change text. 

You can use the Virtual Keyboard just like a regular keyboard to “type” text 
into the text-entry box using your Design Center touch computer, an attached 
mouse to point and click keys on the virtual keyboard or from an attached 
keyboard or PC. 

TIP
Touch or click Spanish Letters once to display accented Spanish letters. Touch 
or click again to return to the standard keyboard.

Note: For more specific details on using the Virtual Keyboard or entering 
Spanish text, see "Using the Virtual Keyboard," page 1-21 in the Software 
User’s Guide.
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File Management

When doing a search, the Find screen opens with search options that you can 
use to find a template, shape, collection, graphic or design element, or one of 
your own saved projects. 

TIP
Search results show only the content for the output type and grade level(s) you 
have selected. If your search does not return an expected result, check that 
your Content Preferences include the appropriate grade level(s).

Search for Files
To search by: 

• Keyword: Locate a template or file using either:
- Design Center Software ID: The ID is listed with each template, shape, 

and collection in the VariQuest® Content Guide
- Content Keyword: Enter a keyword such as “sports” or “numbers.”

• Browse Categories: Search through all templates, shapes, collections, 
graphics and design elements. The files are grouped into categories and 
subcategories, such as “animals” or “weather.” 

• My Files: Search your own templates. When you customize a template, 
you can save it under a different name for future use. Later, you can find 
your saved templates through the My Files option. 

TIP
For more specific details on searching for files, see "Locating Files in the 
Software," page 1-25.

Search for My Graphics
You can also search for your own graphics from the Edit screen, by choosing 
Graphics, then the “find” option Find My Own Graphic.

TIP
For more specific details on searching for files, see "Search for My Graphics," 
page 1-32.
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Importing and Exporting Saved Files
You can import or export  Motiva™ 400 files to/from a USB device from the 
My Files section on the Menu screen. Once selected, your file will be imported 
into the Design Center or exported to the USB device.

TIP
If a file with the same name already exists on your Design Center touch 
computer, the file will not be imported.

Note: For more specific details on importing or exporting saved files, see 
"Importing and Exporting Saved Files," page 1-34.

Deleting Saved Files and Jobs
You can easily delete saved files you no longer want from the My Files menu 
page, selecting the file you want to delete and then clicking Delete.

Note: For more specific details on deleting files, see "Deleting Saved Files 
and Jobs," page 1-36.
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Basic Process 

The general process for creating awards and stickers includes these basic 
steps For more detail, see the remainder of this chapter.

To create an award or sticker:
1. From the Design Center Software main menu, touch or click the Motiva 

button. 
2. Use the search or browse functions to locate the design template you 

want.
3. With a template as your basis, modify it as desired:

• Change the content of editable text.
• Change the font, size, and style of editable text.
• Choose different graphics, remove graphics on templates with replaceable 

graphics.
• Add new text or graphics objects.
• Move and size editable objects.
• Add a name list to create personalized copies (on templates that use name 

lists).
• Change the text or graphic color.

4. Select the material size and type for output, and print.
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Finding a Template

Whether you want to create a new award or sticker, or print more of an 
existing one, your first step after launching the Motiva 400 design element is to 
locate the template you want to use.

To search for a file:
1. Locate the template you want by using on one of the search options:

• Search by keyword or template ID
• Browse stickers or collections
• Browse categories and individual templates 
• Select previously saved templates 

2. On the Edit menu, modify the template as desired.
3. When ready to print the project, touch or click Next to go to the Print 

Preview screen. 
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Customizing an Award or Sticker Template

Text Editing

Change Text Content on a Template

To change the content of a text item on a template:
1. With the template displayed on the Edit screen, touch or click the text you 

want to change. Once selected, it will be bordered by a square.
2. Touch or click Edit Text. 
3. On the Virtual Keyboard, modify the text.
4. When done, touch or click OK. The template will display with your text 

changes.

5. To continue modifying the template, go to:
• Fonts & Styles to change the font or style of editable text items.
• Use Text Size Arrows to increase or decrease font size or key in size.
• Graphics to replace or remove graphics.
• Colors to change the color of a selected graphic.
• Flip Graphic to flip the graphic horizontally..

6. To print, touch or click Next to go to the Print Preview screen.
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TIP
Remember to always select the text or graphic before clicking Edit Text or 
Graphics.

• A blank space outlined by a dotted line marks a text box in a template. The 
dotted line does not print; it simply marks the space where text can go.

• A thick black box with an X inside marks an area where a graphic can be placed 
in a template. The X and box do not print if you decide not to insert a graphic.

• When you select a text box or graphic, square “bullets” appear around it to 
indicate that it is selected. 
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Change Fonts on a Template

To change the text font, style, size or justification on a template:
1. On the Edit screen, touch or click the text you want to change.
2. Touch or click Fonts & Styles.

3. Make the changes you want as follows:

TIP
If your template contains more than one modifiable text item, you can select 
another text item without going back to an earlier screen. Just touch or click the 
next text object you want to modify and follow the steps of this procedure.

• Font: On the Font list, touch or click the font you want (the list of font names 
appear in the actual typeface of their font). Use the up/down arrows to scroll 
through the list of fonts.

• Text Size: Touch or click Font Size arrow buttons or key in size to make the 
text larger or smaller.

• Style: Touch or click B (bold), I (italic), and/or U (underline) to create the 
style you want. The style is “on” when the button is depressed (down), and 
“off” when the button is not depressed (up). You can apply any or all styles 
to the selected text.

• Justification: To change text justification (Left, Right or Centered), 
touch or click one of the justification controls. 

1

2
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TIP
Text justification only affects multiple lines of text within a single text object. It 
does not align the text object on the template.

4. When done, touch or click OK.
5. To continue modifying the template with graphics or color changes. 
6. When ready to print the project, touch or click Next to go to the Print 

Preview screen.



9-12 Motiva 400 VariQuest® Design Center Software User Guide

Customizing an Award or Sticker Template
Text Editing

Add New Text Item

TIP
Make sure that a text item is not selected. If a text item is selected, the new text 
will be placed in that text box. To deselect a text box, click in an empty area 
outside of the editing box.

To add a new text item:
1. With the template displayed on the Edit screen, 
2. Touch or click the Text tab, then touch or click New Text.
3. In the Virtual Keyboard, type the text you want to enter, then touch or click 

OK. 

TIP
The new text item may be placed over existing items on the template.

4. To move the new text item, touch or click and drag the text box to a new 
area on the template.

5. If necessary, size the text item using the sizing buttons under the Text tab.
6. If desired, change the color by touching or clicking the Color tab and 

select Standard or Custom tab and choose a color from either palette.
7. Repeat this procedure to add another text item.
8. When done, touch or click off text and continue with your project.



VariQuest® Design Center Software User Guide 9-13 Motiva 400

Customizing an Award or Sticker Template
Remove a Text Item from a Template

Remove a Text Item from a Template
To remove a text item:
1. On the Edit screen, touch or click text item to be deleted.
2. Touch or click the Design tab.
3. Touch or click the Delete Object button.
4. Or touch or click Text Tab. 
5. Touch or click the Delete Text button.
6. Click Undo to reverse edit or click off item when done.

Option One

Option Two
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Graphics
VariQuest® graphics are provided for a variety of designs. Not all graphics will 
look good on all templates, so you may need to experiment to find the graphics 
that work best for your specific template.

Change Graphics on a Template

To change a graphic:
1. On the Edit screen, touch or click the graphic you want to change.
2. Touch or click Graphics.

3. On the Graphics screen, touch or click the button identifying how you want 
to search for the new graphic:
• Search by Keyword and Browse Categories search the graphics 

provided with the software. When you locate the graphic you want, touch or 
click the thumbnail. 

• Find My Own Graphic lets you search the graphic files elsewhere on your 
Design Center touch computer or PC. When you find the graphic you want, 
select it, then touch or click OK to use it and return to the Edit screen.
Graphic files that use any of these supported formats will be displayed:
- Bitmap (*.bmp)
- TIFF (*.tif)
- JPEG (*.jpg)
- Portable Network Graphic (*.png)
- Windows Metafile (*.wmf)



VariQuest® Design Center Software User Guide 9-15 Motiva 400

Customizing an Award or Sticker Template
Graphics

TIP
For best results, use high-resolution graphics (such as those used for printing 
in yearbooks or letterheads). Most images created for a website don’t work 
well because of their lower resolution. Black-and-white or grayscale graphics 
produce the best results, although grayscale graphics with many gradations 
can produce less-desirable results.

4. On the Edit menu, to modify the template as desired, touch or click:
• Design to change design elements of selected objects.
• Text to change text fonts, styles, size.
• Graphics to insert a new graphic or change an existing graphic or insert a 

pre-defined shape.
• Colors to change the color of text or graphics.
• Background to change the background color.

5. When ready to print the project, touch or click Next to go to the Print 
Preview screen. 
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Remove a Graphic from a Template

To remove a graphic from a template:
1. On the Edit screen.
2. Touch or click the graphic you want to remove.
3. Then touch or click Graphic Tab or Design tab. 
4. Touch or click Delete Graphic/Object.
5. To undo the deletion, click Undo.

TIP
The graphic is removed from the template, but not deleted from the Design 
Center Software. You can always search or browse the software graphics to 
find and restore the graphic.

TIP
If you save the changed template after removing a graphic, you can always add 
a graphic back in — either the original or a different one.

Option 2
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Insert a Graphic
To insert a graphic:

TIP
Make sure that a graphic is not selected. If a graphic is selected, the new 
graphic will be placed in that graphic box. To deselect a graphic, click in an 
empty area outside of the editing box.

1. From the Edit screen.
2. Touch or click Graphics tab.
3. To search for a graphic, touch or click Graphics.
4. Browse to the location of your graphic using one of the search options. 

TIP
The new graphic may be placed over existing items on the template.

5. Move the graphic to the desired location on the template.
6. Repeat this procedure to add another graphic. 
7. To delete an existing graphic, touch or click the graphic, then touch or click 

Delete Graphic.

8. When done, touch or click off object and continue with your project.
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Rotate a New Graphic 
When you import or select a graphic, you can rotate it in 90° increments. This 
is done through the Design Tab.

Note: The Rotate option will work on graphics and text elements in a 
custom or Design Center software template.

To rotate a graphic:
1. In the Edit screen, touch or click Design Tab.
2. Locate and select your graphic. It displays with boundary boxes.
3. Touch or click the Rotate button to rotate the graphic.

a. Each click will rotate the graphic 90° counterclockwise.
4. When done, touch or click off the graphic.

Note: Flip Graphic on the Graphic tab is used to mirror (reflect) the graphic. 
Please refer to page "Flip a Graphic Horizontally," page 9-19
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Flip a Graphic Horizontally
You can select an image and flip it to face the opposite direction. This is 
useful, for example, when you have two graphics and want them to face 
toward each other.

To flip a graphic horizontally:
1. In the Edit screen, touch or click Graphics.
2. Locate and select your graphic.
3. Move and/or size the image as desired.
4. Touch or click a Flip Graphic.
5. Touch or click Flip Graphic. The graphic will be flipped 180° horizontally.

TIP
You can use the New Feature of Copy and Paste on the Design Tab when 
selecting an existing graphic on a template to flip.
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Rotation using Bounding Box
You can select an graphic and rotate it using the bounding box surrounding it. 
This can be useful when you want to make a smaller rotation of your graphic. 

To rotate a graphic:
1. In the Edit screen, touch or click the graphic.
2. Select the handle of the graphic (this will be the one square hanging a bit 

outside of the perimeter, you will get a ¾ circle with arrow)
3. Keep finger on screen or mouse arrow on handle and start movement.
4. Once done with movement, release finger / mouse and movement will 

stop.

Note: Rotation must be made in 15° increments. If this is not achieved, a 
colored box will print where the text or graphic should be.
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Change Graphic Color 
You can change the color of a some graphics on a template. 

Note: Not all available graphics can be edited for color. Only vector-based 
graphics can be changed.

To change the graphic color:
1. With the template displayed on the Edit screen, 
2. Touch or click any graphic object, then click Colors tab.
3. In the Color palette, touch or click a new color. The color of the graphic 

changes to varying shades of the selected color.
4. Repeat this procedure to change other graphic object colors.
5. When done, touch or click off the graphic and continue with your project.
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Tab Descriptions

Design Tab

Send to Back
Touch or click to send selected object to the 
back of all objects.

Bring to Front
Touch or click to bring selected object to the front of 
all objects.

Center Horz.
Touch or click to center the selected object 
horizontally on the page.

Center Vert.
Touch or click to center the selected object 
vertically on the page.

Rotate
Touch or click to rotate the selected object in 15° 
increments.

Delete Object
Touch or click to delete an existing graphic or 
text object.

Copy / Paste
Touch or click to copy and paste an existing 
graphic or text object.

Undo Touch or click to undo the last action.

Text Tab

New Text

Touch or click to add a new text box. When the 
Virtual Keyboard appears, enter the new text, then 
touch or click OK. When a text object is selected, 
this button toggles to Edit Text.

Edit Text

Touch or click to change the text in a text box. 
When the Virtual Keyboard appears, enter the new 
text, then touch or click OK. When no text object is 
selected, this button toggles to New Text.

Size - +
Text Width
Text Height

Select a text box or graphic, key in text size 
touch or click arrows to increase or decrease the 
size, or the text width and height of a text box.

Fonts & Styles

Select a text object, in the Fonts &Styles screen, 
touch or click to select a different font, size, style or 
justification, then touch or click OK.

Horizontal Text
Vertical Text

Select the text orientation. Text in the selected 
text box will be changed to reflect the selected 
orientation.
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Graphics Tab

New Graphics

Touch or click to add a new graphic. In the Change 
Graphic menu, browse to the location of the new 
graphic, then touch or click OK. This button toggles 
to Graphics.

Graphics

Touch or click to change a selected graphic. In the 
Change Graphic menu, browse to the location of 
the new graphic, then touch or click OK. This 
button toggles to New Graphics.

Shapes
• Rectangle
• Oval
• Cross
• Star
• Triangle

Touch or click the button to insert the shape 
indicated, then touch or click OK. Size the object 
while it is selected. You can change the color 
from the Color tab. 

Size - +
Select a text box or graphic, touch or click 
- or + to increase or decrease the size.

Color Tab
Touch or click the desired color on the color 
palette to change the selected object, then touch 
or click OK.
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Background Tab

None
Touch or click to remove background fill, then 
touch or click OK.

Solid Fill

Touch or click to fill the background with color. 
Touch or click the color palette to fill the 
background with the selected color, then touch or 
click OK.

Horizontal Gradient

Touch or click to fill the background with a 
horizontal gradient in the selected color. then 
touch or click OK. 

Note: Gradients display best when used with darker 
colors.

Vertical Gradient

Touch or click to fill the background with a 
vertical gradient in the selected color, then touch 
or click OK. 

Note: Gradients display best when used with darker 
colors.
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Name Lists

Add a Name List to a Template

To add a name list to a template:
1. On the Edit screen, touch or click the text where you want the names from 

your list to appear (e.g., “Student Name”).
2. Touch or click Add Name List.

TIP
Remember to always select the text box before you click Add Name Text. If 
the text cannot be replaced by a name list, a message with that information will 
display.
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3. In the Add Name List screen, touch or click Create/Edit List.

4. To add names to your list, touch or click the keys on the Virtual Keyboard. 
After each name, touch or click Enter. 

5. When done, touch or click OK.
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6. The names you entered will display in the Text to Include list. Click OK to 
continue.

7. At the prompt to save your list:
• Touch or click Yes to enter a name for the list, then touch or click OK to 

return to the Edit screen with the first entry in your list displayed in the text 
box.

• Touch or click No to continue without saving. You will be returned to the Edit 
screen with the first entry in your list displayed in the text box.

8. Touch or click Next to continue with your project.
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My Saved Lists
Use this procedure if you have already created and saved a name list.

1. On the Edit screen, touch or click the text where you want the names from 
your list to appear (e.g., “Student Name”).

2. Touch or click Add Name List.
3. Touch or click My Saved Lists. The Name Lists screen will display all of 

your saved name lists with the items in the list displayed in the Preview 
box.

4. Select the list you want, then touch or click OK. 
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5. On the Add Name List screen, touch or click OK again to accept the list 
and display the first name in the template.

TIP
You can use only one name list per template. If you already used a name list 
for the template and want to use a name list for a different text item, change 
the first text item to standard text by touching or clicking Change Text and 
entering the standard text you want to appear. Then add the name list to the 
new text item.

6. Touch or click Next to continue with your project.
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View, Edit or Delete Name Lists from Edit Menu

To edit a saved list:

TIP
You can only delete a name list from Workroom Assistant.

1. Select the text object you want to edit, then touch or click Add Name List.

2. Touch or click My Saved Lists.
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3. From the Saved List column, choose the name list you want to use, then 
touch or click OK.

4. To edit your list (e.g., remove the column heading):
a. Touch or click Create/Edit List.
b. In the Virtual Keyboard, make the changes you want to the list.
c. When done, touch or click OK.

5. Touch or click OK, and when prompted touch or click Yes to save your list, 
or No to continue without saving.

6. If you selected Yes, enter the name of your list in the Virtual Keyboard, 
then click OK. Your list is saved and you will be returned to the Edit screen.

7. In the Edit screen, touch or click Next to continue with your project.
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Import Name List from Excel
1. Select the text object you want to edit, then touch or click Add Name List.

2. Touch or click Import List from Excel.
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3. In the Import List screen, touch or click Find File.

TIP
You can import name lists from your PC hard drive or from a USB device 
connected to the Design Center touch computer or PC.

4. Navigate to the location of your Excel file, then touch or click OK. The first 
sheet of the file will display the contents of Column A.

TIP
If you have a column header in the Excel file, the header will also be imported 
and included in the name list unless you delete that item.

Column
Heading
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TIP
Only the information in Column A of the selected sheet in the Excel file is 
imported. Blank cells are ignored.

5. To choose another sheet in the imported file, touch or click the sheet name. 
The preview window is immediately updated.

6. When done, touch or click OK. The list displays in the Add Name List 
screen.

7. If you want to edit your list (e.g., remove the column heading):
a. Touch or click Create/Edit List.
b. Edit the list in the Virtual Keyboard, then touch or click OK.

8. Touch or click OK, and when prompted touch or click Yes to save your list, 
or No to continue without saving.

9. If you selected Yes, enter the name of your list in the Virtual Keyboard, 
then click OK. Your list is saved and you will be returned to the Edit screen.
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Printing an Award or Sticker

Depending on the type of project, there are several options available for 
printing your award or sticker. If you have customized the template, you will be 
asked if you want to save the template before initiating the print process.

Saving a Template before Printing
If you have made any changes to the template, you will be prompted to save it 
when you choose Next from the Edit screen.

Guidelines for Saving a Template

TIP
Consider these guidelines for saving a template:

• If you plan to re-use or output additional copies of a template you have 
customized, you should save it and open it later via the My Files option on the 
"Find" screen.

• Saved templates can be exported to a USB device so they can be transported 
between your local PC and the Design Center Software.

• If you did not make any actual changes, or if you don’t plan to reuse this 
customized version in the future, it is not necessary to save your changes.
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To save a customized template:
1. When finished with the Edit screen, touch or click Next. A pop-up message 

will ask whether you want to save the file.
• Touch or click Yes to save the template under a new name. If you save the 

file, you can later export it to a USB device so you can transport it between 
your local PC and the Design Center Software.

• Touch or click No if you don’t want to save it, but want to proceed to printing.
• Touch or click Cancel to remain on the Edit screen (e.g., to continue further 

customization).

2. If you want to save your changes, enter the name you want to use on the 
Virtual Keyboard, then touch or click OK.

3. At the confirmation message that the template was saved, touch or click 
OK to continue.

4. Continue to "Printing," page 9-37.
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Printing

To print awards or stickers on a  Motiva™ 400:

1. Turn on the VariQuest®  Motiva™ 400 Color Awards Maker and install the 
media type and width you want.

2. On the Media Type and Width screen, verify the sticker media type and 
size loaded in the printer are checked: 
• Touch or click a media type and media width to select them. 
• Touch or click Next to continue.
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3. With your project displayed on the Print Preview screen (the quantity 
defaults to “1”). To set the number of stickers you want printed, touch or 
click up/down arrow keys in the # of Stickers box.
• When using a name list, the number in the # of Stickers box defaults to the 

number of names on your list. The example shows 15 because it is the 
number shown in # of names on list.

If you reduce the number, the end of the list will be cut off (e.g., if your list 
includes 30 names, but you change the # of Stickers to 25, the last five 
names will not be printed).

If you increase the number, printing will start over at the top of the list (e.g., 
to print two copies of each name using the same 30-name list, you would 
increase the # of Stickers to 60).

• To see a preview of all versions of the template, touch or click 
Show All Previews.
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4. On the All Previews screen, scroll to see the templates for all names. You 
can also magnify the preview by touching or clicking a thumbnail.

5. After viewing all previews, touch or click OK to return to the Print Preview 
screen.
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6. When ready to output your awards or stickers, touch or click Print. 
A pop-up window indicates the print job status. When printing is complete, 
the pop-up window closes, leaving the Print Preview screen displayed.

7. If you are done with the project and the Awards & Stickers design element, 
touch or click Close.
Other options available are:

- Print additional copies.
- Go Back to make a change to the design.
- Start Over or Finished to work on a new awards/stickers project.
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Print a Collection
To print a Collection file:
1. Touch or Click Collection.
2. Search by Keywords or Browse Categories
3. Once your collection is selected touch or click OK.
4. Choose what material and size your collection will be printed on.

5. In the Print Preview menu, Select Stickers (defaults to all), to select certain 
stickers Touch or Click Select Stickers button.

6. Touch or Click each sticker for printing. The chosen sticker will have 
selected highlighted underneath it. 

7. Back in the Print Preview screen click Print
• Increase or decrease the number of copies in the Copies box.
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Print a PDF File
The My PDFs section allows for quick and easy PDF printing. The file is 
automatically scaled according to the output size selected, making the printing 
process even easier! If you experience difficulty during the printing process, or 
your output is not printing correctly, try printing using Adobe® Reader or the 
native program the from which the PDF file was created.

Note: There is a 99 page limit on the imported PDF file. Any remaining 
pages in the file will be truncated.

To print a PDF file:
1. On the Find Stickers menu, touch or click My PDFs.
2. In the Find File menu, browse to the location of your PDF file, then touch or 

click OK.
3. In the Print Preview menu, select the output size you want to print.

CAUTION!CAUTION!
Not all PDF documents will be suitable for small format printing.

4. In the Print Preview screen, use the arrow buttons to:
• View all pages in the PDF by touching or clicking the left or right arrow 

buttons at the bottom of the screen.
• Increase or decrease the number of copies in the Copies box.

Note: To export this file to a USB drive instead of printing, select Finished, 
then go to My Files to export it.
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Optional and Ink Remaining Settings
1. Select Settings to change Print Quality, Clean and Align the Printheads, 

and adjust Media Sensor and Printer Offsets.
2. The Ink Remaining indicator shows the approximate amount of ink 

remaining in the cartridge. The printer also alerts you when less than 10% 
of the cartridge is remaining.

3. Use the arrow buttons to change the number of stickers to be printed. This 
number defaults to the number of names in your Name List (i.e., one copy 
for each name will print).

4. Select Show All Previews to see all copies that will be printed. (when a 
namelist is used).
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Printer Adjustments

The VariQuest® Motiva™ 400 Color Awards Maker is factory calibrated and 
should not need adjustment or cleaning. However, if necessary, some 
functions can be adjusted from the Printer Adjustments screen.
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Printhead Maintenance
You can clean or align the printhead from the Printhead Maintenance section 
of the Printer Adjustments screen.

Clean Printhead
1. From the Print Preview screen, touch or click Settings to open the 

maintenance dialog.
2. In the Printhead Maintenance box, touch or click Clean.
3. At the prompt, touch or click OK to clean the printhead. A color pattern will 

print showing the results.
4. Touch or click Close to close the dialog.

Align Printhead
1. From the Print Preview screen, touch or click Settings to open the 

Printhead Maintenance dialog.
2. Touch or click Align.
3. At the prompt, touch or click OK to align the printhead. An alignment 

pattern will print showing the results.
4. Touch or click Close to close the dialog.
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Printer Offsets
Printer Offsets let you adjust the vertical and horizontal printing position or 
cutting edge of the label. If you see white on your label edges, you may need 
to adjust the printing position. The  Motiva™ 400 comes factory calibrated to 
print exactly to the edge of the label stock. However, due to variations in the 
left margins and other variables it may be necessary to fine tune these settings 
at the beginning of each roll. Please consult your Authorized VariQuest Dealer 
prior to making adjustments. 

Before adjusting alignment settings, print one label at the quality level you 
intend for the entire job. This will ensure the label stock is moving at the same 
speed and the stock sensor will sense the gap in the same way. 

Before adjusting Top of Form, make sure the label stock is properly loaded so 
there is no gap between the liner edge and the fixed throat guide. 

• Cut Position. Adjusts position of the last label printed after it has been 
presented for tear off. Negative values move the tear point closer to the 
printer. Positive values move the tear point away from the printer. 

• Left Margin Offset. Moves the printed label left or right. Positive values 
move the printed label to the right. Negative values move the printed label 
to the left. 

• Top of Form (TOF). Moves the print start position up or down on the label. 
Add to the value to move the printed label down or toward the printer. 
Subtract from the value to move the printed label up or away from the 
printer. 

1. From the Print Preview screen, touch or click Settings to open the 
Printhead Maintenance dialog.

2. To adust the offset(s), enter a value in the dialog for Margin or Cutter offset, 
or touch or click the Up / Down arrows. 

3. To Test the value entered, touch or click Test. To set the value entered, 
touch or click Set. A test label will print showing the results.

4. Touch or click Close to close the dialog.
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Sensor Mode
Sensor Mode detects the type of media installed. The default is Continuous. If 
you change media, you can change what the sensor detects. 

1. From the Print Preview screen, touch or click Settings to open the 
Printhead Maintenance dialog.

2. To ensure the printer senses the correct media, touch or click the 
appropriate media type (i.e., Reflective, DieCut, Continuous). 

3. Touch or click Close to close the dialog.

Print Quality
You can change the default setting for printing by using the Print Quality 
option. By default, the printer is set to Normal print quality.

1. From the Print Preview screen, touch or click Settings to open the 
Printhead Maintenance dialog.

2. In the Print Quality dialog, move the slider to change the print quality.
• Fast: Faster printing and lower image quality. 
• Normal: Good quality and print speed.
• Best: Best quality printing, slowest print speed.

3. Touch or click Close to close the dialog.
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